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EXECUTIVE SYSTEMS, INC. -- License Agreement 

Carefully read the terms and conditions of this agreement before breaking the 
disk seal. If you do not agree with them, you may return the unopened software to 
the place of purchase for a full refund. This program is being sold on the condition 
that Customer agrees to this license. 

Executive Systems, lnc. ("ESI") agrees to grant, and the Customer agrees to ac­
cept, a non-exclusive, nontransferable license to use the program delivered with 
this Agreement (the "Licensed Program") under the terms and conditions set forth 
below. The Licensed Program and manual are proprietary products of ESL ESI 
retains title to and ownership of the Licensed Program. 

1. License. The Customer may (a) use the Licensed Program on a single ma­
chine, its temporary replacement or a subsequent computer; (b) copy the Licensed 
Program in support of the Customer's use or for backup purposes; (c) transfer the 
Licensed Program to a third party ifthe third party agrees to accept the terms 
and conditions of this Agreement. If the Customer transfers the Licensed Pro­
gram, the Customer must at the same time transfer all copies of the Licensed Pro­
gram to the same party or destroy any copies of the Licensed Program not 
transferred. 

2. Term. This Agreement and license are effective from the date of receipt and 
shall remain in force until terminated. The Customer may terminate this Agree­
ment and license by destroying all complete and partial copies of the program in 
its possession. ESI may terminate the license hereunder ifthe Customer fails to 
observe any of the terms and conditions of this Agreement. In the event of such 
termination, the Customer will certify in writing that to the best of its knowledge, 
the original and all copies of the Licensed Program have been destroyed or re­
turned to ESL 

3. Protection and Security. The Customer agrees not to disclose or make other­
wise available any part of the Licensed Program or associated documentation to 
any third party, without prior written permission of ESL Except as provided in 
Section 1 hereof, the Customer may not copy, modify, sublicense, lease, convey, 
translate, reproduce or disassemble the Licensed Program without the prior writ­
ten permission of ESL 

Limited Warranty and Limitation of Remedies. ESI warrants the diskette 
containing the Licensed Program to be free from defects in materials and work­
manship under normal use by the original purchaser for 90 days from the date of 

l purchase. Within the 90 day period, ESI will replace the defective diskette with-
1 out charge. The entire liability ofESI and its suppliers and the Customer's sole 
and exclusive remedy shall be limited to replacement of any Licensed Program not 
meeting ESI's limited warrant. 

JEXCEPT AS STATED ABOVE, THE LICENSED PROGRAM IS PROVIDED "AS 
IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IM-

I
PLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. IN NO 

1EVENT SHALL ESI BE LIABLE FOR LOSS OR PROFIT OR ANY OTHER COM­
MERCIAL DAMAGE, INCLUDING BUT NOT LIMITED TO SPECIAL, INCI­
J)ENTAL, CONSEQUENTIAL OR OTHER DAMAGES. SOME STATES DO NOT 
!ALLOW THE EXCLUSION OF LIMITATION OF LIABILITY OF INCIDENTAL 
bR CONSEQUENTIAL DAMAGES, IN WHICH CASE THIS LIMITATION MAY 
NOT APPLY TO YOU. 
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Introduction 

With the release ofXTreeGold 2.0, XTree Company has achieved 
two important goals: 

D We've made the powerful file, disk and information manage­
ment capabilities ofXTree products easier to understand and 
access, so new users can get up to speed quickly. 

D We've responded to requests from long-time power users for 
product enhancements like improved handling oflarge capac­
ity hard disks and partial logging capabilities, increased file 
viewers, archiving in the industry standard ZIP format, and 
the ability to undelete files. 

These enhancements and more are described in greater detail 
throughout this Guide. 

Look through this Introduction before you start using XTreeGold 
2.0 and this User's Guide; it contains suggestions for both new 
and long-time XTree product users. And, as soon as you've in­
stalled XTreeGold 2.0, click on the top of the screen to see one of 
our most exciting new features. 
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System Requirements 

Before you open the package which contains the XTreeGold instal­
lation diskettes, make sure your system meets the following re­
quirements, which guarantee XTreeGold will run smoothly: 

D 256K or more of RAM memory 

D MS-DOS or PC-DOS version 3.1 or greater 

D 100% IBM-PC compatibility, with BIOS and DOS functions 
PC-DOS compatible, as defined in the IBM Technical Refer­
ence Manual and the IBM DOS 3.1 Technical Reference Man­
ual. 

Product Package 

Your product package includes: 

D This XTreeGold 2.0 User's Guide 

D Four 51/4" 360Kb diskettes 

D Two 31/2" 720Kb diskettes 

D Registration Card 

You'll only need to use one set of diskettes to install XTreeGold, 
however we've provided both formats so you'll be sure to have the 
size you need. Please fill out and return the registration card. 
This will entitle you to receive toll-free technical assistance if you 
need help. 
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How To Use This Book 

This User's Guide is modular in design, and intended to be used 
for both background information on XTreeGold, and as an ongo­
ing reference to commands and tasks performed by using the com­
mands. This book contains thorough discussions of all its 
concepts and capabilities, and also provides descriptions of all the 
commands, and step-by-step directions for using the commands to 
accomplish the file, directory and disk management tasks for 
which XTreeGold was intended. This Guide tells you how to use 
this tool to meet all your professional and personal file and infor­
mation management needs, and more. 

To support the diverse needs of our users, XTreeGold 2.0 and the 
User's Guide were desiined to be used by both knowledgeable 
users and XTreeGold novices. 

Novice Computer Users 

XTreeGold now provides two different menu systems to help new 
users in learning to use the program's features and capabilities 
quickly and easily. We suggest you: 

D Read Chapter 1 of this Guide for an overview of the product. 

D Then continue on to Chapter 2 to learn how to install and 
start XTreeGold. 

D Read the rest of Chapter 2 to complete your introduction to 
the basics. 

D Use the rest of the book as a reference, looking up specific 
tasks or commands, and following the step-by-step instruc­
tions for both the simple and complex tasks you are inter­
ested in. 

If you follow this procedure, within the hour you should find your­
self performing the same file, directory and disk management 
tasks that power users have been raving about for years. 

l 1ntroduction xiii 



Power Users 

If you are already familiar with XTreeGold, we suggest the follow­
ing process: 

D Read the discussion of our new user interface and new fea­
tures that begins on page 1-3. 

D Then read and follow the installation instructions that begin 
on page 2-2. 

D Once XTreeGold 2.0 is installed, use the page references 
you'll see in the New Features section to learn how to use 
those of most interest to you, and try those features out. 

D Review this Guide at your own pace to learn more about the 
capabilities you haven't tried before. 

If you're an advanced computer user who likes to skim through 
manuals, but a new XTreeGold user, we suggest following the 
same steps we suggest for novices. However, you'll be able to 
skip many of the explanations in the first two chapters while still 
becoming familiar with the basic terms and concepts you need to 
know. So, it should take you about half the time to get started. 
You might also browse through this guide to learn about all of 
XTreeGold's features and capabilities, and then refer to the sec­
tion which describes the commands you'd like to work with first. 
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Conventions 

The following conventions are used throughout this guide. 

When it says ... 

press Enter 

press Enter or click .J ok 

press Ctrl + L 

select the Log volume com­
mand from the Volume pull­
down menu 

highlight a directory or file 
name 

click COMMANDS 

I Introduction 

It means ... 

press the Enter key 

use the method you prefer: 
point to .J ok at the bottom of 
the screen with the mouse 
pointer and click the left 
mouse button, or press the 
Enter key 

press and hold the key 
marked Ctrl while you press 
the L key 

use the method you prefer: 
point to the command name, 
Log volume, with the mouse 
pointer and click the left 
mouse button, or press the 
hotkey L, displayed in bold, or 
highlight the command by 
using the Arrow keys and 
then press the Enter key 

use the method you prefer: 
point to that name with the 
mouse pointer and click the 
left mouse button, or highlight 
the name by using any of the 
Arrow keys 

point to word COMMANDS at 
the bottom left of the screen 
with the mouse pointer and 
click the left mouse button 
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double-click COMMANDS point to word COMMANDS at 
the bottom left of the screen 
with the mouse pointer and 
click the left mouse button 
twice 

There are also some conventions used to help clarify information. 

When you see ... 

a command name with a 
bolded letter, for example Exe­
cute 

file, directory and volume 
names like MYFILE, MYDIR 
and MYVOL in uppercase let­
ters in the steps and examples 

V When the Directory win­
dow is active 

I@' Note: 

It means ... 

you can select the command 
immediately by pressing that 
letter on your keyboard; it is a 
hotkey 

you may substitute any file, 
directory or volume name of 
your choice in the steps 

you can select the command 
shown only when the indi­
cated window or windows are 
active 

read the information before 
using the command or function 

And throughout this Guide, we'll tell you more than one way to se­
lect commands and options and perform all related tasks. The 
best way is always the way you find to be quickest and easiest for 
you; there is no wrong or right methods, but there probably is a 
method you prefer. Always choose the one you're most comfort­
able with. XTreeGold 2.0 was designed to provide that flexibility 
to you. 
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XTreeGold 2.0 Overview 

This chapter overviews XTreeGold's general capabilities, concepts 
and terminology and presents a description of new and improved 
capabilities of particular interest to current XTreeGold users. It 
is designed to expedite your understanding ofXTreeGold's spe- · 
cific capabilities and commands if you're a new user, and give you 
background knowledge needed to use and understand all the in­
formation in Chapter 2 and the rest of this Guide, which contains 
step-by-step instructions for using XTreeGold's capabilities. This 
information includes: 

D Key features for file, directory and disk management 

D The new user interface 

D Other new features ofXTreeGold 2.0 

D XTreeGold terms 

D A summary of keyboard and mouse conventions 

If you are a current XTreeGold user, skip right to the discussion 
of our new user interface and other new features which begins on 
page 1-4. Current users do not need to read the rest of this chap­
ter; the information is already familiar to you. 
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Key Features for File, Directory and Disk 
Management 

XTreeGold's power comes from its ability to perform multiple op­
erations on one or more files in one or more directories or 
branches on one or more volumes or disks. And of course, you 
can perform tasks on multiple directories and disks, easily select­
ing only those directories, branches and volumes of your choice. 
By displaying the contents of volumes and directories on your 
screen in a directory tree and file lists, you can maintain a clear 
picture of the contents of your disks, and immediately see the im­
pact of your command selections. 

The commands and options provide file, directory and disk man­
agement capabilities that far exceed those provided by DOS com­
mands. And, XTreeGold makes the commands easy to use by 
displaying them on menus, followed by appropriate prompts, so 
you don't have to remember the command names and procedures. 
XTreeGold goes one step further to make commands easier to 
use; it lets you point to files, directories or volumes to be acted 
upon, so you don't have to remember and then type in their exact 
names or directory paths, and it remembers the last 16 responses 
for each command, to speed up procedures you find yourself re­
peating. 

And, XTreeGold provides extensive file viewing and searching ca­
pabilities to help you manage information, a sophisticated Appli­
cation Menu to automate your use of all the applications on your 
hard disk, and the ability to open a selected file in its application, 
by pointing to it with the mouse and clicking. If there's a task 
you'd like to perform on your files or their contents, XTreeGold 
probably has a way (or two) to do it, quickly and easily. 

7-2 XTree Gold 2.0 Overview 



The New User Interface 

With the release ofXTreeGold 2.0, we've included a new user in­
terface designed especially for those of you who prefer to work 
with pull-down menus. If you're a mouse user, you'll probably 
find using a mouse in combination with these pull-downs to be 
the quickest and easiest way to select most commands. If you're 
not a mouse user, you'll find you still get around pretty quickly 
using the arrow (cursor) keys and the hotkey displayed for each 
command. (Hotkeys are single keystrokes that let you im­
mediately invoke a command.) You'll have the ability to display 
these pull-down menus when you want to use them, but they 
won't be present all the time, so you'll be able to maintain a clear 
view of your disks' contents on the screen. 

And, the command menus that are familiar to current XTreeGold 
users are still intact, for easy command selection with a mouse or 
the keyboard. 
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New Features of XTreeGold 2.0 

Whether you're a current or new user, you'll probably be inter­
ested in this list of new features. For more details about an item, 
refer to the pages shown. 

Pull-down menus 

As mentioned, XTreeGold now provides pull-down menus which 
group all its commands under logical headers, making it easier to 
learn to use, and helping you locate commands you don't use 
often. (page 2-24) 

Undelete files 

You can now undelete files that you've accidentally erased. 
XTreeGold will show you a list of files you've deleted, and let you 
pick the file(s) you need from that list. There's no need to pur­
chase other expensive utility programs, because XTree offers a 
complete set of file and disk management capabilities. (page 3-37) 

Greatly expanded viewer list 

If you work with applications not on the current top ten list, you'll 
be happy to know we've expanded our viewers to support many of 
the less widely used word processing, spreadsheet and database 
programs. That also means you can view files a co-worker cre­
ated with any of the applications on our list in their native for­
mats, even if you don't use the same applications yourself. (page 
7-3) 

Totally new Application Menu design 

We've completely revised the look and functioning of our Applica­
tion Menu to improve its versatility. XTreeGold now searches 
your hard disk for applications to make building the menu easier. 
You can also configure the program so this menu is displayed 
when you start XTreeGold. And, you can organize the items on 
the menu into groups. When you run applications from this 
menu, XTreeGold only occupies 7K of memory, so virtually all 
your computer's memory is dedicated to the application. (page 8-2) 
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Archive files with Zip 

XTreeGold has added the industry standard Zip format for archiv­
ing files. This Zip format provides faster compression and expan­
sion of files and minimizes the size of archived files. It also will 
ensure you of greater compatibility with other computer users 
and bulletin boards. (page 9-4) 

Move files to other disks and volumes 

You can now move files to a directory on another disk, eliminat­
ing the need to first copy files to a new location and then delete 
them. Not only does this save keystrokes, but it's safer, since 
XTreeGold verifies the new copy of the files before automatically 
deleting them. (page 5-25) 

Partial logging for every need 

You can now start XTreeGold with a command line prompt to 
only partially log the directory tree, a particular benefit to owners 
of large hard disks. Or you can configure this option from within 
XTreeGold using the configuration utility. (pages 10-xx, 10-xx) 

And, every time you select the Log command from within the pro­
gram, you can choose to log only one level of the tree, only the cur­
rent branch or directory, or log the tree structure only, releasing 
all file information. This will significantly speed up tasks per­
formed on large hard disks. (page 6-16) 

Compare file lists across directories and volumes 

Two new compare files capabilities let you search for unique or 
duplicate files and show files with newest, oldest or identical 
dates, helping you locate recent copies of files and old unwanted 
versions of files to delete, thus saving space on your hard disk. 
(pages 4-26, 5-15) 

Partial release options 

The release disk command now provides the ability to partially re­
lease file information, either by electing to release a current 
branch or all the files in a branch, so owners of large hard disks 
can free memory in order to perform operations that were not pre­
viously possible. (page 6-12) 
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Easily work with files on a branch 

Work with a directory and all its subdirectories easily, using the 
new Branch logging capability and Branch window displays. 
(pages 4-3, 6-16) 

Added copy and move capabilities 

Copy and move files with their directory structure to any sub­
directory on any volume. And, point to a destination in one side 
of a split display while maintaining your display of the source in 
the other side, during all copy or move operations. (pages 5-21, 
5-25) 

Indicate more and longer filespecs 

The File specification command now lets you enter up to 28 file 
specifications, with a total length of up to 232 characters. (page 
3-3) 

Increased command history files 

The command history now saves and displays 16 recent entries 
for each command. (page 2-37) 

Easily toggle upper and lower case display 

A configuration option now allows you to display the directory 
tree and file lists in lower case and quickly switch to an upper 
case display by pressing the Caps Lock key. (page 10-7) 
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XTreeGold Terms 

In this Guide, we use some terms that are essential to your under­
standing ofXTreeGold. Here is a quick summary of those terms, 
along with an explanation of how they are used. 

The active window is the one which contains the highlight bar. 
The available commands are always determined by the active 
window. 

The current disk or current volume is the one on which 
XTreeGold is currently operating (not necessarily the same as the 
current disk in DOS). Only those directories and files on the cur­
rent volume are displayed (except when the Global window is ac­
tive). Many ofXTreeGold's disk and volume commands can be 
applied to both, for example you can use the Log disk command 
to log a disk or a volume on a disk. These options are explained 
as needed. 

The current directory is the one which is highlighted while the 
Directory window is active or which is marked by the f-- left­
arrow indicator when the File window is active. 

The current file is the one which is highlighted when one of the 
File windows is active. 

A disk may be either a hard disk or a diskette in a disk drive 
used to store data. A hard disk may be partitioned into one or 
more volumes. 

A disk drive is a spindle or device that reads the data stored on 
a disk and writes data on a disk for storage. 

A diskette is a removable magnetic storage medium, either 51/4" 
or 31;2" in size. 

A hotkey is a single keystroke displayed in bold which you can 
press to select a command or option. 

The XTreeGold term logging means to read directory and file in­
formation from a volume and to save that information in tempo-
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rary memory so that in can be displayed upon request. A volume 
must first be logged (physically read) by XTreeGold before its di­
rectories and files can be accessed and acted upon. 

Matching files are files you specify which may be acted upon by 
commands. The name of the file(s) you are matching is always 
displayed, and can include wild cards, for example *.txt or*.*. 

To select a command or option means to either press the high­
lighted letter, or click with the mouse by highlighting (pointing 
to) the command or option, then pressing the left mouse button. 

Tagging files is the process of selecting and marking files for 
subsequent operation by a command. A + diamond is displayed 
to the right of each tagged file to show it has been selected. 

A volume is a physical portion of hard disk space. A disk may 
contain one or more volumes. 
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Keyboard and Mouse Conventions 

XTreeGold supports a two button mouse. If you have a three but­
ton mouse, the middle button will be inactive while you are using 
the program. You can use the mouse and keyboard interchange­
ably in order to: 

D Select disks, volumes, directories and files 

D Select commands and options and respond to subsequent sys­
tem prompts 

D Locate and display information 

D Move between Directory and File windows 

The mouse is inactive while you are using the lWord text editor. 

In this User's Guide, we often provide several methods for select­
ing a command. XTreeGold allows you to select most commands 
by either: 

D Pressing the hotkey, the bold letter you see on the screen 
(most often the first letter of a command) 

D Pressing a function key or other displayed key(s) 

D Highlighting the command or option with the mouse and then 
clicking the left mouse button 

In this Guide, we present options for keyboard and/or mouse 
users, but we do not present every possible option in every set of 
instructions, as it might make the instructions overly confusing. 
You should always use the method you find most comfortable. 
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Summary 

This chapter introduced XTreeGold and discussed some of the 
basic capabilities and terminology of XTreeGold. You now know: 

D The purpose ofXTreeGold 

D Some new features to try if you're a current XTreeGold user 

D Basic XTreeGold terms 

Given this groundwork, you are ready to start XTreeGold, and un­
derstand the discussion of windows, menus, commands and con­
cepts in Chapter 2. 
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Getting Started 

This chapter begins the hands-on instructions and will get you 
started by: 

D Providing step-by-step directions for installation 

D Providing step-by-step directions for starting and exiting 

D Identifying menus, screens and windows displayed during 
your use of different functions and commands 

D Showing you how to use the keyboard and mouse to move 
around windows, select commands, and also to respond to 
prompts 

D Giving you step-by-step directions for obtaining on-line help, 
when you need it 
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Installing XTreeGold 

To install XTreeGold, insert the XTreeGold diskette #1 in drive 
A: and follow these steps. If your drive is named something other 
than A, substitute that letter for A. 

D Installing XTreeGold 

Follow these steps to begin the installation process. 

Action 

1. Insert the XTreeGold disk­
ette# 1 in drive A:, type A: and 
press Enter 

2. Type INSTALL and press 
Enter 

3. Follow the directions on the 
screen 

2-2 

Response 

The A: prompt is displayed 

The Installation Menu is dis­
played 

The screen will display the 
steps needed to install 
XTreeGold 
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Starting XTreeGold 

XTreeGold provides a number of command line options that en­
able you to specify configuration parameters or options when you 
start. These are explained in Chapter 10, configuration. The 
most common usage of these options would be to start XTreeGold 
and log a volume or diskette other than the one on which 
XTreeGold is installed. (For example, you may have XTreeGold 
installed on your hard disk, C:, but want to work with files on a 
diskette in drive A:). This is explained in the step-by-step instruc­
tions. As a new user, it is not necessary for you to understand or 
use these configuration options to work easily with XTreeGold. 
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D Starting XTreeGold 

Follow these steps to start XTreeGold when the DOS C:\ or 
C: \(Any Other Directory) prompt is displayed. Choose the 
method based on the volume, directory or diskette you want to 
work with first. 

Action 

1. Type CD\XTGOLD and 
press Enter 

Response 

The current directory changes 
to C:\XTGOLD 

-OR-

1. Type CD followed by the 
name of the directory in which 
XTreeGold was installed (if you 
made modifications to the in­
stall procedure) and press 
Enter 

2. Type XTGOLD and press 
Enter 

If XTreeGold was installed in 
a different directory, that 
name will be displayed 

The XTreeGold title screen is 
briefly displayed, and then the 
Main Display for the current 
DOS drive is shown 

-OR-

2. To start XTreeGold and im­
mediately display the contents 
of a diskette in drive A:, type 
XTGOLD A: and press Enter 

2-4 

The XTreeGold title screen is 
displayed, and the Main Dis­
play for the diskette in the A: 
drive is shown 
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XTreeGold Screens and Windows 

XTreeGold uses a series of screens and windows to organize the 
display of information and commands. There are two major win­
dows, the Directory window and the File window. Commands are 
divided into Directory commands and File commands, and corre­
spond to the active window. 

D When a window is active, a highlight bar is in that window. 

D When a window is active, the available commands are dis­
played on the bottom of the screen on the menu, and option­
ally, on the pull-down menus. 

D You can move quickly between the windows (changing which 
one is active) by using the Enter key, the Escape key or by 
clicking the window of your choice with the mouse. 

D To perform most operations on a volume or directory, the Di­
rectory window must be active. 

D To perform most operations on a file or group of files, a File 
window must be active. 

The Main Display 

The Main Display is organized into separate areas for displaying 
file, directory and volume information and statistics, as well as 
the program's commands, options and prompts. 

When you start XTreeGold, the Main Display is on your screen 
and the Directory window is active. 
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Disk specification box 

Path identification line File specification box 

j Directory lndow Date and time line 

2-02-91 

File window Statistics box 

Command menu and Prompt line location 
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Path Identification Line 

Identifies the current disk or volume and directory path where 
the highlight bar or pointer is. 

Example: Path: C:\XTGOLD 

As you change the current directory, the Path Identification Line 
also changes. If only a drive letter and a backslash(\) are dis­
played, the currently highlighted directory is the root directory on 
the disk or volume. 

Date and Time Line 

Displays the current date and time. 

Example: 2-04-91 12: 05: 30 pm 

XTreeGold uses your system clock to maintain a display of the 
current date and time. 

Directory window 

Displays the directory structure of the current volume. The root 
(first) directory is at the top of the display, and the rest are sorted 
alphabetically. Subdirectories are indented. In the Directory win­
dow, there is a highlight bar that can be used to select a directory 
for subsequent operations. 

Example: c : \ 
DOCUMENT 

I

-MEMOS 

-REPORTS 

-LETTERS 

DOS 

LuTILITY 

-XTGOLD 
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The highlighted directory is the one that was current when you 
started XTreeGold, or the root of the volume you specified at 
startup. As you scroll through the directory tree using the arrow 
keys, the highlight bar always identifies the current directory. 

Small File Window 

Lists the files in the selected directory that match the File specifi­
cation. If*.* is in the File specification box, all the files in the se­
lected directory are listed in the File window. The Small file 
window displays up to 12 files at one time. In the File window, 
there is a highlight bar that can be used to select a file for opera­
tions. 

Example: 
XTGOLD.CFG XTG EDIT.XTG XTG HELP.X30 

XTGOLD.COM XTG FIND.XTG XTG HELP.X40 

XTGOLD.HST XTG HELP.XlO XTG MENU.BIN 

XTGOLD.OVL XTG HELP.X20 XTG MENU.XTG 

When you start XTreeGold, the Directory window is active. To 
make the File window active, press the Enter key or click in the 
File window. The highlight bar is now in the Small file window, 
and File commands are available. 

~ Note: If the File window displays the message: 
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Dir Empty it means that there are physically no files in the 
current directory. 

No Files Match there are no files that match the current 
File specification which is displayed in the File Specification 
Box. 

Dir Not Logged you have not yet physically logged the direc­
tory, so the files will not be displayed. 
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File Specification Box 

Shows the name of the files which XTreeGold will display in the 
File window and use to determine matching files. Each time 
XTreeGold is started the*.* (all files) wild card specification is 
displayed. 

Example: *. * or *.BAK or MYFILE. * 

The file specification you enter is the main criterion which deter­
mines which files will be displayed in the various display win­
dows. You may list a single file name or up to 28 file names and 
any combination of wild cards. 

Disk Specification Box 

Identifies the disk or volume currently being referenced by 
XTreeGold. 

Example: DISK C:XTREE 

Available 

Bytes 99,999,999 

The Disk specification box contains the volume label and number 
of available bytes on that volume for file and directory storage. It 
is immediately updated each time you log or select a disk or vol­
ume. 

Statistics Box 

Displays information about files and the amount of storage space 
they occupy. This display changes depending on which of the Di­
rectory or File windows is active. When the Directory window is 
active, the statistics reflect the data for the current volume. 
When a File window is active, the statistics for the current direc­
tory (or all directories if a Branch, Showall or Global file window 
is active) are displayed. In addition to the number of files and the 
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amount of storage space they occupy, this box shows the number 
of tagged files and how many bytes the files occupy. The current 
directory or file and the number of bytes contained in it are dis­
played in the lower area. Statistics are immediately updated 
each time you make a change. 

Example: DISK Statistics 

Total 

Files 296 

Bytes 6,602,239 

Matching 

Files 32 
Bytes 1,467,866 

Tagged 

Files 12 

Bytes 602,239 

Current Directory 

XTREE 

Bytes 270,660 

Command Menu 

Displays the available Directory or File commands, depending on 
which window is active. 

Example: 

DIR Avail Branch Compare Delete Filespec Invert 

COMMANDS Oops! Print Rename Showall Tag Untag Volume 

~ file F7 autoview F8 split F9 menu FlO commands 

The available XTreeGold commands are always displayed on 
three lines below the windows. One upper-case letter of each com­
mand may be highlighted to identify the hotkey which is the key 
you should press to select that command. Or a function key may 
be displayed next to a command if it used by the command. 
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Prompt Line 

When additional input is required after a command or option se­
lection, a prompt line will be displayed for that additional input. 

Example: 
Copy file: MYFILE.DOC as 

Enter file spec or strike enter 

Displayed in place of the command menu, this list of additional 
options includes the current function key options and additional 
available XTreeGold input needed to complete a selected opera­
tion. 
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Pull-Down Menu Display 

XTreeGold also provides a menu bar and pull-down menus, which 
group the commands by category in an easy-to-locate display. To 
access these menus, simply press FlO or click FlO commands on 
the Standard command menu at the bottom of the screen when ei­
ther the Directory or File window is displayed, or point and click 
in the top line of the screen. 

Menu Bar 

XTree File Directory 

Application Menu 
Configuration 

Execute (qui ck) 
Execute <all MBMory) 

The Menu Bar 

FILE w. w 

Displays the headers for all the currently available pull-down 
menus. The header of the currently displayed pull-down menu is 
always highlighted. You may click any header with the mouse to 
select a pull-down menu. 
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Pull-Down Menus 

Display all the currently available commands, depending on 
whether the Directory or File window is active. Each time the 
pull-down menus are opened the prompt: Press Fl or click 
right mouse button for menu item descriptions is displayed. 
After you enable the pull-down menu help summaries they are 
displayed until you close the menus. 

Once the menu bar is displayed, you may scroll through the pull­
down menus with the Right or Left Arrow, or scroll through 
items on a menu with the Up or Down Arrow. You may select a 
highlighted item by pressing Enter. Or, press the highlighted 
key, also called the hotkey, to select an item on an open pull-down 
menu. Or, simply point to the item with the mouse and click the 
left mouse button. 

When an ellipse( ... ) is displayed after a command name, addi­
tional input will be required. Once you select the command, 
XTreeGold will display another menu, question or prompt in the 
prompt line at the bottom of the screen. 

By offering both command menus and pull-down menus, 
XTreeGold provides a large amount of user flexibility. You can se­
lect commands from either the command menus at the bottom of 
the display or the pull-down menus, depending on your prefer­
ence. Additional prompts, available keys or information are then 
always displayed on the prompt line at the bottom of the screen. 
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Additional Windows 

When the Main Display is first shown, the Small file window is al­
ways displayed. Other File window formats are: 

D Expanded 

D Branch 

D Showall 

D Global 

The displays look identical, except that each provides file informa­
tion from different sources, and the label and information in the 
Statistics box changes to correspond to the display. 

Expanded File Window 

Replaces the Small file window and Directory window, allowing 
the display of up to 57 file names at once. The files in the current 
directory are listed. To access: 

D Press Enter when the Small file window is active. 

-OR-

D Select Directory files from the Window pull-down menu. 
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Branch File Window 

Lists the files in one logged directory and all its logged sub­
directories that match the File specification. If*.* is in the File 
specification box, all the files in all logged subdirectories on the 
branch are listed in the File window. To access select the top level 
directory in a branch when the Directory window is active, then: 

D Press B or click Branch. 

-OR-

D Select Branch files from the Window pull-down menu. 

Showell File Window 

Lists the files in all logged directories on the volume that match 
the File specification. If*.* is in the File specification box, all the 
files on the current volume in all logged directories are listed in 
the File window. To access: 
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D Press S or click Showall when the Directory window is active. 

-OR-

D Select Disk files (Showall) from the Window pull-down 
menu. 

Global File Window 

Lists the files in all logged directories on all logged volumes that 
match the File specification. To access: 

D Press G or click Global when the Directory window is active. 

-OR-

D Select Global from the Window pull-down menu. 

Complete information on the Branch, Showall and Global file win­
dows can be found in Chapter 4. 

Splitting Directory and File Windows 

XTreeGold lets you split the Directory and File windows into a 
two window format, a feature that is especially useful when view­
ing and comparing the contents of different volumes and directo­
ries. Some examples of ways you might use split windows are to: 

D Simultaneously view directory trees of different disks and vol­
umes 

D Simultaneously view the contents of different directories on 
the same volume 

D Simultaneously view the contents of different directories on 
different volumes 

D View the contents of a potential destination volume or direc­
tory while retaining a view of your source 
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~Note: The File specification box, Disk specification box and 
Statistics box disappear in a split window format. The cur­
rent file specification is at the top of each window in the dis­
play. 

To split the window into a two window format when the Directory 
or File window is active: 

D Press F8 or click F8 split 

-OR-

D Select Split on/off from the Window pull-down menu. 

Complete information on XTreeGold's split window capabilities 
can be found in Chapters 4 and 5. 
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Moving Around the Windows 

You can use the mouse and keyboard interchangeably to move be­
tween Directory and File windows. 

The charts on this and the following pages provide the keys and 
mouse action to move between the Directory and File windows 
and to move around in each window. 

D Moving Between the Windows 

Key 

Enter 

Enter 

B 

s 

G 

Escape 
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Mouse Action 

Click the .J 
file prompt 

Click the .J 
more prompt 

Click Branch 

Click Showall 

Click Global 

Click Esc 
cancel 

Purpose 

To move from the Directory 
window to the Small file win­
dow 

To move from the Small file 
window to the Expanded file 
window 

To move from the Directory 
window to the Branch file win­
dow 

To move from the Directory 
window to the Showall file 
window 

To move from the Directory 
window to the Global file win­
dow 

To move froni any File win­
dow back to the Directory win­
dow 
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D Using Keys in the Directory window 

Key 

iUpArrowor 
j, Down Arrow 

Page Down 

Page Up 

Home 

End 

~ Right Arrow 

f- Left Arrow 

*(asterisk) 

+(plus) 

Getting Started 

Purpose 

To scroll through a directory 
tree and select a directory 

To move from the first to last 
line displayed on a window, 
and then scroll the next sec­
tion of the list onto the window 

To move from the last to first 
line displayed, and then scroll 
the previous section of the list 
onto the window 

To place the highlight bar on 
the first item of the displayed 
list 

To place the highlight bar on 
the last item of the list 

To move the highlight bar 
down the current path to the 
next subdirectory 

To move the highlight bar to 
the current directory's parent 

To log the current directory 
and all the files and sub­
directories in that branch 

To log the current directory 
and all the files in that direc­
tory, and the first-level sub­
directories 
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- (minus) 

F5 

F6 

<>(brackets) 

Enter 

To release the files and direc­
tories in the current branch 
from XTreeGold memory 

To show or hide the directory 
tree display one level below 
the current subdirectory (see 
note) 

To show or hide the directory 
tree display at the current sub­
directory level (see note) 

To select another logged 
volume 

To move to the Small file 
window 

~ Note: When you use F5 or F6 key to collapse the tree display, 
files that have been logged remain logged. 

2-20 Getting Started 



0 Using the Mouse in the Directory Window 

Mouse Action 

Point to the desired directory 
and click the left button 

Point to the top or bottom bor­
der of the Directory window 
and hold down the left button 

Point to a directory and click 
the right mouse button. Drag 
the mouse (move it while hold­
ing down the right button) to 
continue changing the tag 
state of other files 

Double-click the + (plus) sign 

Double-click the space to the 
left of the branch 

Point to the File window and 
click the left button, or point to 
the .J file prompt and click the 
left button 

Getting Started 

Purpose 

To select a directory 

To scroll the directory tree 

To toggle the tags in the direc­
tory 

To log the current directory 
and all the files in that direc­
tory, and the first-level sub­
directories 

To hide the display of the en­
tire branch (the file and direc­
tory information remain in 
memory) 

To move to the Small file 
window 
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0 Using Keys in File Windows 

Key 

I Up Arrow or 
J. Down Arrow 

Page Down 

Page Up 

Home 

End 

~ Right Arrow or 
f- Left Arrow 

.J Enter 

Escape 

2-22 

Purpose 

To scroll up or down through a 
file list and select a file 

To move from the first to last 
line displayed on a window, 
and then scroll the next sec­
tion of the list onto the window 

To move from the last to first 
line displayed on a window, 
and then scroll the previous 
section of the list onto the win­
dow 

To place the highlight bar on 
the first item of the displayed 
list 

To place the highlight bar on 
the last item of the displayed 
list 

To move the highlight bar to 
the right or left from column 
to column 

To move from the Small to the 
Expanded file window 

To move to the Directory win­
dow 
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D Using the Mouse in File Windows 

Mouse Action 

Point to the desired file name 
and click the left button 

Point to the top or bottom bor­
der of the File window and 
hold down the left button 

Point to the file and click the 
right button. Drag the mouse 
(move it while holding down 
the right button) to continue 
changing the tag state of files 

Point to the .J more prompt 
and click the left button 

Point to the .J tree prompt 
and click the left button 

Double-click the right button 

Double-click the left button 
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Purpose 

To select a file 

To scroll the file display 

To change the tag on a file 

To move to the Expanded file 
window from the Small file 
window 

To move to the Directory win­
dow 

To view the current file 

To perform the open command 
on the current file 
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How Pull-Down Menus are Organized 

Pull-down menus provide an efficient way to organize groups of a 
program's related functions. When a program has many capabili­
ties, as XTreeGold does, pull-down menus make it easier for 
users to find commands, since they can be presented logically by 
category. XTreeGold provides two groups of pull-down menus: 

D Directory pull-down menus, which are displayed when se­
lected with the Directory window active 

D File pull-down menus, displayed when selected with any File 
window active (remember, there are several file windows) 

When an ellipse( •.• ) is displayed after a command name, addi­
tional input will be required. Once you select the command, 
XTreeGold will display another menu, question or prompt in the 
prompt line at the bottom of the screen. The keys displayed on 
the right of each menu are accelerator keys. In general, you may 
use either the hotkeys displayed in a contrasting color or these ac­
celerator keys whenever they are displayed. 

When you select a command from a pull-down menu the highlight 
bar blinks momentarily, creating a wiggle effect. The wiggle fea­
ture helps confirm your command selection. You may toggle this 
feature on and off by pressing the Scroll Lock key. 

Within each set of pull-down menus, there are both unique and 
overlapping headers on the menu bar and pull-down menus: 

D XTree 

D File 

D Directory (displayed only when a Directory window is active) 

D Tagged (displayed only when a File window is active) 

D Volume 
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D Tag 

D Window 

XTree 

Contains commands that are not applied directly to files, directo­
ries, volumes or windows, which are available when any window 
is active. These commands include those used to start applica­
tions and execute commands, to obtain on-line help and to quit 
XTreeGold. 

File 

Contains commands that can be performed on individual files or 
files displayed in the active window. When you select a command 
from this menu with the file window active, it will be applied to 
the current file (the one selected with the highlight bar) in the 
current file window. 

l Getting Started 

File 

Attributes ... 
Copy ... 
Delete 
Edit 
Move •.. 
New date ... 
Open <quick> 
Open (al 1 MeMory l 
Open Zip and Arc 
Print. .. 
RenaMe ... 

Al t+O 
Alt+FS 

p 
R 
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Directory 

Contains commands that can be performed on individual directo­
ries. When you select a command from this menu, it will be ap­
plied to the current directory (the one selected with the highlight 
bar) in the Directory window. This menu is available only when 
the Directory window is active. 

Tagged 

Directory 

Delete 
Graft ... 
Hide-unhide 
Make .. . 
Prune .. . 
Re log 
RenaMe ... 

Al t+G 
Alt+H 

M 
Al t+P 

Al t+F3 
R 

Contains commands that can be performed on all tagged files in 
the current window. This menu is available when any of the file 
windows is active. 
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Tagged 

Attributes ... 
Batch ... 
Copy files ... 
Copy with paths ... 
Delete ... 
Move files ... 
Move with paths ... 
New date ... 
Print ..• 
RenaMe . . . 
Search .. . 
View 

Ctrl +A 
Ctrl +B 
Ctrl+C 

Alt+C 
Ctrl+D 
Ctrl+M 

Alt+M 
Ctrl +N 
Ctrl+P 
Ctrl+R 
Ctd+S 
Ctrl+V 
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Volume 

Contains commands that can be performed on a volume or disk­
ette, such as the log and format commands. The commands dis­
played depend on whether the Directory or File window is active. 

UoluMe 

Log options... Al t+L 
Release disk... Alt+R 

Next 1 ogged disk 
Switch to disk... Ctrl+L 

Available space ... 
forMat diskette... Al t+fZ 
NaMe... U 
Print... P 
Statistics 
Wash deleted space Al t+W 

Tag 

Contains the set of commands that enable you to tag and untag 
files. The commands displayed depend on whether the Directory 
or File window is active and can be applied to the current direc­
tory, current file, or all files in the current window. 
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Tag 

Directory files 
All disk files Ctrl+T 

----- untag ---­
Di rectory files 
All disk files Ctrl+U 
All by attributes... Alt+U 

Merge split tags Ctrl+f& 
Invert dir files... I 
Invert disk files... Ctrl+I 
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Window 

Contains commands that apply to one or more ofXTreeGold's win­
dows, such as the Autoview and Split window commands. 

Window 

Split on/off 
Uideo Mode 

Directory files 
Branch files 
Branch tagged 
Disk files < Showall) 
Disk tagged 
Global 
Glob al tagged 

file specification ... 
file display coluMns 
Sort criteria ... 

f8 
Alt+f9 

Enter 
B 

Ctrl+B 
s 

Ctrl+S 
G 

Ctrl+G 

f 
Al t+f 
Al t+S 

The charts on the following pages provide the keyboard and 
mouse actions to execute commands from the pull-down menus. 
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D Executing Commands With Keys 

Key 

FlO 

--t Right Arrow or 
t- Left Arrow 

i Up Arrow or 
J,Down Arrow 

Hotkey (highlighted letter) 

Fl 

Escape 

Getting Started 

Purpose 

To display the Menu bar and 
most recently displayed pull­
down menu 

To display the next pull-down 
menu to the right or left 

To highlight a command on a 
menu 

To execute the corresponding 
command 

To turn on the display of Help 
summaries for each high­
lighted item 

To cancel the pull-down 
menus and return to the Direc­
tory or File window 
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D Executing Commands With the Mouse 

Mouse Action 

Point to FlO commands or 
the line at the top of the screen 
and click the left button 

Move the mouse pointer in the 
menu bar area until the de­
sired menu header is high­
lighted, then click the left 
button 

Move the mouse pointer until 
the desired command is high­
lighted, then click the left but­
ton 

Click the right button 

Highlight anywhere outside 
the menu bar and pull-down 
menu displayed and click the 
left button 
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Purpose 

To display the Menu bar and a 
pull-down menu 

To display the Menu bar and 
pull-down menu at that loca­
tion 

To execute any command 

To turn on the display of Help 
summaries for each high­
lighted item 

To cancel the pull-down 
menus and return to the Direc­
tory or File window 
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How Command Menus are Organized 

We have seen that there are two main sets of commands in 
XTreeGold: 

D Directory commands are available when the Directory win­
dow is active (when the highlight bar is in the Directory win­
dow). 

11 D File commands are available when one of the File windows is 
active (when the highlight bar is in a File window). 

Within each set, there are three types: 

D Standard Commands 

D Ctrl Commands 

D Alt Commands 

Standard Commands 

Displayed on the menu at the bottom of the screen, they usually 
perform operations on individual directories or files. 

Ctrl Commands 

Displayed when you hold down the Ctrl key or move the mouse 
over the word COMMANDS in the prompt line and click with the 
mouse, they usually perform operations on multiple files or direc­
tories. You can also reach Ctrl commands by pressing F4 while 
the Standard commands are displayed. 

Alt Commands 

Displayed when you hold down the Alt key or move the mouse 
, over the word COMMANDS and double-click with the mouse, 
J these are advanced commands that extend the function of the 

Standard commands. You can also reach Alt commands by press­
ing F4 while the Ctrl commands are displayed. 
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Some commands are available when either the Directory or File 
window is active and are displayed on both the Directory and File 
command menus. 

Directory Commands 

Directory commands include Standard, Ctrl and Alt commands, 
and also function keys. Remember, the available commands can 
always be displayed on the menu at the bottom of the screen. To 
select any command, either press the hotkey (displayed) or point 
to the command with the mouse and click the left button. 

Standard Directory Commands 

The Standard directory commands usually apply to individual di­
rectories. They are displayed on the command line when the Di­
rectory window first becomes active. 

DIR Avai I Branch Cottpare Delete Fi !espec Global Invert Log Make 
COMMANDS Oops• Print Renatte Showa!! Tag Untag Uolutte eXecute Quit 
~file F7 autoview F8 split F9 Menu F10 cottttands Fl help ? stats 

Ctrl Directory Commands 

Ctrl directory commands are generally applied to multiple files or 
directories. To display them, press F4 or hold down the Ctrl key 
while the Directory window is active or select DIR COMMANDS 
with the mouse and click. 

CTRL DIR Branch Global Invert Log disk Showa! I tagged fi !es Tag Untag 
COMMANDS 

Alt Directory Commands 

Alt directory commands are advanced directory commands that 
extend the function of the Standard commands. To display them, 
hold down the Alt key while the Directory window is active or se-
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lect DIR COMMANDS with the mouse and double-click, or press 
F4 when the Ctrl commands are displayed. 

ALT DIR Edit File display Graft H1de/unh1de Log disk Prune Release dis 
COMMANDS Sort criteria Tag Un tag Wash d 1 sk execute Ou1 t 

FZ forMat F3 relug d1r F9 video Mode F10 configure 

File Commands 

File commands include Standard, Ctrl and Alt commands, and 
also function keys. As with directory commands, the available 
file commands are always displayed on the menu at the bottom of 
the screen. To select any command, either press the highlighted 
key or select the command with the mouse and click the left but­
ton. 

Remember that there are four different File windows, and when 
the different File windows are active, different groups of files are 
affected by the selected command. 

Small or Expanded 

Branch 

Showall 

Global 

Getting Started 

Matching files in the current 
directory 

Matching files in one directory 
and all its subdirectories (on 
the current volume) 

Matching files in all sub­
directories on the current vol­
ume 

Matching files on all logged 
volumes 
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Standard File Commands 

The Standard file commands usually apply to individual files. 
They are displayed on the command line when a File window first 
becomes active. 

FILE Attributes Copy Delete Edit Filespec lnuert Log disk Moue 
COMMANDS NeLJ date Open Print RenaMe Tag Untag UieLJ eXecute Quit 
+-I tree F7 autouieLJ FB split F9 Menu F10 COMMands Fl help ESC cancel 

Ctrl File Commands 

Ctrl file commands are generally applied to multiple tagged files. 
To display these commands, press F4 or hold down the Ctrl key 
while the File window is active or select FILE COMMANDS 
with the mouse and click. 

CTRL FILE Attributes Batch Copy Delete lnuert Log disk Moue NeLJ date 
COMMANDS Print RenaMe Search Tag Untag U i eLJ 

FS archiue files F& Merge tags FB partial untag 

Alt File Commands 

Alt file commands are advanced file commands that extend the 
function of the Standard commands. To display these commands, 
hold down the Alt key while the File window is active, or select 
FILE COMMANDS with the mouse and double-click, or press 
F4 while the Ctrl file commands are displayed. 

ALT FILE Copy File display Log disk Moue Open Release disk Sort criteri 
COMMANDS Tag Untag eXecute Quit 

FZ forMat F3 relog d1r F4 coMpare F5 open archiue 

The charts on the following pages provide the keyboard and 
mouse actions to execute commands from the command menus. 
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D Executing Commands With Keys 

Key Purpose 

F4 To cycle through the command 
menus 

Ctrl To display the Ctrl command 
menu 

Alt To display the Alt command 
menu 

Hotkey To execute any command 

Fl To display a Help Screen 

Esc To cancel the current opera-
tion and return to the Direc-
tory or File window 
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D Executing Commands With the Mouse 

Mouse Action _Pu_r~p_o_s_e ________ _ 

Point to DIR COMMANDS or To cycle through the command 
FILE COMMANDS at the bot- menus 
tom left of the screen and click 
the left button 

Move the mouse pointer to the 
command menu until the de­
sired command is highlighted, 
then click the left button 

Highlight ESC cancel in the 
prompt line and click the left 
button 
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To execute any command 

To cancel the current opera­
tion and return to the Direc­
tory or File window 
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Responding to Command Prompts 

When you select some of XTreeGold's commands, additional input 
may be required to complete a procedure. This will be indicated 
by the display of a prompt, submenu and/or additional options. 
You can always respond to a prompt by typing the input re­
quested and you can use either ofXTreeGold's shortcuts that are 
displayed in the prompt line. 

Entering and Editing Text 

Some XTreeGold commands require that you respond to addi­
tional prompts and enter information such as a new file name or 
confirmation of potentially dangerous commands. You will also 
enter text in the Command shell to perform DOS operations. The 
mouse does not perform editing functions. The chart on page 
2-41 shows the available keys. 

Using the Command History 

Whenever you respond to an XTreeGold prompt, XTreeGold saves 
your entry in a command history file. A separate history is main­
tained for each type of command and for the Command shell. 
When the history option is available, it is displayed in the prompt 
line as I history. When you select it with either the up arrow 
key or mouse, the history window is displayed. Then, instead of 
typing an entry, you can review your past responses and select 
from the list. You can select the entry by placing the highlight 
bar on it and pressing Enter or clicking the mouse to confirm. 

XTreeGold stores up to 16 entries for each kind of operation. 
Each time you enter an item which doesn't appear in the history 
list, XTreeGold adds it to the corresponding list. Because histo­
ries are maintained in a file, they remain available from one 
XTreeGold session to another. Since XTreeGold replaces existing 
entries with new ones, you must decide and specify the items you 
want to keep in your command histories on a permanent basis. 
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Typical history files will have some entries marked as perma­
nent, while other entries will change on a daily basis along with 
your program usage. 

To specify an entry as permanent, highlight the entry and press 
the Insert key. XTreeGold marks each permanent entry with a 
bar. To remove this mark, highlight the marked entry and press 
Insert again. To remove any entry from a command history, se­
lect the entry and press the Delete key. 

Pointing to a Destination 

When a command requires that you indicate a destination path, 
XTreeGold lets you point to that destination in a Destination win­
dow rather than typing in the name of the destination at the 
prompt or selecting it from the command history. When the 
Point option is available, it is displayed in the prompt line as F2 
point. When you select it with either the function key or mouse, 
the Destination window is displayed. You can then select the 
path by placing the highlight bar on it and pressing Enter or 
clicking the mouse to confirm. 

As an example, you might point to a destination directory when 
you are copying files from one directory to another. Pointing elim-
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inates the need to remember the exact spelling and syntax of a di­
rectory or volume because you are selecting it from the destina­
tion and copying it to the prompt line. 

The charts on this and the following pages provide the keyboard 
and mouse actions to respond to prompts. 

0 Responding to Prompts With Keys 

i Action 

Enter 

i Up Arrow 

F2 

F3 

Getting Started 

Response 

To complete an entry of text or 
confirm an informative mes­
sage 

To display the command his­
tory 

To display the destination di­
rectory window or a pick list 

To use the most recent history 
entry 
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D Responding to Prompts With the Mouse 

Action 

Move the mouse pointer over 
one of the prompts in the 
prompt line and click the left 
button 

Highlight .J ok in the prompt 
line and click the left button 

Highlight i history in the 
promp_t line and click the left 
button 

Highlight F2 point in the 
prompt line and click the left 
button 
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Response 

To respond to messages and 
questions 

To complete an entry of text or 
confirm an informative mes­
sage 

To display the command his­
tory 

To display the destination di­
rectory window 
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D Entering and Editing Text 

Key 

Home 

End 

~ Right Arrow or 
~LeftArrow 

Backspace 

Delete 

Insert 

Ctrl + Backspace 

Getting Started 

Purpose 

To move the cursor to the be­
ginning of a line 

To move the cursor to the end 
of a line 

To move the cursor one posi­
tion to the right or left with­
out altering the text 

Deletes one character to the 
left of the cursor 

Deletes the character under 
the cursor 

Toggles Insert On and Off. 
When On, you can insert char­
acters to the left of the cursor. 
When Off, typing a character 
replaces the character at the 
cursor. 

Erases the line and moves the 
cursor to the first position 
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D Selecting an Entry From a Command History 

Additional options are available when selecting an item from a 
command history. 

Keys 

Up Arrow 

iUpor 
J, Down 
Arrow 

Enter 

Esc 

Insert 

Delete 
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Mouse Action 

Click 
i history 

Highlight an 
entry 

Double-click 
an entry 

Highlight ESC 
cancel and 
click 

Purpose 

Displays a history of re­
sponses associated with the 
currently displayed prompt or 
the Command shell 

Places the highlight bar on (se­
lects) an entry in the list 

Copies the selected entry to 
the prompt 

Returns to the prompt without 
copying an entry 

After an entry is highlighted, 
pressing Insert marks an 
entry as permanent. To re­
move a permanent mark, 
press Insert again 

After an entry is highlighted, 
removes it from the history 
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Getting Help 

XTreeGold provides extensive help information in a logical se­
quence of help screens. The screens provide: 

0 Descriptions of the windows and menus 

0 Use of the cursor, function and editing keys 

0 Both brief and in-depth discussions of every command 

Help Screens 

The Help screens are context sensitive so that appropriate infor­
mation is presented to you whenever you select Help and the in­
formation is relative to your location and action in the program. 
So, if you select a command from a command menu and then se­
lect Help, information will be presented on the command you se­
lected. If you choose the Help command without a specific 
selection, XTreeGold displays a representation of the Main Dis­
play. You then select the graphic (using the Arrow Keys or 
mouse) that corresponds to the topic you want help with and 
press Enter to view additional information on that topic. 

Within the Help screens, you can select additional topics by high­
lighting the topic and pressing Enter. Six options are available 
on each Help screen. To select an option, press the highlighted 
character, select with the highlight bar and press Enter, or se­
lect with the mouse by highlighting and clicking. 
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D Displaying Help Screens 

To display a Help screen at any time, follow these steps when the 
pull-down menus are not displayed. 

Action 

1. Press Fl 

2. Highlight your choice on the 
screen for an additional help 
topic and press Enter 

3. Press Esc 
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Response 

The corresponding page of the 
Help screens is displayed 

A full screen of information on 
that topic is displayed 

The Help Screen is cancelled 
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o Help Screen Options 

The following additional Help Screen options are available. 

Option 

Next Page 

Last Page 

Back 

Dir Commands 

File Commands 

Index 

Esc 

Getting Started 

Purpose 

Displays the next screen of 
help information 

Displays the previous help 
screen 

Enables you to back up 
through the Help screens you 
have viewed 

Provides a list of directory 
commands with brief descrip­
tions; a specific command can 
be chosen from this list to 
view more information 

Provides a list of file com­
mands with brief descriptions; 
a specific command can be cho­
sen from this list to view more 
information 

Lists the help topics in se­
quence 

Returns to XTreeGold at the 
location prior to accessing help 
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Pull-Down Menu Help 

If you press Fl or click the right mouse button while the pull­
down menus are displayed, a help summary is displayed for each 
highlighted menu item on every menu until you close the pull­
down menus. This brief description is displayed in the prompt 
line. 

If you want to see more comprehensive Help information, choose 
Help from the XTree pull-down menu by pointing and clicking 
with the mouse or pressing the hotkey H. 

D Displaying Pull-Down Menu Help 

To display a summary of each item on the pull-down menus, fol­
low these steps when the pull-down menus are displayed. 

Action 

1. Press Fl or click the right 
mouse button 

2. Use the Arrow keys or 
mouse to scroll pull-down 
menu items for additional 
information 
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Response 

A brief summary of the cur­
rently highlighted command is 
displayed at the bottom of the 
screen 

A brief summary of each item 
is displayed as it is high­
lighted until the pull-down 
menus are closed 
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Quitting XTreeGold 

There are two Quit commands that enable you to exit XTreeGold. 
The Quit command enables you to exit XTreeGold and return to 
the operating system prompt. It is available: 

V When any Directory or File window is active 

D From the XTree pull-down menu 

By clicking Quit XTreeGold or pressing the hotkey Q 

XTree 

Help Fl 

Application Menu F9 
Configuration Al t+F10 

Execute (quick) X 
Execute <all MeMoryl Alt+X 

Ouit to directory Alt+O 

D Or, from the Standard directory and Standard file com­
mand menus 

By clicking Quit or pressing Q 

DIR Avail Branch Co11pare Delete Filespec Global Invert Log Make 
COMMANDS Oops! Print Rena11e Shouall Tag Untag Uolu11e eXecute iimJ 
+-I file F7 autovieu F8 split F9 11enu F10 co1111ands Fl help ? stats 

When you choose the Quit command, you are prompted for confir­
mation. Either: 

D Press Y(es) to confirm the exit. 

D Press N(o) to cancel and remain in XTreeGold. 
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You can also configure XTreeGold to exit without requesting con­
firmation. See Chapter 10 for more information on configuration 
options. 

Quit to Directory 

The Alt Quit command enables you to exit XTreeGold and return 
to the operating system prompt, automatically setting the current 
DOS directory to be the current directory setting in XTreeGold. 
It is available: 

V When any Directory or File window is active 

D From the XTree pull-down menu 

By clicking Quit to directory, or pressing the hotkey t 

D Or, from the Alt directory and Alt file command menus 

By double-clicking COMMANDS and then clicking Quit 
or pressing Alt + Q 

When you choose this Quit command, you are also prompted for 
confirmation. Either: 

D Press Y(es) to confirm the exit. 

D Press N(o) to cancel and remain in XTreeGold. 

You can also configure XTreeGold to exit without requesting con­
firmation. See Chapter 10 for more information on configuration 
options. 

Quick Exiting - Exit with Save 

XTreeGold provides a command for quick exiting, that is not dis­
played on the menus. This command can be selected when any 
window is active by pressing Alt + Z. When you press Alt + Z, 
XTreeGold immediately exits to DOS and at the same time saves 
all the current program (disk, directory, file and tagging) informa­
tion. The next time you start XTreeGold, it restores all the infor­
mation to the same state as when you exited. Of course, if 
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changes were made to the directory structure or your files from 
the DOS prompt or other applications, those changes will not be 
displayed until you relog the disk or modified directory. 

D Exiting XTreeGold 

To exit XTreeGold when either the Directory or File Commands 
are displayed: 

Action 

1. Press FlO or click com­
mands 

2. Press the Right or Left 
Arrow or click XTree to open 
the XTree pull-down menu 

3. Press tor click Quit to di­
rectory 

4. Press Y or click Yes 

Getting Started 

Response 

The pull-down menus are dis­
played 

The first item, Help, is high­
lighted 

The prompt Quit XTreeGold 
and return to DOS? is dis­
played 

The DOS command line 
prompt (for example 
C:\XTGOLD) is displayed 
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Summary 

This chapter introduced the elements that provide the foundation 
for XTreeGold and all its operations. These include: 

0 Installing, starting and exiting XTreeGold 

0 Menus, screens and windows 

0 How commands are organized 

0 Using the keyboard and mouse to move around and execute 
commands 

0 Obtaining help 

The next chapter introduces some of XTreeGold's commands that 
will enable you to easily manage your files. 
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Working With Files, Part 1 

XTreeGold provides a number of commands to speed up and sim­
plify common file management tasks. This chapter provides a 
thorough explanation of the commands you'll use and step-by­
step instructions to easily complete these tasks: 

D Copying files 

D Deleting files 

D Undeleting files 

D Moving files 

D Renaming files 

D Printing the contents of files 

The chapter begins with a discussion ofXTreeGold's many file 
handling capabilities and concepts, which will provide a solid 
basis for your understanding of all of the file management tasks. 
We also include some pointers to help you use XTreeGold to your 
best advantage. The following topics are presented, as a founda­
tion for the tasks: 
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D Matching files 

D Displaying file information 

D Choosing the best file window 

D Statistics box 

D Selecting and tagging files 

0 Selecting all files in a directory 

D Selecting all files on a volume 
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Matching Files 

One of the most important concepts in working with files is the 
concept of matching files. XTreeGold uses the term matching 
files to enable you to specify files which will be acted on by its 
commands. Each time XTreeGold starts, the wild card*.* is in 
the File specification box and all files are matching files until you 
make a change. 

The names of all matching files (and only matching files) are al­
ways listed in the File window. When file commands are per­
formed, they are performed on files you see in the window, which 
are the matching files. 

Matching files are controlled by the Filespec command. The 
Filespec command is available: 

V' When any Directory or File window is active 

D From the Window pull-down menu 

By clicking File specification or pressing the hotkey F 

Window 

Autoview F7 
Split on/off FS 
Uideo Mode Al t+F9 

Directory files Enter 
Branch files B 
Branch tagged Ctrl+B 
Disk files < Showall) S 
Disk tagged Ctrl+S 
Global G 
Global tagged Ctrl+G 

File display coluMns Alt+F 
Sort criteria... Alt+S 
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D Or, from the Standard directory or file command menu 

By clicking File spec or pressing the hotkey, F 

DIR Auail Branch Co11pare Delete IDl!mlm!! Global lnuert Log Make 
COMMANDS Oops• Print Rena11e Showa! I Tag Untag Uolu11e eXecute Quit 
..___JfiJe F7 autouiew F8 split F9 11enu F10 co1111ands Fl help ? stats 

Use the Filespec command to select a group or groups of files that 
will be displayed in the file window and acted upon by 
XTreeGold's commands. 

When you choose the Filespec command, XTreeGold prompts you 
for a new file specification. You can either: 

D Press Enter to automatically default to the *. * wild card 

D Enter any file specification by typing one at the prompt 

D Select an item from the history file (press Up Arrow or click 
history) 

D Enter up to 28 different file specifications separated by com­
mas or spaces using* and/or? characters to specify particu­
lar groups of files to be included 

When you make a change, the name of the file you are matching 
is always displayed in the File specification box. This file name 
can include wild cards, for example MYFILE.* or *.TXT. For ex­
ample, entering a multiple file specification of: 

*.EXE, *.BAT,*. COM (the executable file extensions) 

would allow you to display all executable files for group opera­
tions. After entering the file specification, you can use the 
Showall command to display all executable files on the current 
volume, or choose the Global command to display all executable 
files on all logged volumes. (The Showall and Global commands 
are discussed in the next chapter.) 
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You can make sets of file specifications easy to identify by adding 
a descriptive label to each list of specifications. To label a set of 
file specifications, first enter a descriptive word, then type a colon 
(:) before entering the multiple specifications. For example: 

PROGRAMS:*.EXE,*.BAT,*.COM 

Because XTreeGold ignores all the text before the colon, you can 
use this technique to create groups of file specifications that can 
be readily identified in the File specification box (or the history 
for file specifications), regardless of their length. 

You can also display all files that do not match the file specifica­
tion by placing a minus sign (-) in front of a file specification. For 
example: 

-*.BAT 

would result in all files except those matching the file specifica­
tion *.BAT being displayed. 

Once you have entered a new file specification, the File specifica­
tion box and the Statistics box are updated to reflect the change. 
Always look at both boxes to confirm the current matching files 
before performing operations or selecting commands. 

If a right arrow is displayed in the File specification box, all file 
specifications are not visible. To display the complete file specifi­
cation, press the Up Arrow key or click history to display a his­
tory of file specification entries. XTreeGold highlights the 
current file specification in the history window. 
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D Specifying Matching Files 

To change matching files with the File or Directory window ac­
tive, follow these steps. In this example, we'll change the file 
specification to display all backup files with the extension .BAK. 

Action 

1. Press F or click Filespec in 
the command menu 

2. Type the file specification 
*.BAK (the name of the files 
you want to see in the File win­
dow) and press Enter 

3. To change matching files 
back to the *. * wild card, press 
F or click Filespec and press 
Enter 
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Response 

The prompt Enter file speci­
fication is displayed 

The File specification box con­
tains the file name being 
matched, *.BAK, and the File 
window displays only those 
files with the .BAK extension. 

The File specification box con­
tains the file name *. * and all 
files are now matching files. 
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Displaying File Information 

The display of file information can be modified to best suit the 
needs of a particular task and/or your individual preference. You 
can: 

D Work on different groups of files by displaying either the 
Small or Expanded, Branch, Showall, or Global file window. 

D Modify the file display format to display files in one, two, or 
three column format. 

D Sort the files to display them in an order which best suits 
your needs. 

All these capabilities are explained in this section. 

Choosing the Best File Window 

As we have seen, File commands act on selected or matching files 
displayed in the File window. The scope of the File command you 
choose depends on the type of File window that is currently active. 

Again, the File windows are: 

Small or Expanded 
file window 

Branch file window 

Showall file window 

Global file window 
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File commands perform operations on all 
matching files in the current directory 

File commands act on matching files in 
one branch (one directory and all its sub­
directories) on the current volume 

File commands act on matching files in all 
directories on the current volume 

File commands act on matching files in all 
directories on all logged volumes 
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You can determine the best File window by the needs of the task 
you are going to perform. 

D Use the Small file window when you will be performing a task 
on files in only one directory and you can easily display all 
the file names. 

D Use the Expanded file window ifthat directory contains many 
files and you prefer to display the maximum number of file 
names. 

D Use the Branch file window if you are performing similar 
tasks on files in one directory and its subdirectories. 

D Use the Show all file window if you are performing similar 
tasks on files in more than one directory. 

D Use the Global file window if you have logged more than one 
volume and will be performing similar tasks on files on all the 
volumes. 

Working in either the Small or Expanded file window is a matter 
of personal preference and convenience. The Small file window is 
displayed as part of the Main Display and allows you to review 
file information while maintaining the directory tree display. 
The Expanded file window enables you to display a greater 
amount of file information at one time, but does not allow you to 
see the directory tree at the same time. 

All the steps in this Guide are written using the Small file win­
dow, which is displayed when you press Enter or click the .J file 
prompt once in the Directory window. If you prefer to work in 
the Expanded file window, simply press Enter twice or double­
click the .J file prompt. You can also configure XTreeGold to by­
pass the Small file window. See Chapter 10 for a description of 
this configuration option. 

In this chapter, we describe tasks that apply to files in one direc­
tory on a single volume using only the Small or Expanded file win­
dow. In Chapter 4, we'll describe how to span branches, 
directories and volumes by using the Branch, Showall and Global 
File windows and how to apply tasks across branches, directories 
and volumes. 
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D Choosing a File Window 

The Small File window is always displayed when the Directory 
window is active and the Main Display is on the screen. The keys 
and mouse action to move between the Small and Expanded file 
windows and the Directory window are shown in this chart. 

Key 

Enter 

Enter 

Esc 

FlO + 
(right or 
left arrow 
to) open 
the 
Window 
menu+D 

FlO + 
(right or 
left arrow 
to) open 
the 
Window 
menu+T 

Mouse Action 

Click the 
.J file prompt 

Click the .J 
more prompt 

Click Esc 
cancel 

Click FlO 
commands 
then Window 
then 
Directory 
files 

Click FlO 
commands 
then Window 
then Tree 
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Purpose 

To move from the Directory 
window to the Small file win­
dow 

To move from the Small to the 
Expanded file window 

To move from any File win­
dow back to the Directory win­
dow 

To move from the Directory 
window to the Small file win­
dow using pull-down menus 

To move from any File win­
dow back to the Directory win­
dow using pull-down menus 
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Modifying the File Display Format 

When XTreeGold is installed, the file windows are set to display 
in three columns, alphabetically by name, in ascending order, 
with a"." between the file name and extension. XTreeGold pro­
vides a command to enable you to change the file display format 
to provide additional information about files on an ongoing basis. 
The File display command is available: 

V' When any Directory or File window is active 

D From the Window pull-down menu 

By clicking File display columns or pressing the 
hotkey c 

Window 

Autoview 
Split on/off 
Uideo Mode 

cDirectory files 
Branch files 
Branch tagged 
Disk files <ShowalU 
Disk tagged 
Global 
Global tagged 

File specification ... 

Sort criteria ... 

F7 
FB 

Al t+F9 

Enter 
B 

Ctrl +B 
s 

Ctrl +S 
G 

Ctrl+G 

Alt+S 

D Or, from the Alt directory or Alt file command menu 

By double-clicking COMMANDS and then clicking File 
display or pressing Alt + F 

ALT FILE Cop!:J ~ Log disk Move Open Release disk Sort criteri 
COMMANDS Tag Untag eXecute Quit 

FZ forHat F3 relog dir F4 coHpare FS open archive 
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Using the File display command, you can change the File window 
display from three columns to two columns to one column, depend­
ing on the information you prefer to see in the File window. 
When you select the command, it immediately changes the dis­
play by removing a column from a three or two column display, or 
if one column display waR in effect, returns to three column dis­
play (the default). 

For example, a three-column display shows only a file name and 
extension, and any tag markings, as in this example: 

XTGOLD.CFG XTGOLD.HST 

XTGOLD.COM XTGOLD.XOl 

XTGOLD.EXE XTGOLD.X02 

XTGOLD.XlO 

XTGOLD.X20 

XTGOLD.X30 

A two-column format also displays the file size and attributes, as 
in this example: 

XTGOLD.COM 

XTGOLD.XOl 

XTGOLD.X02 

53,110 .a .. XTGOLD.XlO 16,046 .a .. 

24,274 .a .. XTGOLD.X20 15,019 .a .. 

10,032 .a .. XTGOLD.X30 13,976 .a .. 

A one-column format also displays the last modified date and 
time, as in this example: 

XTGOLD.COM 53,832 .a .. 12-22-90 12:00:00 pm 

XTGOLD.XOl 24,274 .a .. 12-22-90 12:00:00 pm 

XTGOLD.X02 10,032 .a .. 12-22-90 12:00:00 pm 
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Changing the File Sort Order 

XTreeGold provides a command which enables you to change the 
order in which files are displayed in the File window. This com­
mand is the Sort criteria command, available: 

V When any Directory or File window is active 

D From the Window pull-down menu 

By clicking Sort criteria or pressing the hotkey o 

Window 

Autoview F7 
Split on/off FB 
Video Mode Alt+F9 

Directory files Enter 
Branch files B 
Branch tagged Ctrl+B 
Disk files < Showall) S 
Disk tagged Ctrl +S 
Global G 
Global tagged Ctrl+G 

File specification ... 
file display coluMns Alt+F 

D Or, from the Alt directory or Alt file command menu 

By double-clicking COMMANDS and then clicking Sort 
criteria or pressing Alt + S 

ALT FILE Copy Fi le display Log disk Move Open Release disk 
COMMANDS Tag Untag eXecute Quit 

FZ for11at F3 relog dir F4 co11pare FS open archive 

Each time you start XTreeGold, files are displayed in alphabeti­
cal order by default. When you use the Sort criteria command, 
you select a new sort order which will be used in all subsequent 
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File window displays during the XTreeGold session. When you se­
lect the Sort criteria command, the Sort criteria submenu is dis­
played with these options: 

Name 

Extension 

Date 

Size 

Unsort 

Displays files in alphabetical order by 
their names. This is the default sort cri­
teria. 

Displays files in alphabetical order by 
their file name extensions. For example, 
all the *.DOC files appear before the 
*.TXT files. Files with the same exten­
sion are displayed in alphabetical order by 
name. 

Displays files in order of creation/modifica­
tion date. Files that were created or modi­
fied earlier are shown first, followed by 
newer files. Files with the same date and 
time are ordered by name. 

Displays files ordered by their size. The 
smallest files appear first, followed by 
larger size files. Files with the same size 
are ordered by name. 

Displays files in the actual order in which 
they are stored on the volume, just as you 
would see them if you typed the DIR com­
mand at the DOS prompt. 

Two additional toggle options provide further control. When 
using one of these options, select it first, then choose the sort cri­
teria option from the previous list. 

Order You can change the default display's as­
cending order to a descending order to 
find the largest or smallest, oldest or new­
est files on the volume. When you press 
0 you remain in the Sort prompt line, 
where you can select a sort criteria. 
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Path This toggle option applies only to the 
Branch, Showall and Global displays and 
allows you to specify that files be sorted 
sequentially in path order. Select Path 
Yes to group files according to directories. 
Select Path No to display all files sorted 
by the current sort criteria only. 

Once you select an option, no further action is necessary. The dis­
play is immediately updated. 

D Changing the Sort Order 

These steps show how to change the sort order so files are listed 
in order of creation/modification date, in descending order. The 
procedure is the same for any active window. You can substitute 
any Sort option for Date & Time in the example. 

Action 

1. Press Alt + S or select Sort 
criteria from the Window 
pull-down menu 

2. Press 0 or click Order 

3. Press D or click Date and 
Time 

Response 

The prompt Enter sort op­
tion is displayed 

The order is changed from as­
cending (the default) to de­
scending 

The files are displayed by date 
and time (in the new sort 
order you selected) 

The default sort order can be changed by using the configuration 
program described in Chapter 10. 
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Selecting Files 

Before you can use XTreeGold to perform tasks with files they 
must be selected. There are several ways to select files and the 
most efficient way will be based on your intended task. 

D To perform a task involving only one file, it can be selected by 
placing the highlight bar on it. 

D To specify groups of related files which will be acted upon by 
XTreeGold commands, first use the Filespec command to iden­
tify those files as matching files. 

D To perform operations on more than one file at a time, those 
matching files must be tagged (using the Tag command). In 
XTreeGold, tagging means to select files for subsequent opera­
tions and mark them with a diamond. 

D Once you have tagged a group of files, use the Ctrl file com­
mands also found on the Tagged pull-down menu. The com­
mands are always applied to all the tagged files. 

D After you have completed your task(s), use the Untag com­
mand to remove the tags from the files. 

Tagging Individual Files 

To perform tasks on more than one file in a directory, but not all 
the files, select and tag each file individually while the File win­
dow is active. The Tag command enables you to tag individual 
files in the current directory. It is available: 

V When any File window is active 

D From the Tag pull-down menu 

By clicking File or pressing the hotkey F 
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Tag 

All in window Ctrl+T 
All by attributes... Alt+T 
---- untag ----
File 
All in window Ct.rl +IJ 
All by attributes... Alt+U 
Partial untag Ctrl+FB 

Merge split tags Ctr 1 +ff, 

Invert file tag... I 
Invert dir files... Ctrl+I 

D Or, from the Standard file command menu 

By clicking Tag or pressing T 

FILE Attributes Copy Delete Edit Filespec Invert Log disk Move 
COMMANDS New date Open Print RenaMe iE!'j Untag UiE!w .,x.,cute Quit 
.____i tr"" F7 autoview FB split F9 ME!nu F10 coMMands Fl help ESC cancE!l 

When you select the Tag command, the current file (identified by 
the highlight bar) is selected and marked with a diamond. To tag 
a file, place the highlight bar on it and then select the Tag com­
mand. 

Untagging Individual Files 

If you accidentally tag a file you do not want to select or when you 
have finished a task with tagged files, use the Untag command to 
cancel the file selection and remove the tags. It is available: 

V' When any File window is active 

D From the Tag pull-down menu, under the subheader 
untag 

By clicking File or pressing the hotkey I 

D Or, from the Standard file command menu 

By clicking Untag or pressing U 
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Mouse Shortcuts 

D To change the tag state of files, point to the file and click the 
right mouse button 

D To continue changing the tag state of other files, drag the 
mouse (move it while holding down the right button) 

D Selecting (Tagging) Files 

To tag individual files named MYFILE.DOC and MYFILE.TXT in 
directory MYDIR, follow these steps. 

Action 

1. If the words DIR COMMANDS. 

are not displayed on the bot­
tom left of the screen, press Esc 

2. Press the Up or Down 
Arrow to place the highlight 
bar on directory MYDIR and 
press Enter or point to 
MYDIR and double-click 

3. Press the Up or Down 
Arrow to place the highlight 
bar on the first file to be 
tagged, MYFILE.DOC or point 
to MYFILE.DOC and click 

] 
4. Press T or click the right 
mouse button 
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Response 

The Directory commands are 
now available 

The File window is displayed 
for directory MYDIR 

The file MYFILE.DOC is se­
lected 

A diamond is displayed to 
show you the file has been 
tagged 
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5. Press the Up or Down 
Arrow to place the highlight 
bar on the second file to be 
tagged, MYFILE.TXT or point 
to MYFILE.TXT and click 

6. Press T or click the right 
mouse button 

The file MYFILE.TXT is se­
lected 

A diamond is displayed to 
show you the file has been 
tagged 

D Removing Tags from Files 

To remove the tags from an individual file named MYFILE.DOC 
follow these steps. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Press the Up or Down 
Arrow to place the highlight 
bar on the directory MYDIR 
and press Enter or point to 
MYDIR and double-click 

3. Press the Up or Down 
Arrow to place the highlight 
bar on the first file to be un­
tagged, MYFILE.DOC or point 
to MYFILE.DOC and click 

4. Press U or click the right 
mouse button 
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Response 

The Directory commands are 
now available 

The File window is displayed 
for directory MYDIR 

The file MYFILE.DOC is se­
lected 

The file is no longer tagged, 
and a diamond is no longer dis­
played next to it 
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Tagging All Files in a Directory 

To perform operations on all the files in a directory, select and tag 
all the files in that directory while the File window is active. The 
Tag all command enables you to tag all files in the current direc­
tory. It is available: 

t/ When any File window is active 

D From the Tag pull-down menu 

By clicking All in window or pressing the hotkey A 

Tag 

File 

All blJ attributes ... Al t+T 
----- untag -----
File 
All in window Ctrl+U 
All blj attributes... Alt+U 
Partial untag Ctrl+FB 

Merge split tags Ctrl+Fo 
Invert file tag... I 
Invert dir files... Ctrl+I 

D Or, from the Ctrl file command menu 

By clicking COMMANDS and then Tag or pressing 
Ctrl + T 

CTRL FILE Attributes Batch CoplJ Delete Invert Log disk Move l'teu date 
COMMANDS Print RenaMe Search umJ Untag Uiew 

FS archive files F6 Merge tags FB partial untag 

When you select the Tag all command, all the files in the current 
directory are selected and marked with diamonds. To tag all the 
files in the current directory, select this command when the File 
window is active. 
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You can also use the Directory window Tag command to tag all 
the files in the current directory. It is available: 

V When any Directory window is active 

D Frum the Tag pull-down menu 

By clicking Directory files or pressing the hotkey D 

Tag 

II 

All disk files Ctrl+T 
All by at trlbutes. . . Al t+T 
----- untag ----­
Directory files 
All disk files Ctrl+U 
All by attributes... Al t+U 

Merge split tags Ctr 1 +ff, 
Invert dir files... I 
Invert disk files... Ctrl+I 

D Or, from the Standard directory command menu 

By clicking Tag or pressing T 

DIR Avai 1 Branch CoMpare Delete Fi lespec Global Invert Log Make 
COMMANDS Oops• Print RenaMe Showa!! i;m Untag UoluMe eXecute Quit 
1-----ifiie F7 autouiew F8 split F9 Menu F10 coMMands Fl help ? stats 

When you select the Tag command, all the files in the current di­
rectory (identified by the highlight bar) are selected and marked 
with a diamond. To tag all the files in a directory, place the high­
light bar on it and then select the Tag command. 

Untagging All Files in a Directory 

If you accidentally tag a group of files you do not want to select or 
when you have finished a task with tagged files, use the Untag 
all command to cancel the file selection and remove the tags. The 
Untag all command enables you to remove the tags from all files 
in the current directory. 
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It is available: 

t/ When any File window is active 

D From the Tag pull-down menu, under the subheader 
untag 

By clicking All in window or pressing the hotkey A 

D Or, from the Ctrl file command menu 

By clicking COMMANDS and then Untag or pressing 
Ctrl + U 

To untag all the files in the current directory, select the Ctrl + 
Untag command when any File window is active. 

You can also use the Directory window Untag command to untag 
all the files in the current directory. It is available: 

t/ When any Directory window is active 

D From the Tag pull-down menu, under the subheader 
untag 

By clicking Directory files or pressing the hotkey r 

D Or, from the Standard directory command menu 

By clicking Untag or pressing U 

When you select the Untag command, the tags on all the files in 
the current directory (identified by the highlight bar) are re­
moved. To untag all the files in a directory, place the highlight 
bar on it and then select the Untag command. 

Mouse Shortcuts 

D To toggle the tags of all files in a directory, point to the direc­
tory and click the right mouse button. 

D To continue changing the tag state of all files in directories, 
drag the mouse up or down the directory tree. 
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D Selecting (Tagging) All Files in a Directory 

To tag all the files in a directory MYDIR, follow these steps. 

Action 

1. If the words DIR COMMANDS 

are not displayed on the bot­
tom left of the screen, press Esc 

2. Press the Up or Down 
Arrow to place the highlight 
bar on the directory MYDIR 

3. Press T or click Tag 

Response 

The Directory commands are 
now available 

Directory MYDIR is the cur­
rent directory 

All the files in directory 
MYDIR are tagged 

-OR-

2. Press the Up or Down 
Arrow to place the highlight 
bar on the directory MYDIR 
and press Enter 

3. Press Ctrl + T or click COM­
MANDS and then click Tag 
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The File window is displayed 
for directory MYDIR 

All the files in directory 
MYDIR are tagged 
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D Removing the Tags From All Files in a Directory 

To untag all the files in a directory MYDIR, follow these steps. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Press the Up or Down 
Arrow to place the highlight 
bar on the directory MYDIR 

3. Press U or click Untag files 

Response 

The Directory commands are 
now available 

Directory MYDIR is the cur­
rent directory 

No files are now tagged 

-OR-

2. Press the Up or Down 
Arrow to place the highlight 
bar on the directory MYDIR 
and press Enter 

3. Press Ctrl + U or click COM­
MANDS and then click Untag 
all 
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The File window is displayed 
for directory MYDIR 

No files are now tagged 
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Tagging All Files on a Volume 

To perform operations on all the files on a volume, you will need 
to tag all the files while the Directory window is active. The Tag 
all command enables you to tag all files in all the directories on a 
volume. It is available: 

V When the Directory window is active 

D From the Tag pull-down menu 

By clicking All disk files or pressing the hotkey A 

Tag 

DirectorlJ files 

All blJ attributes... Alt+T 
----- untag ----­
DirectorlJ files 
All disk files Ctrl+U 
All btj attributes... Alt+U 

Merge split tags Ctrl+ff, 
Invert dir files... I 
Invert disk files... Ctrl+I 

D Or, from the Ctrl directory command menu 

By clicking COMMANDS and then Tag or pressing 
Ctrl + T 

CTRL DIR Branch Global Invert Log disk Showall tagged files iE:m Untag 
COMMANDS 

When you select the Tag all command, all the files on the current 
disk or volume are selected and marked with diamonds. To tag 
all the files on the current volume, select the Ctrl + Tag command 
when the Directory window is active. 
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Untagging All Files on a Volume 

If you accidentally tag files on a volume you do not want to select, 
and/or when you have finished a task with tagged files, use the 
Untag all command to cancel all the file selections on the volume 
and remove the tags. The Untag all command removes the tags 
from all files on the current volume. 

It is available: 

t/ When the Directory window is active 

D From the Tag pull-down menu, under the subheader 
untag 

By clicking All disk files or pressing the hotkey s 

D Or, from the Ctrl directory command menu 

By clicking COMMANDS and then Untag or pressing 
Ctrl + U 

To untag all the files on the current volume, select this Untag 
command when the Directory window is active. 
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D Selecting (Tagging) All Files on a Volume 

To tag all the files on the current volume, follow these steps. 

Action 

1. If the words DIR COMMANDS 

are not displayed on the bot­
tom left of the screen, press Esc 

2. Press Ctrl + T or click COM­
MANDS and then Tag 

Response 

The Directory commands are 
now available 

All the files on that volume 
will be tagged 

D Removing Tags From All Files on a Volume 

To untag all the files on the current volume, follow these steps. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen,' press Esc 

2. Press Ctrl + U or click COM­
MANDS and then Untag 
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Response 

The Directory commands are 
now available 

No files are now tagged 
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Copying Files 

XTreeGold enables you to copy a file or group of files to another 
directory and/or volume by using one of the Copy commands. The 
Copy command lets you copy the current file to another volume or 
directory. The Copy tagged files command lets you copy all 
tagged files to another volume or directory. 

The Alt Copy command lets you copy all files with their directory 
structures and is a very handy command for backing up large 
amounts of files on different volumes. See Chapter 5 for complete 
information on the Alt Copy command. The Copy command is 
available: 

V When any File window is active 

0 From the File pull-down menu 

By clicking Copy or pressing the hotkey C 

File 

Attributes ... 

Delete 
Edit 
Move ... 
New date ... 
Open (quick) 
Open (al 1 MeMory) 
Open Zip and Arc 
Print ... 
RenaMe ... 
Uiew 

Al t+O 
Al t+FS 

p 
R 
v 

0 Or, from the Standard file command menu 

By clicking Copy or pressing the hotkey C 

FILE Attributes im Delete Edit Fi lespec Invert Log disk Move 
COMMANDS Neu date Open Print Renatte Tag Untag Uieu eXecute Quit 
...._Jtree F7 autovieu F8 split F9 ttenu F10 cottttands Fl help ESC cancel 
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The Copy tagged files command is available: 

V When any File window is active 

D From the Tagged pull-down menu 

By clicking Copy files or pressing the hotkey C 

Tagged 

Attributes... Ctrl+A 
Batch... Ctrl +B 

Copy with paths... Al t+C 
Delete... Ctrl+D 
Move files... Ctrl+M 
Move with paths... Al t+M 
New date... Ctrl+N 
Print... Ctrl+P 
RenaMe... Ctrl+R 
Search... Ctrl+S 
Uiew Ctrl+U 
Zip and Arc... Ctrl+FS 

D Or, from the Ctrl file command menu 

By clicking COMMANDS and then Copy or pressing 
Ctrl + C 

CTRL FILE Attributes Batch E Delete Invert Log disk Move Hew date 
COMMANDS Print Rena Me Search Tag Untag U i ew 

FS archive fi Jes F& Merge tags FB partial untag 

When you choose one of the Copy commands, you are prompted 
for the file name of the new file(s). You can either: 

D Press Enter to retain the same file name 

D Enter any name of your choice 

D Select an item from the history file (press Up Arrow or click 
history) 
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You are then prompted for the destination of the new file(s). You 
can either: 

D Enter a directory name by typing one at the prompt 

D Type a drive letter to specify a disk or volume as the destina­
tion 

D Select an item from the history file (press Up Arrow or click 
history) 

D Use the Point command (press F2 or click point) to display 
the destination directory window, where you can point to the 
destination; ifthe current display is a split window display, 
you'll be able to maintain your source directory display while 
pointing to the destination in the other side of the split win­
dow. 

You are then asked whether or not to automatically replace exist­
ing files. 

D If you choose Y(es) you'll automatically overwrite files of the 
same name. 

D If you choose N(o) XTreeGold will ask for confirmation each 
time a file with the same name is about to be copied over. 

When copying more than one file, XTreeGold moves the highlight 
bar over each tagged file as it is being copied. If you are copying 
tagged files to a disk that becomes full, XTreeGold alerts you. 
You can then replace the full disk with either another formatted 
diskette that has more available space (and press any key to con­
tinue) or format a new diskette and continue the process (specify 
the drive and path again). This enables you to copy large groups 
of files in one operation regardless of whether they will fit on one 
destination disk. 

XTreeGold does not allow you to copy over a Hidden or System 
file. If you are sure you want to do this, first remove the system 
or hidden attributes and then perform the copy operation. If you 
attempt to copy over a file with a Read-Only attribute, XTreeGold 
asks you to confirm the operation before continuing. 
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~ Note: Normally, XTreeGold also copies the archive bit when it 
copies a source file. You can configure XTreeGold to operate 
like DOS and always set the archive bit for newly copied files. 
Chapter 10 provides full information on configuring 
XTreeGold. 

D Copying a File 

This example shows how to copy a single file named MYFILE 
from a directory called MYDIR to a directory named OTHERDIR 
on the current volume. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the directory 
MYDIR and double-click or 
press the Up or Down Arrow 
to place the highlight bar on 
MYDIR and press Enter 

3. Point to the file to be copied, 
MYFILE and click or press the 
Up or Down Arrow to place 
the highlight bar on MYFILE 

4. Press C or click Copy 

5. Press Enter to copy the file 
MYFILE and keep the file 
name 
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Response 

The Directory commands are 
now available 

The File window is displayed 
for directory MYDIR 

The file MYFILE is selected 

The prompt Copy file as is 
displayed 

The prompt to: is displayed, 
asking you where you want to 
copy the files 
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6. Press F2 (to point) and then 
Up or Down Arrow to high­
light the destination 
OTHERDIR, then press Enter 
or point to OTHERDIR with 
the mouse pointer and click 

7. Press Enter or click ok 

The prompt to: 
C:\OTHERDIR is displayed 

The file is copied 

D Tagging and Copying Files to Another Volume 

This example shows how to copy several files from a directory 
called OTHERDIR on a diskette in the A: drive to a directory 
named MYDIR on C: (the hard disk). Remember to insert the disk­
ette in the A: drive. 

Action 

1. Press L or click Log 

2. Type A and press Enter or 
point to A in the prompt line 
and click 

3. Point to the directory 
OTHERDIR and double-click 
or press the Up or Down 
Arrow to place the highlight 
bar on OTHERDIR and press 
Enter 
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Response 

The Log prompt is displayed 

The Main Display is shown 

The File window is displayed 
for directory OTHERDIR 
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4. Press the Up or Down 
Arrow to place the highlight 
bar on a file to be copied, then 
press Tor click Tag, or point to 
the first file to be copied and 
press the right mouse button to 
tag it, repeating either tech­
nique until all files are selected 

5. Press Ctrl + C or click 
COMMANDS and then Copy 

6. Press Enter or click ok to 
copy the files and keep the file 
names 

7. Press F2 (to point) then> (to 
switch disks) and then the Up 
or Down Arrow to highlight 
the destination MYDIR, then 
press Enter, or point to the 
destination MYDIR and click 

8. Press Enter or click ok 

9. Type Y or click Yes 
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Files to be copied will be 
tagged (selected and marked 
with a diamond) 

The prompt Copy all tagged 
files as is displayed 

The prompt to: is displayed, 
asking you where you want to 
copy the files 

The prompt to: C:\MYDIR is 
displayed 

The prompt Automatically 
replace existing files? is dis­
played 

All tagged files are copied 
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Deleting Files 

The Delete commands enable you to delete one or more files from 
a Volume. The Delete file command lets you delete the current 
file. The Delete tagged files command lets you delete all tagged 
files from the current directory. XTreeGold does not allow you to 
delete Read-Only, Hidden or System files. The Delete command 
is available: 

V When any File window is active 

D From the File pull-down menu 

By clicking Delete or pressing the hotkey D 

File 

Attributes ... 
Cop!J .•• 
II- - -
Edit 
Move ... 
New date .•. 
Open (quick> 
Open <all MeMOrlj) 
Open Zip and Arc 
Print.,. 
RenaMe ... 
View 

M 
N 
0 

Alt+O 
Al t+FS 

p 
R 
IJ 

D Or, from the Standard file command menu 

By clicking Delete or pressing D 

FILE Attributes Cop~ ~ Edit Fi lespec Invert Log disk Move 
COMMANDS New date Open Print Rena11e Tag Untag View eXecute Quit 
<1---ltree F7 autoview F8 split F9 11enu F10 co1111ands Fi help ESC cancel 
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The Delete tagged files command is available: 

v When any File window is active 

D From the Tagged pull-down menu 

By clicking Delete or pressing the hotkey D 

D Or, from the Ctrl file command menu 

By clicking COMMANDS and then Delete or pressing 
Ctrl + D 

When you select the Delete file command, you are asked to con­
firm the delete operation. 

D If you choose Y(es) you'll delete the selected file 

D If you choose N(o) XTreeGold will cancel the operation 

When you select the Delete tagged files command, you are asked 
if you will confirm the delete operation for each tagged file. 

D If you choose N(o) you'll automatically delete all tagged files. 

D If you choose Y(es) XTreeGold will ask for confirmation each 
time a file is to be deleted. 

Using the Delete tagged files command is the easiest way to de­
lete groups of files, such as backup files automatically created by 
your application programs. 
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D Deleting a File 

This example shows how to delete a file named MYFILE from a 
directory named MYDIR on the current volume. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the directory 
MYDIR and double-click or 
press the Up or Down Arrow 
to place the highlight bar on 
MYDIR and press Enter 

3. Point to the file to be de­
leted, MYFILE and click or 
press the Up or Down Arrow 
to place the highlight bar on 
MYFILE 

4. Press D or click Delete 

5. Press Y or click Yes 

Response 

The Directory commands are 
now available 

Directory MYDIR has a 
pointer next to it and the File 
commands are displayed 

The file will be selected (the 
current file) 

The prompt Delete this file? 
is displayed 

The file is deleted 

-OR-

5. Press N or click No 
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The delete operation is can­
celled 
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D Tagging and Deleting Files 

This example shows how to delete several files from a directory 
named MYDIR on the current volume. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the directory 
MYDIR and double-click or 
press the Up or Down Arrow 
to place the highlight bar on 
MYDIR and press Enter 

3. Press the Arrow Keys to 
place the highlight bar on a file 
you want to delete and press T 
or click the right mouse button 

4. Continue highlighting files 
you wish to delete until all the 
files are tagged 

5. Press Ctrl + D or select 
Delete from the Tagged pull­
down menu 

6. Press Nor click No 

Response 

The Directory commands are 
now available 

Directory MYDIR has a 
pointer next to it and the File 
commands are displayed 

The selected file will be tagged 
(marked with a diamond) 

All the files you selected listed 
will be tagged 

The prompt Confirm delete 
for each file? is displayed 

All the tagged files are deleted 

-OR-

6. Press Y or click Yes and 
then confirm your choice by 
pressing Y or N to respond to 
each prompt 

3-36 

Each file is highlighted, one at 
a time, followed by the prompt 
Delete this file? until all the 
files are confirmed 
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Undeleting Files 

XTreeGold's Oops! command enables you to undelete or recover 
files from a disk after they have been deleted. Files which have 
been deleted from your disk and whose previously used disk 
space are not in conflict with other files may be recoverable. Files 
are only recoverable if you have not used the Wash deleted space 
command to wash deleted data from your disk and if you have not 
used a disk optimizer since the files were deleted. 

The Oops! command is available: 

V When the Directory window is active 

D From the File pull-down menu 

By clicking Oops! or pressing the hotkey 0 

File 

Edit file... Alt+E 

~ 

D Or, from the Standard directory command menu 

By clicking Oops! or pressing 0 

DIR Auai 1 Branch Cottpare Delete Fi lespec Global Invert Log Make 
COMMANDS mlD Print Renatte Shouall Tag Untag Uolutte eXecute Quit 
<!----1 file F7 autouieu FB split F9 ttenu F10 cottttands Fl help ? stats 

When you select the Oops! command, XTreeGold opens the Un­
delete window for the current directory and displays a list of de­
leted files in that directory. 
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~Note: If the current volume is a network volume or a SUBST 
volume an error message will be displayed. Or, ifthe current 
directory contains no deleted files a message to that effect 
will be displayed in the prompt line. 

The Undelete window is similar to the Expanded file window but 
differs in the following ways: 

0 In the list of files, the first character of each file will always 
be a? because the first character in a file name is always 
erased when you delete a file, and therefore cannot be deter­
mined by XTreeGold. 

0 This window contains a list of files in the current directory 
only. The undelete command cannot be applied to a Branch, 
Showall or Global file window. 

0 XTreeGold resets the file specification to *. * when the un­
delete window is opened but uses the current sort order. 

0 The file attributes (Read-only, Archive, System and Hidden) 
are not displayed. In their place you'll see either four dots 
(. ... )or four question marks(????). The questions marks indi­
cate that the file is a conflicting file. Conflicting files are files 
that the FAT (File Allocation Table) indicates might occupy 
the same space on the disk if they were undeleted. 

0 The Statistics box is labeled UNDELETE Stats and displays 
the number of total, matching and conflicting files but not 
their size in bytes. The box does display the bytes in the cur­
rent file (before it was deleted). There are no tagged file sta­
tistics shown since there can be no tagged files in this window. 

You can undelete any number of files using the Undelete com­
mand in this window but they must be selected one at a time. Se­
lect a file from the list using the arrow keys or mouse and then 
select the Undelete command from the File pull-down menu or 
from the Undelete command menu. 

You will be prompted for the name of the undeleted file. Type 
only a file name; a file is always recovered to the current direc­
tory. XTreeGold will then attempt to undelete the selected file. 
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A message will be displayed indicating whether the undelete was 
successful. 

~ Note: The most likely reason XTreeGold would be unable to 
undelete a file is if the file area had been overwritten since 
the file was deleted. 

The file display will then be refreshed and any file or files which 
were in conflict with the undeleted file may no longer be dis­
played. There is no way for XTreeGold to predict how conflicting 
files will be resolved before the undelete operation. 
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D Undelete Commands 

In the Undelete window, the following commands are available 
from pull-down and command menus. 

Pull-down 
menu item 

D Xtree 

Help 

Quit to 
XTreeGold 

D File 

Undelete 

D Window 

Tree 

File 
specification 

Sort 
criteria 
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Command 
menu item 

Fl help 

Esc 

Undelete 

Enter 

Filespec 

Alt+ Sort 
criteria 

Purpose 

Displays a context sensitive 
help screen 

Closes the Undelete window 
and returns you to the stan­
dard XTreeGold display 

Undeletes the currently se-
lected file 

Displays the Undelete direc-
torywindow 

Changes the file specification 
that XTreeGold uses to select 
deleted files for display and op-
erations 

Changes the order in which 
files are displayed in the Un-
delete window 
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D Undeleting a File 

This example shows how to undelete a file named ?YFILE from a 
directory named MYDIR on the current volume. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the directory 
MYDIR and click or press the 
Up or Down Arrow to place 
the highlight bar on MYDIR 

3. Press 0 or select Oops! from 
the File pull-down menu 

4. Point to the file to be de­
leted, ?YFILE and click or 
press the Up or Down Arrow 
to place the highlight bar on 
?YFILE 

5. Press U or select Undelete 
from the File pull-down menu 

6. Type a file name, MYFILE 
and press Enter 
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Response 

The Directory commands are 
now available 

Directory MYDIR is the cur­
rent directory 

The Undelete file window will 
be displayed listing the de­
leted files in directory MYDIR 

The file will be selected 

The prompt Undelete File: 
as is displayed 

XTreeGold will attempt to un­
delete the file and display a 
message indicating whether it 
was successful 
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Moving Files 

The Move commands allow you to move files to another directory 
and/or volume. The Move file command moves the current file to 
another directory. The Move tagged files command lets you move 
all the tagged files to another directory. A new feature of 
XTreeGold 2.0 is the ability to move files to a directory on an­
other disk or volume. The Alt Move command lets you move all 
files with their directory structures and is a very handy command 
for backing up large amounts of files on different volumes. See 
Chapter 5 for complete information on the Alt Move command. 
XTreeGold does not allow you to move Read-Only, Hidden or Sys­
tem files. The Move command is available: 

V When any File window is active 

0 From the File pull-down menu 

By clicking Move or pressing the hotkey M 

File 

Attributes ... 
CopLJ ... 
Delete 
Edit 

New date ... 
Open <quid;) 
Open (all MeMOrLJ) 
Open Zip and Arc 
Print .. . 
Rena.Me .. . 
Uiew 

Al t+O 
Al t+FS 

p 
R 

0 Or, from the Standard file command menu 

By clicking Move or pressing M 

FILE Attributes Copy Delete Edit Fi lespec Invert Log disk :il!l!lil 
COMMANDS Heu date Open Pl"int RenaHe Tag Untag Uieu eXecute lluit 
~tree F7 autovieu FB split F9 Menu F10 COHHands F1 help ESC cancel 
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The Move tagged files command is available: 

V When any File window is active 

D From the Tagged pull-down menu 

By clicking Move files or pressing the hotkey M 

D Or, from the Ctrl file command menu 

By clicking COMMANDS and then Move or pressing 
Ctrl + M 

When you choose the move command, you are prompted to re­
name the file(s) to be moved. You can either: 

D Accept the one shown (keeps the same name) 

D Enter any name of your choice 

D Select an item from the history file (press Up Arrow or click 
history) 

You are then prompted for the destination of the file(s). You can 
either: 

D Enter a volume or directory path by typing one at the prompt 

D Select an item from the history file (press Up Arrow or click 
history) 

D Use the Point command (press F2 or click point) to display 
the destination directory window where you can point to the 
destination; if the current display is a split window display, 
you'll be able to maintain your source directory display while 
pointing to the destination in the other side of the split win­
dow. 
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D Moving a File 

To move a file named MYFILE from a directory named MYDIR to 
another directory named OTHERDIR on the same volume, follow 
these steps. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the directory 
MYDIR and double-click or 
press the Up or Down Arrow 
to place the highlight bar on 
MYDIR and press Enter 

3. Press the Arrow Keys to 
place the highlight bar on the 
file you want to move, MYFILE 

4. Press M or click Move 

5. Press Enter or click ok to re­
tain the same file name 

6. Enter the directory name by 
typing OTHERDIR at the 
prompt and pressing Enter or 
clicking ok 
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Response 

The Directory commands are 
now available 

Directory MYDIR has a 
pointer next to it and the File 
commands are displayed 

The selected file MYFILE is 
highlighted (is the current file) 

You are prompted Move file 
as 

You are then prompted Enter 
destination path 

The file is moved to the direc­
tory you selected, OTHERDIR 
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D Tagging and Moving Files 

These steps show how to move all the files from a directory 
named MYDIR to another directory named OTHERDIR on an­
other volume, D: . 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the directory 
MYDIR and double-click or 
press the Up or Down Arrow 
to place the highlight bar on 
MYDIR and press Enter 

3. Press Ctrl + T or click 
COMMANDS and then Tag 

4. Press Ctrl + M or click 
COMMANDS and then Move 

5. Press Enter to retain the 
same file names 

6. Enter a volume and direc­
tory name by typing 
D:\OTHERDIR at the prompt 
and press Enter or click ok 
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Response 

The Directory commands are 
now available 

The File window is displayed 
for directory MYDIR 

All the files in the directory 
MYDIR are tagged 

XTreeGold prompts for file 
names, Move all tagged files 
as 

XTreeGold prompts to: for the 
destination of the files 

The files are moved to the di­
rectory OTHERDIR 
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Renaming Files 

When you want to change the name of one or more files while 
keeping the contents of the files intact, you can use the Rename 
commands. The Rename file command enables you to rename 
the current file. The Rename tagged files command enables you 
to rename all the tagged files in a directory. The Rename com­
mand is available: 

ti' When any File window is active 

D From the File pull-down menu 

By clicking Rename or pressing the hotkey R 

File 

Attributes ... 

Edit 
Move ... 
New date ... 
Open (quick) 
Open (al 1 MeMory) 
Open Zip and Arc 
Print ... 

Uiew 

A 
c 
D 
E 
M 
N 
0 

Al t+O 
Al t+FS 

p 

D Or, from the Standard file command menu 

By clicking Rename or pressing R 

FILE Attributes Cop!:j Delete Edit Filespec Invert Log disk Moue 
COMMANDS Hew date Open Print ~ Tag Untag Uiew eXecute Quit 
<1--1 tree F7 autoview F8 split F9 Menu F10 coHHands Fl help ESC cancel 
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The Rename tagged files command is available: 

V When any File window is active 

0 From the Tagged pull-down menu 

By clicking Rename or pressing the hotkey R 

0 Or, from the Ctrl file command menu 

By clicking COMMANDS and then Rename or pressing 
Ctrl + R 

When you choose one of the Rename commands, you are 
prompted for the file name of the new file(s). You can either: 

0 Enter any name of your choice 

0 Select an item from the history file (press Up Arrow or click 
history) 

After you rename files, the File window is updated to show the 
new file names. 
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D Renaming a File 

To rename a file called MYFILE to MYFILE.DOC in a directory 
named MYDIR, follow these steps. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the directory 
MYDIR and double-click or 
press the Up or Down Arrow 
to place the highlight bar on 
MYDIR and press Enter 

3. Press the Arrow Keys to 
place the highlight bar on the 
file you want to rename, MYF­
ILE 

4. Press R or click Rename 

5. Type the new file name, 
MYFILE.DOC and press 
Enter 
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Response 

The Directory commands are 
now available 

Directory MYDIR has a 
pointer next to it and the File 
commands are displayed 

The selected file is highlighted 
and shown in the path line 

XTreeGold displays the name 
of the selected file and 
prompts: Enter new file 
name 

The file is renamed and the 
file window is updated to re­
flect the new name 
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D Tagging and Renaming Files 

This example shows how to tag and rename several files in a di­
rectory named MYDIR so that they all have the file extension 
.BAK. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the directory 
MYDIR and double-click or 
press the Up or Down Arrow 
to place the highlight bar on 
MYDIR and press Enter 

3. Press the Up or Down 
Arrow to place the highlight 
bar on a file to be renamed, 
then press T or point to the 
first file to be tagged and press 
the right mouse button, repeat­
ing either technique until all 
files are selected 

4. Press Ctrl+ R or select Re­
name from the Tagged pull­
down menu 

5. Type the new file specifica-

] 
tion *.BAK and press Enter or 
click ok 
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Response 

The Directory commands are 
now available 

The File window is displayed 
for directory MYDIR 

Files to be renamed will be 
tagged 

XTreeGold prompts: Enter 
file specification 

The files are renamed with 
the .BAK extension and the 
file window is updated to re­
flect the new name 
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Printing the Contents of Files 

The Print file commands let you print the contents of one or more 
files on your printer. The Print file command lets you print the 
contents of the current file. The Print all tagged files command 
lets you print all tagged files in the current directory. The Print 
command is available: 

V When any File window is active 

D From the File pull-down menu 

By clicking Print or pressing the hotkey P 

File 

At tributes ... 
Copy ... 
Delete 
Edit 
Move ... 
New date •.. 
Open <quickl 
Open (all MeMory l Al t+O 
Open Zip and Arc Al t+FS 

RenaMe ... 
Uiew 

D Or, from the Standard file command menu 

By clicking Print or pressing P 

FILE Attributes Copy Delete Edit Filespec Invert Log disk Move 
COMMANDS Heu date Open Im! RenaMe Tag Untag Uieu eXecute Oui t 
._i free F7 autovieu F8 split F9 Menu F10 coMMands Fl help ESC cancel 
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The Print tagged files command is available: 

ti' When any File window is active 

D From the Tagged pull-down menu 

By clicking Print or pressing the hotkey P 

D Or, from the Ctrl file command menu 

By clicking COMMANDS and then Print or pressing 
Ctrl + P 

When you choose the Print command, XTreeGold prompts for the 
number of lines per page. You can: 

D Accept the default 

D Enter a different number if you know it is needed for your 
printer 

D Select an item from the history file (press Up Arrow or click 
history) . 

Once you select a destination and confirm by pressing Enter, 
your file(s) will be printed. 

Each time you print, remember the following: 

D Be sure the printer is turned on and available before selecting 
the command and the paper is properly aligned. 

D You can cancel printing at any time by pressing Esc. 

D If you try to print a file that does not contain text informa­
tion, you may find random characters in your printout. 

D A form feed is issued at the end of each file so that each file 
starts printing on a new page. 
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D Printing the Contents of a File 

To print a file named MYFILE in a directory named MYDIR, fol­
low these steps. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the directory 
MYDIR and double-click or 
press the Up or Down Arrow 
to place the highlight bar on 
MYDIR and press Enter 

3. Press the Arrow Keys to 
place the highlight bar on the 
file you want to print, MYFILE 

4. Press P or click Print 

5. Type a number and press 
Enter or click ok (or to accept 
the number shown) 

Response 

The Directory commands are 
now available 

Directory MYDIR has a 
pointer next to it and the File 
commands are displayed 

The highlight bar is on the file 
and the file name is displayed 
in the path line 

The prompt Number of lines 
per page is displayed 

The file is printed 

I@" Note: If the file does not print, and the Error Message De­
vice not ready, Press C to Cancel and R to Retry is dis­
played, check to make sure your printer is on and ready. 
Then press R to print. 
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D Tagging and Printing the Contents of Files 

This example shows how to tag and print all the matching files in 
the current directory, MYDIR. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the directory 
MYDIR and double-click or 
press the Up or Down Arrow 
to place the highlight bar on 
MYDIR and press Enter 

3. With the File window active, 
press Ctrl + T or click 
COMMANDS and then Tag to 
tag all the files 

4. Press Ctrl + P or click 
COMMANDS and then Print 

5. Type a number and press 
Enter or click ok (or to accept 
the number shown) 

6. Press Ctrl + U or click 
COMMANDS and then Untag 
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Response 

The Directory commands are 
now available 

The File window is displayed 
for directory MYD IR 

All the matching files in the di­
rectory are tagged 

The prompt Number of lines 
per page is displayed 

The files are printed 

The previously tagged files are 
no longer tagged 
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Summary 

This chapter provided information on the XTreeGold commands 
and capabilities that help you speed up and simplify the most 
common file management tasks, including: 

D Matching Files 

D Choosing the best file window 

D Modifying the file display format 

D Selecting and tagging files 

D Copying files 

D Deleting files 

D Undeleting files 

D Moving files 

D Renaming files 

D Printing the contents of files 

The best way to use this chapter is as an ongoing reference. 
Refer back to individual sections when you need directions for a 
task or additional information on a command, until you become 
familiar with the steps and no longer need instructions. 

3-54 Working With Files, Part 7 • 



Working With Files, Part 2 

XTreeGold provides a number of additional commands to speed 
up and simplify some less common file management tasks. This 
chapter provides a thorough explanation of the commands you'll 
use and step-by-step instructions to easily complete these tasks: 

D Comparing files 

D Modifying file dates 

D Modifying file attributes 

And, we explain XTreeGold's advanced file selection techniques: 

D Spanning branches, directories and volumes 

D Selecting (tagging) files in the current window 

D Splitting windows and merging tags in split windows 

D Selecting (tagging) files by attribute 

D Inverting tags and file specifications 

D Partially untagging file lists after interrupted operations 
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Spanning Directories and Volumes 

As we have seen, File commands act on selected or matching files 
displayed in the File window. The scope of the command you 
choose depends on the type of File window that is currently ac­
tive. In the previous chapter, we discussed how to work with files 
in a single directory on a single volume. For all the tasks and ex­
amples the Small or Expanded file window was active. 

We could also have applied the commands to files in more than 
one directory and on more than one volume by working with dif­
ferent active File windows. 

D If the Branch file window had been active, File commands 
would have acted on matching files in one directory and all its 
subdirectories on the current volume. 

D If the Showall file window had been active, File commands 
would have acted on matching files in all directories on the 
current volume. 

D If the Global file window had been active, File commands 
would have acted on matching files in all directories on all 
logged volumes. 

So if you need to work with files in more than one directory 
and/or on more than one volume, before you select a command for 
a task (such as copying, deleting and renaming files), choose the 
File window that meets the needs of th~ task you are going to per­
form. 

D Display the Small or Expanded file window when you will be 
performing a task on files in only one directory. 

D Display the Branch file window if you are performing similar 
tasks on files in one branch (one directory and all its sub­
directories). 

D Display the Show all file window if you are performing similar 
tasks on files in more than one directory. 
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0 Display the Global file window if you have logged more than 
one volume and will be performing similar tasks on files on 
all the volumes. 

Branch File Window 

When you choose the Branch files command, XTreeGold displays 
the Branch file window, which lists the files in one branch (a di­
rectory and all its subdirectories) on the current volume that 
match the File specification. If*.* is in the File specification box, 
all the files in the current branch are listed in the Branch file win­
dow. When you choose the Branch tagged files command, 
XTreeGold displays the Branch file window and lists only the 
tagged files on the branch. 

The Branch command is available: 

V' When the Directory window is active 

0 From the Window pull-down menu 

By clicking Branch files or pressing the hotkey B 

Window 

Autoview 
Split on/off 
Uideo Mode 

Directory files 
1: 

Branch tagged 
Disk files <Showall> 
Disk tagged 
Global 
Glob al tagged 

File specification ... 
File display coluMns 
Sort criteria ... 
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F7 
F8 

Al t+F9 

Enter 

Ctrl +B 
s 

Ctrl+S 
G 

Ctrl +G 

F 
Alt+F 
Al t+S 

4-3 



0 Or, from the Standard directory command menu 

By clicking Branch or pressing B 

DIR Avail !lm::mml CoMpare Delete Filespec Global Invert Log Make 
COMMANDS Oops• Print RenaMe Showall Tag Untag UoluMe eXecute Quit 
.____.file F7 autoview FB split F9 Menu F10 COMMands Fl help ? stats 

The Branch tagged files command is available: 

V When the Directory window is active 

0 From the Window pull-down menu 

By clicking Branch tagged or pressing the hotkey r 

Window 

Autoview F7 
Split on/off FB 
Video Mode Alt+F9 

DirectorlJ files Enter 
Branch files B 
i:. 

Disk files <ShowallJ 
Disk tagged Ctrl+S 
Global G 
Global tagged Ctrl+G 

File specification ... 
File displalJ coluMns Alt+F 
Sort criteria... Alt+S 

0 Or, from the Ctrl directory command menu 

By clicking COMMANDS and then Branch or pressing 
Ctrl + B 

CTRL DIR il1m,ll Global Invert Log disk Showall tagged files Tag Untag 
COMMANDS 
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As you select files in the window by moving the highlight bar, the 
path identification line at the top of the screen provides each file's 
location. 

FILE w. w 

The display for the Branch file window looks identical to the Ex­
panded file window, except that each contains file information 
from different sources and the label and information in the Statis­
tics box changes to Branch statistics. 
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D Displaying the Branch File Window 

Key 

B 

FlO+ 
(right or 
left arrow 
to) open 
the 
Window 
menu+B 

Ctrl + B 

FlO+ 
(right or 
left arrow 
to) open 
the 
Window 
menu+r 

Esc 
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Mouse Action 

Click Branch 

Purpose 

To move from the Directory 
window to the Branch window 

-OR-

Click FlO 
commands, 
then Window, 
then Branch 
files 

Click DIR 
COMMANDS 
+Branch 

To move from the Directory 
window to the Branch file win­
dow 

To move from the Directory 
window to the Ctrl Branch 
tagged files window 

-OR-

Click FlO 
commands, 
then Window, 
then Branch 
tagged 

Click Esc 
cancel 

To move from the Directory 
window to the Ctrl branch 
tagged files window 

To move back to the Directory 
window 
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Showell File Window 

When you choose the Showall files command, XTreeGold displays 
the Showall file window, which lists the files in all the directories 
on the volume that match the File specification. If*.* is in the 
File specification box, all files on the current volume are listed in 
the File window. When you choose the Showall tagged files com­
mand, XTreeGold displays the Showall file window but lists only 
the tagged files in all the directories on the volume. 

The Showall command is available: 

V When the Directory window is active 

0 From the Window pull-down menu 

By clicking Disk files (Showall) or pressing the hotkey S 

Window 

Autoview F7 
Split on/off FB 
Uideo Mode Alt+F9 

Directory files Enter 
Branch files B 
Branch tagged Ctrl+B 
II 

Disk tagged Ctrl +S 
Global G 
Global tagged Ctrl+G 

Fi le specification ... 
File display coluMns Alt+F 
Sort criteria... Al t+S 

0 Or, from the Standard directory command menu 

By clicking Showall or pressing S 

DIR Avail Branch CoMpare Delete Filespec Global Invert Log Make 
COMMANDS Oops• Print RenaMe i!lll!l!llJ Tag Untag UoluMe eXecute Quit 
.__.file F7 autoview FB split F9 Menu F10 coMMands Fl help ? stats 
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The Showall tagged files command is available: 

V' When the Directory window is active 

D From the Window pull-down menu 

By clicking Disk tagged or pressing the hotkey t 

Window 

Autoview F7 
Split on/off F8 
Uideo Mode Alt+F9 

Directory files Enter 
Branch files B 
Branch tagged Ctrl+B 
Disk files <Showall) S 
II 

Global 
Glob al tagged Ctr 1 +G 

File specification ... 
File display coluMns Alt+F 
Sort criteria... Alt+S 

D Or, from the Ctrl directory command menu 

By clicking COMMANDS and then Showall tagged files 
or pressing Ctrl + S 

CTRL DIR Branch Global lnv.,l't Log disk ~ Tag Untag 
COMMANDS 

4-8 Working With Files, Part 2 



As you select files in the window by moving the highlight bar, the 
path identification line at the top of the screen provides each file's 
location. 

FILE ~.~ 

The display for the Showall file window looks identical to the Ex­
panded File window, except that each contains file information 
from different sources and the label and information in the Statis­
tics box changes to Showall statistics. 
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D Displaying the Showell File Window 

Key 

s 

FlO+ 
(right or 
left arrow 
to) open 
the 
Window 
menu+ S 

Ctrl + S 

FlO+ 
(right or 
left arrow 
to) open 
the 
Window 
menu+ t 

Esc 
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Mouse Action 

Click Showall 

Purpose 

To move from the Directory 
window to the Showall file 
window 

-OR-

Click FlO 
commands, 
then Window, 
then Disk 
files 
(Showall) 

Click DIR 
COMMANDS 
+ Showall 

To move from the Directory 
window to the Showall file 
window 

To move from the Directory 
window to the Ctrl Showall 
tagged files window 

-OR-

Click FlO 
commands, 
then Window, 
then Disk 
tagged 

Click Esc 
cancel 

To move from the Directory 
window to the Ctrl Showall 
tagged files window 

To move back to the Directory 
window 
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Global File Window 

When you choose the Global files command, XTreeGold displays 
the Global file window, which lists the files in all the directories 
on all logged volumes that match the File specification. If*.* is 
in the File specification box, all the files on all the volumes are 
listed in the File window. When you choose the Global tagged 
files command, XTreeGold displays the Global file window but 
lists only the tagged files in all the directories on all the logged 
volumes. 

The Global command is available: 

V When the Directory window is active 

D From the Window pull-down menu 

By clicking Global or pressing the hotkey G 

Window 

Autoview F7 
Split on/off F8 
Video Mode Alt+F9 

Di rectory files Enter 
Branch files B 
Branch tagged Ctrl+B 
Disk files ( Showall) S 
Disk tagged Ctrl+S 

Glob al tagged Ctr 1 +G 

File specification ... 
File display coluMns Alt+F 
Sort criteria... Alt+S 

D Or, from the Standard directory command menu 

By clicking Global or pressing G 

DIR Avail Branch CoMpare Delete Filespec e!I] Invert Log Make 
COMMANDS Oops• Print RenaMe Shouall Tag Untag UoluMe eXecute Quit 
.__i file F7 autovieu FB split F9 Menu F10 coMMands Fl help ? stats 
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The Global tagged files command is available: 

V When the Directory window is active 

D From the Window pull-down menu 

By clicking Global tagged or pressing the hotkey l 

Window 

Autov iew 
Split on/off 
IJ ideo Mode 

Directory files 
Branch files 
Branch tagged 
Disk files (Showall) 
Disk tagged 
Global 

File specification ... 
File display coluMns 
Sort criteria ... 

F7 
FB 

Alt+F9 

Enter 
B 

Ctrl +B 
s 

Ctrl+S 
G 

F 
Al t+F 
Al t+S 

D Or, from the Ctrl directory command menu 

By clicking COMMANDS and then Global or pressing 
Ctrl + G 

CTRL DIR Branch m!I] lnuel't Log disk Showa! I tagged fi Jes Tag Untag 
COMMANDS 
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As you select files in the window by moving the highlight bar, the 
path identification line at the top of the screen provides each file's 
location. 

Path' C''WINDOWS 

FILE *· * 
11221E3o. HJ<l8. 570 . a .. 10-15-90 5 34, 30 PM 
123 . DCF 313 . a .. 10-11-90 11 3o' 02 aM DISK D' IJOLUMEl 
123 . EXE 84. 843 . a .. B-30-90 1 23' 04 aM Available 
123 . GRP 1. 410 . a .. 11-09-90 11 41' 02 aM Bytes 17. 320. 080 
123 . HLP 457. 949 . a .. 8-30-90 1 23, 00 aM 
123 • !CO 700 . a .. B-30-90 1 23, 00 aM GLOBAL Statistics 
123 . Plf 545 . a .. 10-17-90 4 24, 10 pM Total 
123 • PIF 545 . a .. 10-17-90 4 00' 54 PM Files 1. 537 
123DOS . EXE 911. 254 . a .. 8-30-90 1 23' 02 aM Bytes 35. 400.070 
123R31 • CNF 10 . a .. 8-30-90 1 23, 00 aM Matching 
180FHDR . INF o.25o . a .. 11-09-90 1 07' 48 PM Files 1. 037 
180FSTR . INF 1.248 . a .. 11-09-90 1 04' 42 PM Bytes 35. 400, 070 
2 COIJER . CHT 5. 305 . a .. 8-29-90 1 49, 38 PM Tagged 
4z01 • CPI 17, 089 . a .. 2-02-88 12 00, 02 aM Files 
5202 . CPI 459 . a .. 2-02-88 12 00' 02 aM Bytes 
8514A . WPD 3.510 .... 1-03-89 11 00' 08 aM Current File 
891040 . WK3 2, 301 . a .. 10-07-90 10 09' 04 aM 0A23395E. 
901040 . WK3 2. 103 .a .. 10-07-90 10 10' lo aM Bytes 1. 048, 570 

FILE Attributes Copy Delete Edit Filespec Invert Log disk Move 
OMMANDS New date Open Print RenaMe Tag Un tag Uiew execute Oui t 

-c-J tree F7 autoview FB split F9 Menu F10 cOMMands Fl help ESC cancel 

The display for the Global file window looks identical to the Ex­
panded, Showall and Branch File windows, except that each con­
tains file information from different sources and the label and 
information in the Statistics box changes to Global statistics. 
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D Displaying the Global File Window 

Key 

G 

FlO+ 
(right or 
left arrow 
to) open 
the 
Window 
menu+G 

Ctrl + G 

FlO+ 
(right or 
left arrow 
to) open 
the 
Window 
menu+ 1 

Esc 
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Mouse Action 

Click Global 

Purpose 

To move from the Directory 
window to the Global file win­
dow 

-OR-

Click FlO 
commands, 
then Window, 
then Global 

Click DIR 
COMMANDS 
+Global 

To move from the Directory 
window to the Global tagged 
files window 

To move from the Directory 
window to the Ctrl Global 
tagged files window 

-OR-

Click FlO 
commands, 
then Window, 
then Global 
tagged 

Click Esc 
cancel 

To move from the Directory 
window to the Ctrl Global 
tagged files window 

To move back to the Directory 
window 
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Tagging Files in the Current Window 

XTreeGold's multiple File windows and tagging capabilities com­
bined give you the ability to perform operations on any files or 
groups of files on any selected directories on all logged volumes. 
The multiple File windows were designed to enable users to select 
(tag) files as needed across directories and volumes and then 
apply a command from the Tagged pull-down menu or Ctrl file 
commands menu to all the tagged files. Or you can tag any and 
all files in one or more directories on one or more logged volumes, 
using any of the Tag commands or methods and then display the 
window that meets your needs. 

To perform operations on selected files in all logged directories on 
the current volume or all logged volumes, or a branch on the cur­
rent volume, use these guidelines to tag the files to be acted upon. 
(After reviewing Chapter 6, you'll also be able to specifically log 
only selected directories on selected volumes, to further customize 
this process.) 

D Decide which directories and volumes contain the files to be 
acted upon and log those areas. Choose one of the following: 

If you will be working on another volume in addition to 
the current volume, use the Log disk command on the Vol­
ume pull-down menu to log another volume. 

If you will be working on another volume instead of the 
current volume, use the Log disk command on the Vol­
ume pull-down menu to log that volume and make it the 
current volume. 

Use the Log options command on the Volume pull-down 
menu to partially log another volume. 

D To apply a command to all the files: 

In a branch, first highlight the top level directory in that 
branch, and select the Branch window. 

On the current volume, select the Showall window. 
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On all logged volumes, select the Global window. 

D Use the Filespec command to restrict matching files to meet 
your needs. (See page 3-3 to review the Filespec command.) 

D Use the File or All files command on the Tag pull-down menu 
to tag individual files or all files displayed in the current File 
window. 

» You may also tag files in the current window by pointing 
to them and clicking with the right mouse button, or drag­
ging the mouse pointer down a files list while holding 
down the right button. 

You may also use any of the Tag commands available 
from the Standard, Ctrl or Alt file commands menus. 

D Once you've tagged all the files to be acted upon, select a com­
mand from either the Tagged pull-down menu or command 
menu. 

Or, you may work in the following sequence: 

D Use the Filespec command to restrict matching files to meet 
your needs. (See page 3-3 to review the Filespec command.) 

D Use any tag command or method to tag individual files or all 
files on a directory by directory and volume by volume basis. 

D Once you've tagged the files you want to work with, select the 
appropriate window. To apply a command to all the tagged 
files: 

In a branch, first highlight the top level directory in that 
branch, and select the Branch tagged files window. 

On the current volume, select the Showall tagged files 
window. 

» On all logged volumes, select the Global tagged files win­
dow. 
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D Once you've displayed the appropriate window, select a com­
mand from either the Tagged pull-down menu or Ctrl file com­
mand menu. 

D Selecting (Tagging) All Files in a Window 

To tag all the files in any File window, follow these steps. Choose 
any of the three methods mentioned in step 2. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. To work with all files on a 
branch, point to the parent (top 
level) directory on the branch 
and click or press the Up or 
Down Arrow to place the 
highlight bar on the parent di­
rectory and select Branch 
from the Window pull-down 
menu or press B 

Response 

The Directory commands are 
now available 

The Branch file window is dis­
played for the selected direc­
tory and its subdirectories 

-OR-

2. To work with all files on a 
volume, select Disk files 
(Showall) from the Window 
pull-down menu or press S 

2. To work with all files on all 
logged volumes, select Global 
from the Window pull-down 
menu or press G 
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The Showall file window is dis­
played for the current volume 

-OR-

The Global file window is dis­
played for all logged volumes 
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You may skip steps 3 and 4: 

3. Press F or click Filespec 

4. Type any file specification of 
your choice, separated by com­
mas (,) and press Enter or 
point to entries in the com­
mand history and click (up to 
26 file specs may be entered) 

5. Select All files from the Tag 
pull-down menu or press 
Ctrl + T 

The prompt File specifica­
tion: is displayed (If you click 
Filespec, the Filespec history 
will also be displayed) 

A list of files with those specifi­
cations are displayed. 

All the files listed will be 
tagged 

You can now apply Ctrl file commands to all the tagged files in 
the active window. 

D Using an All Tagged Files Window 

To tag files and then display them in a Branch, Showall or Global 
tagged file window, follow these steps. You may substitute the 
Showall or Global tagged files window in step 6. 

Action 

1. If the words DIR COMMANDS 

are not displayed on the bot­
tom left of the screen, press Esc 

You may skip steps 2 and 3: 
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Response 

The Directory commands are 
now available 
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2. Press F or click Filespec 

3. Type any file specification of 
your choice, separated by com­
mas (,) and press Enter or 
point to entries in the com­
mand history and click (up to 
26 file specs may be entered) 

4. Select a directory and then 
the Tag command of your 
choice from either the Tag pull­
down menu or Standard direc­
tory commands 

5. Continue selecting files by 
any method until files to be 
acted upon are tagged 

6. To work with all tagged files 
on a branch, point to the par­
ent of the branch and click or 
press the Up or Down Arrow 
to place the highlight bar on 
the parent directory and select 
Branch from the Ctrl directory 
command menu or Branch 
tagged from the Window pull­
down menu 

The prompt File specifica­
tion: is displayed (If you click 
Filespec, the Filespec history 
will also be displayed) 

A list of files with those specifi­
cations are displayed. 

All the files selected will be 
tagged 

All files with be marked with 
a diamond, and the Statistics 
box will show the total num­
ber of tagged files on the cur­
rent volume 

The Branch tagged files win­
dow is displayed for the se­
lected directory and its 
subdirectories 

You can now apply Ctrl file commands or commands on the 
Tagged pull-down menu to all the tagged files in the active win­
dow. 
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2=:-wm 
Splitting File Windows 

XTreeGold lets you split any window into two windows, a feature 
that is especially useful when viewing and comparing the con­
tents of different volumes and directories, with its Split (win­
dows) command. The Split command is available: 

V When any Directory or File window is active 

D From the Window pull-down menu 

By clicking Split on/off or pressing the hotkey P 

Window 

Autoview F7 

Uideo Mode Al t+F9 

Directory files Enter 
Branch files B 
Branch tagged Ctrl+B 
Disk files (Showall) S 
Disk tagged Ctrl+S 
Global G 
Glob al tagged Ctrl +G 

File specification ... 
File display coluMns Alt+F 
Sort criteria... Al t+S 

D Or, from the Standard directory or file command menu 

By clicking split or pressing FS 

DIR Auai I Branch Co11pare Delete Fi lespec Global Invert Log Make 
COMMANDS Oops• Print Rena11e Showa! I Tag Untag Uolu11e eXecute Quit 
..____i file F7 autouiew !imm F9 11enu F10 co1111ands F1 help ? stats 
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Some examples of ways you might use split windows are to: 

D Simultaneously view directory trees of different disks and vol­
umes 

D Simultaneously view the contents of different directories on 
the same volume 

D Simultaneously view the contents of different directories on 
different volumes 

D View the contents of a potential destination directory or vol­
ume while retaining a view of your source 

Notice that the File specification box, Disk specification box and 
Statistics box disappear in a split display. The current file specifi­
cation is at the top of each window in the display. In a split dis­
play, statistics can be displayed by using the? stats command. 

When you choose the Split command, the window that is cur­
rently active is split and all subsequent active windows are split. 
To return to a single window at any time, select the Split on/off 
command again with any window active. 
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If you choose either a Copy, Move or other command that 
prompts for a destination when in split windows mode and then 
select the F2 point option to point to the destination directory, 
XTreeGold lets you point to the destination in one window while 
maintaining your view of the source files in the other window. 
And, XTreeGold automatically defaults to the destination path 
shown in the other side of the split display. 

In a split display, only one of the two display windows is consid­
ered active at any time and the active window is the one that con­
tains the highlight bar. All XTreeGold commands are available, 
however only items in the active window are impacted when you 
select a command. When you return to a single window format, it 
is the inactive window that is closed. 

In each window, file tags and the current file specifications are in­
dependent. You can move between the two windows and scroll 
them independently, and you can also combine the file tags in the 
active and inactive side of the display. 

If you make a change in one side of the display that will impact 
the inactive side, the change will not be displayed until you acti­
vate the other window. The sort order and file display format se­
lected for an active window is automatically updated to the 
inactive window when it becomes active. In other words, the in­
formation in both windows is not updated at the same time; only 
the active window is updated. When a window becomes active, 
the display is then automatically updated. 
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D Splitting Windows 

The following keys and mouse actions are available: 

Key 

F8 orFlO 
(+right or 
left arrow 
to) open 
the Win­
dow menu 
+P 

TAB 

? 

F8 again 

Mouse Action 

Click split or 
click FlO 
commands, 
then Window, 
then Split 
on/off 

Click in the 
other side with 
the mouse 

Click stats 

Click 
split/unsplit 
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Purpose 

XTreeGold divides the current 
window in half and copies the 
contents of the current win­
dow into the new window 

To move between the split 
halves; the other window will 
be active 

To display statistics in a split 
display; extended statistics for 
the active window are dis­
played in a full screen over 
the windows 

A single window is displayed; 
the contents match the active 
window at the time you se­
lected the unsplit command 
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Merging Tags 

In a split File window display, XTreeGold provides the capability 
to combine the tags in both file windows using the Merge tags 
command. Use the Merge tags command to copy the tag states of 
files from one side of the split display to the other. It is available: 

V When any File window is active 

D From the Tag pull-down menu 

By clicking Merge split tags or pressing the hotkey M 

Tag 

File 
All in window Ctrl+T 
All btj attributes... Alt+T 
----- untag 
File 
All in window 
All blJ attributes .. , 
Partial untag 

Invert file tag .. . 
Invert dir files .. . 

Ctrl +LJ 
Al t+U 

Ctrl+FB 

Ctrl+I 

D Or, from the Ctrl file command menu 

By clicking COMMANDS and then merge tags or press­
ing Ctrl + F6 

CTRL FILE Attributes Batch Cop~ Delete Invert Log disk Moue Hew date 
COMMANDS Print RenaHe Search Tag Untag Uiew 

FS archive flies ~ F8 partial untag 

When you choose Merge tags, files that are tagged in the active 
File window are also tagged in the inactive File window. How­
ever, each side of the display retains its existing tags after it in­
herits tags from the other side of the window. (Files are not 
untagged when you use the Merge tags commands.) 
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D Merging tags 

Follow these steps to copy tags from the active to inactive split 
File window when both windows display the files in the current 
directory. 

Action 

1. Press Tab or click with the 
mouse to select the side of the 
display that contains the tags 
you want to merge 

2. Press Ctrl + F6 or select 
Merge split tags from the 
Tag pull-down menu 

3. Select the other side with 
the Tab key or by clicking with 
the mouse 
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Response 

The highlight bar is in the ac­
tive side 

The tagged status is copied, 
but the copied tags are not yet 
displayed on the inactive side 

The new tag status of the files 
is displayed 
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Comparing Files 

XTreeGold enables you to compare files across all directories 
and/or all volumes with the Compare command. The Compare 
command is available: 

V When the Branch, Showall or Global File window is active 

D From the Alt file command menu 

By double-clicking COMMANDS and then compare or 
pressing Alt+ F4 

ALT FILE Copy File display Log disk Move Open Release disk Sort criteri 
COMMANDS Tag Untag eXecute Quit 

FZ forMat F3 relog dir ~ FS open archive 

D When selected with the Branch file window active, it enables 
you to compare all files on all directories in a branch. 

D When selected with the Showall file window active, it enables 
you to compare all files on all directories on the current vol­
ume. 

D When selected with the Global file window active, it enables 
you to compare all files on all directories on all logged vol­
umes on the network. 

When you select the list compare command, a submenu is dis­
played with six options: 

Duplicate name 

Unique names 

Identical dates 
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Lists all files that are not uniquely named 

Lists each unique file 

Lists each file that has the same name 
and date as another file 
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Newest date 

Oldest date 

Scope 

To compare files: 

Lists the most recent version of each file 
that is not unique; ifthere is more than 
one file with the same (most recent) date 
and name, all are listed 

Lists the earliest version of each file that 
is not unique; if there is more than one 
file with the same (earliest) date and 
name, all are listed 

Applicable when the Global file window is 
active. Enables you to compare all files, 
files across volumes or files with matching 
paths. 

D First select the scope (if the Global file window is active) by 
pressing S or clicking Scope to toggle the options. 

D If you want to see duplicate files, choose from among the date 
options or select Duplicate to see all duplicate files. 

D If you wish to see unique files select Unique. 

Once you have listed selected files, you may tag all the files dis­
played in the File window. 
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0 Comparing Files 

Follow these steps to list and compare files on the current volume 
or across all logged volumes. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Press S (for Showall) to com­
pare all files on the current vol­
ume or G (for Global) to 
compare all files on all logged 
volumes 

3. Press Alt + F4 or double­
click COMMANDS and then 
compare 

4. If the Global file window is 
active, press S (for Scope) to 
display the scope of you choice 

5. Select the option of your 
choice: press U (for Unique 
names) or press D (for 
Duplicate names), or press I 
(for duplicates with Identical 
dates), press N (for duplicates 
with Newest date) or press 0 
(for duplicates with Oldest 
date) 
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Response 

The Directory commands are 
now available 

The selected Showall or 
Global file window is active 

The list compare options are 
displayed 

Your selection (all, across vol­
umes or matching paths) is 
displayed 

The files are listed in the File 
window according to your se­
lection 

Working With Files, Part 2 



Modifying File Dates 

XTreeGold provides commands that enable you to change the 
date and time stamped on files, called the New date command. 

The New date command enables you to modify the date and time 
for the current file. The Ctrl New date command enables you to 
modify the date and time for all the tagged files. 

The New date command is available: 

V When any File window is active 

0 From the File pull-down menu 

By clicking New date or pressing the hotkey N 

File 

Attributes ... 
Copy ... 
Delete 
Edit 
Move ... 

Open (quick) 
Open (al 1 MeMory) 
Open Zip and Arc 
Print .. . 
RenaMe .. . 
View 

A 
c 
D 
E 
M 

Al t+O 
Al t+F5 

p 
R 
v 

0 Or, from the Standard file command menu 

By clicking New date or pressing N 

FILE Attr-ibutes Cop!J Delete Edit Filespec Invert Log disk Moue 
COMMANDS ~ Open Print Renatte Tag Untag Uieu execute Quit 
..__itree F7 autouieu FB split F9 ttenu F10 cottttands Fl help ESC cancel 
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The New date tagged files command is available: 

V When any File window is active 

D From the Tagged pull-down menu 

By clicking New date or pressing the hotkey N 

D Or, from the Ctrl file command menu 

By clicking COMMANDS and then New date or pressing 
Ctrl + N 

You will be prompted for a new date and time. You can either: 

D Accept the one shown 

D Enter a new date and optional time by typing one at the 
prompt. If no time is entered, XTreeGold uses the current 
time as the default. 

D Select an item from the history file (press Up Arrow or click 
history) 

The new date and time will be stamped on the file or all tagged 
files. 
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D Modifying File Dates 

These steps show how to change the dates stamped on all match­
ing files in directory MYDIR. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the directory 
MYDIR and double-click or 
press the Up or Down Arrow 
to place the highlight bar on 
MYDIR and press Enter 

3. With the File window active, 
press Ctrl + T or select All in 
window from the Tag pull­
down menu 

4. Press Ctrl + N or select 
New date from the Tagged 
pull-down menu 

5. Type the date and time in 
the format shown and press 
Enter or click ok 
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Response 

The Directory commands are 
now available 

The selected directory MYDIR 
has a pointer next to it and 
the File window is active 

All the matching files in the di­
rectory are tagged 

The prompt Enter date and 
time is displayed 

The new date is stamped on 
all tagged files in directory 
MYDIR 
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Modifying File Attributes 

XTreeGold provides commands that enable you to modify file in­
formation or attributes, called the Attributes commands. The At­
tributes command enables you to modify information for the 
current file. The Ctrl Attributes command enables you to modify 
attributes for all the tagged files. 

The Attributes command is available: 

V When any File window is active 

D From the File pull-down menu 

By clicking Attributes or pressing the hotkey A 

File 

Copy ... 
Delete 
Edit 
Move ... 
New date ... 
Open (quick) 
Open <all MeMory) 
Open Zip and Arc 
Print ... 
RenaMe ... 
Uiew 

Al t+O 
Al t+FS 

p 
R 
u 

D Or, from the Standard file command menu 

By clicking Attributes or pressing A 

FILE ~ Copy Delete Edit Filespec Invert Log disk Move 
COMMANDS Hew date Open Print RenaHe Tag Untag Uiew eXecvte Quit 
~tree F7 autoview FS split F9 Menu F10 COHHands fl help ESC cancel 
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The Attributes tagged files command is available: 

V When any File window is active 

D From the Tagged pull-down menu 

By clicking Attributes or pressing the hotkey A 

D Or, from the Ctrl file command menu 

By clicking COMMANDS and then Attributes or press­
ing Ctrl +A 

When you select the Attributes command, a prompt line is dis­
played with four options: 

Read-Only 

Archive 

System 

Hidden 

Allows a file to be read but not modified 

Marks a file as having been modified or 
newly created 

Classifies a file as a system file. This is 
how DOS protects its own operating files. 
Turning this attribute off is not advised. 

Causes a file to not appear in a DOS direc­
tory listing although it is on the volume 

You will be prompted to enter the changes. You can either: 

D For each change, enter it by typing the+ or - (plus or minus) 
sign and the letter(s) of the attributes you wish to change, fol­
lowed by the next change without a space (for example +R-A) 

D Select an item from the history file (press Up Arrow or click 
history) 

The attributes will be changed for the files. 
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D Modifying File Attributes 

These steps show how to modify the attributes of a file named 
MYFILE in directory MYDIR. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the directory 
MYDIR and double-click or 
press the Up or Down Arrow 
to place the highlight bar on 
MYDIR and press Enter 

3. Point to the file whose attri­
butes you want to modify, 
MYFILE, and click or press the 
Arrow keys to place the high­
light bar on it 

4. Press A or click Attributes 

5. Type + or - and the letters 
of the attributes you wish to 
change and press Enter 
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Response 

The Directory commands are 
now available 

The selected directory MYDIR 
has a pointer next to it and 
the File window is active 

The highlight bar is on the file 
and the file name is displayed 
in the path line 

The prompt Enter attribute 
changes ( +/- RASH) is dis­
played 

The attribute changes are 
made to the file MYFILE 
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D Tagging and Modifying File Attributes 

These steps show how to modify the attributes of all the files in di­
rectory MYDIR. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the directory 
MYDIR and double-click or 
press the Up or Down Arrow 
to place the highlight bar on 
MYDIR and press Enter 

3. With the File window active, 
press Ctrl + T or select All 
files from the Tag pull-down 
menu 

4. Press Ctrl + A or select At­
tributes from the Tagged 
pull-down menu 

5. Type+ or - and the letters 
of the attributes you wish to 
change and press Enter 
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Response 

The Directory commands are 
now available 

The selected directory MYDIR 
has a pointer next to it and 
the File window is active 

All the matching files in the di­
rectory are tagged 

The prompt Enter attribute 
changes ( +/- RASH) is dis­
played 

The attribute changes are 
made to the all the tagged files 
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Selecting Files by Attribute 

XTreeGold also provides a way for you to select (or tag) files by 
any of these attributes with the Tag files by attributes commands. 

The Tag by attributes command is available: 

V When the Directory window is active 

D From the Tag pull-down menu 

By clicking All by attributes or pressing the hotkey b 

Tag 

Di rectory files 
All disk files Ctrl+T 

untag 
Directory files 
All disk files Ctrl+LJ 
All by attributes... Al t+U 

Merge split tags Ctrl +ff, 
Invert dir files... I 
Invert disk files... Ctrl+I 

D Or, from the Alt directory command menu 

By double-clicking COMMANDS and then clicking Tag 
or pressing Alt + T 

ALT DIR Edit File displa\j Graft Hidel'unhide Log disk Prune Release dis 
COMMANDS Sol't cl'i teria iET1l Untag Wash disk eXecute Quit 

FZ fol'Mat F3 l'elog dil' F9 video Mode F10 configul'e 
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The Tag by attributes command is also available: 

V When the File window is active 

D From the Tag pull-down menu 

By clicking All by attributes or pressing the hotkey b 

D Or, from the Alt file command menu 

By double-clicking COMMANDS and then clicking Tag 
or pressing Alt + T 

Although the Tag all files by attributes commands are available 
when any window is active, the commands differ in that: 

D When selected with the Directory window active, all matching 
files on the current volume with certain attribute settings are 
tagged. 

D When selected with any File window active, all matching files 
in the current directory with certain attribute settings are 
tagged. Matching files in the current directory are tagged if 
the Small or Expanded file window is active, while matching 
files in the current window are tagged if the Branch, Showall 
or Global file window is active. 

As always, once you have tagged a group of files, you'll use the 
Ctrl file or Tagged commands to perform operations on them. 

Untagging by Attribute 

You can also remove the tags from files that meet specified cri­
teria by using the Untag files by attributes command. The Untag 
by attribute command is available: 

V When the Directory window is active 

D From the Tag pull-down menu, under the subheader 
untag 

By clicking All by attributes or pressing the hotkey t 
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D Or, from the Alt directory command menu 

By double-clicking COMMANDS and then clicking 
Untag or pressing Alt + U 

The Untag by attributes command is also available: 

v' When the File window is active 

D From the Tag pull-down menu, under the subheader 
untag 

By clicking All by attributes or pressing the hotkey t 

D Or, from the Alt file command menu 

By double-clicking COMMANDS and then clicking 
Untag or pressing Alt+ U 

The Untag files commands are also available when any window is 
active and differ in the same way as the Tag by attributes com­
mands. 

When you select either Tag or Untag by attribute command, a 
submenu is displayed with the same options found on the File at­
tributes command submenu: 

Read-Only 

Archive 

System 

Hidden 

Allows a file to be read but not modified 

Marks a file as having been modified or 
newly created 

Classifies a file as a system file. This is 
how DOS protects its own operating files. 
Turning this attribute off is not advised. 

Causes a file to not appear in a DOS direc­
tory listing although it is on the volume 

To tag by one or more of the attributes shown, select the option 
and type the+ or - (plus or minus sign) and the letter(s) of the at­
tribute(s) to select by . 
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D Tagging Files on a Volume by Attribute 

Follow these steps to select (tag) a group of files that match spe­
cific criteria. This example shows how to tag all files on the cur­
rent volume. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Press Alt + T or select All 
by attributes from the Tag 
pull-down menu 

3. Type the + or - (plus or 
minus sign) and the letter(s) of 
the attribute(s) to select by and 
press Enter 
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Response 

The Directory commands are 
now available 

The prompt Enter attribute 
( +/- RASH) is displayed 

The files that match these­
lected attributes are tagged 
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... 
Inverting Tags and File Specifications 

Once you are comfortable with the basic concepts of file specifica­
tions and tagging files, you will probably want to use one of the 
Invert commands occasionally, to: 

0 Invert the tag status of files 

0 Reverse the File specification so that XTreeGold displays all 
the files that do not match the File specification 

The Invert command is available: 

V When any Directory or File window is active 

0 From the Tag pull-down menu 

By clicking Invert dir files or pressing the hotkey I 

Tag 

Directory files 
All disk files Ctrl+T 
All by attributes... Al t+T 
----- untag ----­
Directory files 
All disk files Ctrl+U 
All by attributes... Alt+U 

Merge split tags Ctr 1 +Ff, 

Invert disk files... Ctrl+I 

0 Or, from the Standard directory or Standard file com­
mand menu 

By clicking Invert or pressing I 

DIR Auali 1 Branch CoMpare Delete Filespec Global 1li1!1D3 Log Make 
COMMANDS Oops• Print RenaMe Showall Tag Untag UoluMe eXecute Quit 
.____,file F7 autovieu FS split F9 Menu F10 coMMands Fl help ? stats 
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The Invert all command is available: 

V When any Directory or File window is active 

0 From the Tag pull-down menu 

By clicking Invert disk files or pressing the hotkey n 

0 Or, from the Ctrl directory or Ctrl file command menu 

By clicking Invert or pressing Ctrl + I 

When you choose either Invert command, a submenu is displayed 
.with two options: 

File Specification 

Tags 

Reverses the file specification to display 
only those files that do not match the cur­
rent file specification. This command is 
similar to creating an exclusory file specifi­
cation with the Filespec command. 

Untags files that were formerly tagged 
and tags files that were formerly un­
tagged. 

Inverting the Tag Status of Files 

The Invert Tags commands and Invert all Tags commands oper­
ate on different groups of files. 

When the Directory window is active: 

0 The Invert directory files command inverts the tag status of 
all the files in the current directory. 

0 The Invert disk files (Ctrl+ I) command inverts the tag status 
of all the files in all directories on the volume. 
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When the File window is active: 

0 The Invert directory files command inverts the tag status of 
the current file. 

0 The Invert disk files (Ctrl +I) command inverts the tag sta­
tus of all the files in the current directory. 

The Invert Tags commands toggle these changes, so that select­
ing a command once creates the described changes, while select­
ing it again returns the original tag status. 

Inverting the File Specification 

The Invert commands are identical in their impact on the File 
specification. 

When either the Directory or File window is active, the Invert 
File specification command (selected from either the Standard di­
rectory, Standard file, Ctrl directory or Ctrl file command menu) 
reverses the display to show all the files on the current volume 
that do not match the File specification. The display in the File 
specification box is shown in reverse video. 

The Invert File specification commands toggle these changes, so 
that selecting a command once creates the described changes 
while selecting it again returns the original file display. 
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D Inverting the Tag Status of All Files in a Directory 

To use the Invert command to invert the tag status of all files in 
directory MYDIR follow these steps. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the directory 
MYDIR and click or press the 
Up or Down Arrow to place 
the highlight bar on MYDIR 

3. Press I or click Invert 

4. Press T or click Tags 

Response 

The Directory commands are 
now available 

The directory MYDIR is se­
lected (the current directory) 

The File specification and 
Tags options are displayed 

The tag status of all the files 
in MYDIR (the current direc­
tory) are inverted 

D Reversing the File Specification 

To use the Invert File specification command to reverse the dis­
play of all matching files on a volume follow these steps, when 
any window is active. 

Action 

1. Press either I or click Invert 

2. Press F or click File specifi­
cation 
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Response 

The File specification and 
Tags options are displayed 

All the files in the current di­
rectory that do not match the 
files specification are displayed 
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Partially Untagging File Lists After Interrupted 
Operations 

Occasionally, you may be interrupted during a mass operation 
with tagged files and need to update the tags. The Partial untag 
command enables you to continue an interrupted mass operation 
after cancelling it by updating the tag list. 

The Partial untag command is available: 

V When the File window is active 

D From the Tag pull-down menu, under the subheader 
untag 

By clicking Partial untag or pressing the hotkey u 

Tag 

File 
All in window Ctrl+T 
All by attributes... Alt+T 
----- untag ----­
Fi le 
All in window Ctrl+U 
All by attributes... Alt+U 

Merge split tags Ctrl+Fo 
Invert file tag... I 
Invert dir files... Ctrl+I 

D Or, from the Ctrl file command menu 

By clicking COMMANDS and then partial untag or 
pressing Ctrl + FB 

CTRL FILE Attr-ibutes Batch Copy Delete Invel"t Log disk Move Hew date 
COMMANDS Pl"i nt RenaMe Seal"ch Tag Untag Uiew 

FS al"chive files FG Mel"ge tags ~ 
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The Partial untag command untags files that have already been 
operated on, allowing you to continue a process (such as a mass 
copy) from the point at which it was stopped by an error (for ex­
ample, a disk error) message. Partial untagging provides a 
method by which you can subsequently restart the interrupted 
file operation. 

0 Partially Untagging File Lists 

Follow these steps to update tags after an interrupted file opera­
tion. In the example, we use the error message as the starting 
point. 

Action 

1. When the error message is 
displayed, press Esc to cancel 
the current file operation 

2. Press Ctrl + S or click COM­
MANDS and then Showall 

3. Press Ctrl + FB to untag 
files that have been operated 
on or select partial untag 
from the Tag pull-down menu 

4. Take the steps needed to con­
tinue the procedure, then con­
tinue the cancelled operation 
on the remaining tagged files 
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Response 

The operation is cancelled 

The Showall tagged files win­
dow is displayed 

Only the files that have not 
been operated on still remain 
tagged 

The operation will continue, 
beginning with the first re­
maining tagged file 
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Summary 

This chapter provided information on the advanced file manage­
ment and selection capabilities ofXTreeGold. Refer to individual 
sections when you need directions for a specific task, and try 
using all the advanced capabilities as you become more comfort­
able with XTreeGold's basic commands. Included in the chapter 
were: 

D Spanning directories and disks 

D Tagging files in the current window 

D Splitting windows and merging tags in split windows 

D Comparing files 

D Modifying file dates 

D Modifying file attributes 

D Selecting (tagging) files by attribute 

D Inverting tags and file specifications 

D Partially untagging file lists after interrupted operations 
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Working With Directories 

This chapter explains the routine directory information and man­
agement tasks that XTreeGold handles so easily. They include: 

D Making a new directory 

D Renaming a directory 

D Printing directory information 

D Deleting a directory 

D Splitting the directory window 

D Comparing file lists within directories 

D Relogging a directory 

D Copying directory structures 

D Moving directory structures 

D Grafting a directory branch 
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D Pruning a directory branch 

D Hiding/unhiding a directory 

You will probably utilize some of these capabilities on a daily 
basis, while others will be needed only occasionally, depending on 
your daily routine. Use this chapter as needed as an ongoing ref­
erence for tasks. 
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Making a New Directory 

The Make command enables you to add a new directory to a vol­
ume and a new subdirectory under an existing directory. The 
Make command is available: 

II' When the Directory window is active 

D From the Directory pull-down menu 

By clicking Make or pressing the hotkey M 

CoMpare... C 
Delete D 
Graft... Alt+G 
H1de-unh1de Alt+H 

~ 
Prune... Al t+P 
Relog Alt+F3 
RenaMe... R 

D Or, from the Standard directory command menu 

By clicking Make or pressing M 

DIR Avai 1 Branch Cot1pare Delete Fi lespec Global Invert Log ii:E!:!!l 
COMMANDS Oops• Print RenaMe Shouall Tag Untag UoluMe eXecute Quit 
......_,file F7 autovieu FB split F9 Menu F10 coMMands Fl help ? stats 

When you select the Make directory command, you are prompted 
for a directory name. You can either: 

D Enter a name of your choice up to 11 characters long without 
any wild card characters 

D Select an item from the history file (press Up Arrow or click 
history) 
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It is not necessary to begin typing the name with a backslash 
character. 

The new directory will be created under the current (highlighted) 
directory. The Directory window will then be updated to show 
the new directory within the tree structure. 

D Creating a New Directory 

This example shows how to create a directory called NEWDIR 
under the root directory C:\. (The root directory is the first, or 
top, directory on a volume). 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Press Home to place the 
highlight bar on the root direc­
tory or point to the C:\ and 
click 

3. Press M or click Make or se­
lect Make from the Directory 
pull-down menu 

4. Type NEWDIR and press 
Enter 
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Response 

The Directory commands are 
now available 

The root directory is selected 

The prompt Make subdirec­
tory under : \ as: is displayed 

Directory NEWDIR is created 
and displayed in the Directory 
window 
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Renaming a Directory 

You can rename a directory or subdirectory with the Rename com­
mand, which enables you to change the name of a directory while 
keeping the files in that directory intact. The Rename command 
is available: 

V When the Directory window is active 

D From the Directory pull-down menu 

By clicking Rename or pressing the hotkey R 

D Or, from the Standard directory command menu 

By clicking Rename or pressing R 

Any directory or subdirectory name other than the name of the 
root directory can be changed. When you select the Rename com­
mand, you are prompted for the name of the new directory. You 
can either: 

D Enter a directory name by typing one at the prompt 

D Select an item from the history file (press Up Arrow or click 
history) 

After you rename a directory, the Directory window is updated to 
show the new name. 

l@f' Note: Remember that most application programs look in spe­
cifically named directories for needed files. Do-not rename 
those directories unless you understand how your application 
programs work and are sure renaming them will not cause 
problems when running them. 
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D Renaming a Directory 

To rename a directory called MYDIR to OTHERDIR, when the Di­
rectory window is active: 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the directory 
MYDIR and click or press the 
Up or Down Arrow to place 
the highlight bar on MYDIR 

3. Press R or click Rename or 
select Rename from the Direc­
tory pull-down menu 

4. Type OTHERDIR (the new 
directory name) and press 
Enter 
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Response 

The Directory commands are 
now available 

The selected directory MYDIR 
is highlighted and shown in 
the path line 

XTreeGold displays the name 
of the selected directory, 
MYDIR and prompts Enter 
new directory name 

The directory is renamed and 
the directory window is up­
dated to display the renamed 
directory OTHERDIR 
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Printing Directory Information 

The Print command enables you to print directory information, in 
the form of: 

D The directory tree structure 

D A list of all path names 

D The name and statistics of all files on the current volume that 
have been tagged 

This Print command is available: 

ti' When the Directory window is active 

D From the Volume pull-down menu 

By clicking Print or pressing the hotkey P 

IJoluMe 

Log disk ... 
Log options... Alt+L 
Release disk... Al t+R 

Next logged disk 
Switch to disk... Ctrl+L 

Available space ... 
forMat diskette... Alt+fZ 
NaMe... IJ 

Statistics 
Wash deleted space Alt +W 

D Or, from the Standard directory command menu 

By clicking Print or pressing P 

DIR Avail Branch Co11pare Delete Filespec Global Invert Log Make 
COMMANDS Oops' ~ Rena11e Shouall Tag Untag Uolu11e eXecute Quit 
.____i file F7 autovieu FS split F9 11enu F10 co1111ands Fl help ? stats 
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When you select the Print command, a submenu is displayed with 
three options. 

Catalog of tagged 
files 

Pathnames 

Tree 

Prints the name and statistics of all files 
that have been tagged in every directory 
on the current volume. Contains a head­
ing for each directory on the'Volume that 
has at least one tagged file, followed by a 
list of files in that directory that are 
tagged, and file size, attributes, and file 
dates. 

Prints a list of path names with the total 
number oflogged files, and total bytes for 
the file, on the current volume. 

Prints the directory tree structure as you 
see it in the Directory window. Also prints 
the total number of logged files, and total 
bytes for the file, on the current volume. 

To print directory names and information, choose the option of 
your choice. XTreeGold prompts for the number of lines per page. 
You can either: 

D Accept the one shown 

D Enter a number by typing one at the prompt 

D Select an item from the history file (press Up Arrow or click 
history) 

Once you select a number and confirm by clicking ok or pressing 
Enter, you selection will be printed. Each time you print, remem­
ber the following: 

D Be sure the printer is turned on and available before selecting 
the command and the paper is properly aligned. 

D You can cancel printing at any time by pressing Esc. 
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D Printing a Catalog of Files 

To print a catalog of all the tagged files in all the directories on 
the current volume, follow these steps. Remember, the files must 
have been tagged with one ofXTreeGold's Tag commands for 
them to appear on the list. (Complete information on tagging 
files can be found in Chapters 3 and 4.) 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Press P or click Print or se­
lect Print from the Volume 
pull-down menu 

3. Press C or click Catalog of 
tagged files 

4. Type a number and click ok 
or press Enter (or to accept 
the number shown) 

Response 

The Directory commands are 
now available 

The print options are displayed 

The prompt Number of lines 
per page is displayed 

The catalog of tagged files is 
printed. 

ll2ilf' Note: If the catalog does not print, and the Error Message De­
vice not ready, Press C to Cancel and R to Retry is dis­
played, check to make sure your printer is on and available. 
Then press R to print. 

Follow the same steps to print Pathnames or the Tree, substitut­
ing the option of your choice in step 3. 

Working With Directories 5-9 



Deleting a Directory 

To delete a subdirectory or directory from the current volume, use 
the Delete command. The Delete command is available: 

V When the Directory window is active 

0 From the Directory pull-down menu 

By clicking Delete or pressing the hotkey D 

0 Or, from the Standard directory command menu 

By clicking Delete or pressing D 

You can only use this command to delete empty subdirectories 
(those that contain no files) or empty directories (those that con­
tain no files or subdirectories). 

When you choose the Delete command, you are prompted for the 
name of the directory you want to delete. You can either: 

0 Enter a directory name by typing one at the prompt 

0 Accept the one displayed (the current directory) 

You cannot delete the root directory. If you try to delete a direc­
tory that contains files or subdirectories, an error message will be 
displayed reminding you the directory is not empty. 

To delete a directory that is not empty, you can use the Prune 
command (described later in this chapter) to delete all files and 
subdirectories within the directory and then delete the directory 
itself. 
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D Deleting a Directory 

To delete a directory called MYDIR on the current volume which 
contains no files or subdirectories, follow these steps. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the directory 
MYDIR and click or press the 
Up or Down Arrow to place 
the highlight bar on MYDIR 

3. Press D or click Delete or se­
lect Delete from the Direc­
tory pull-down menu 

4. Press Y or click Yes (or press 
Nor click No) 

With Directories 

Response 

The Directory commands are 
now available 

The selected directory MYDIR 
is highlighted and shown in 
the path line 

The prompt Delete this di­
rectory? is displayed 

XTreeGold deletes the direc­
tory MYDIR and updates the 
Directory window to reflect 
the change (or if you select No, 
the delete procedure is can­
celled; the directory is not de­
leted) 
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Splitting the Directory Window 

XTreeGold's ability to split any window into two windows is espe­
cially useful when viewing and comparing the contents of differ­
ent volumes and directories, as well as when copying and moving 
directory structures. The Split command is available: 

V When any Directory or File window is active 

D From the Window pull-down menu 

By clicking Split on/off or pressing the hotkey p 

Window 

Autoview F? 

Uideo Mode Al t+F9 

DirectOrLJ files Enter 
Branch files B 
Branch tagged Ctr 1 +B 
Disk files <Showall) S 
Disk tagged Ctrl +S 
Global G 
Glob al tagged Ctr 1 +G 

File specification... F 
File display coluMns Alt+F 
Sort criteria... Alt+S 

D Or, from the Standard directory or Standard file com­
mand menu 

By clicking Split or pressing F8 

DIR Avai 1 Branch Co11pare Delete Filespec Global Invert Log Make 
COMMANDS Oops! Print Rena11e Showall Tag Untag Uolu11e eXecute Quit 
..__)file F7 autoview ~ F9 11enu F10 co1111ands Fl help ? stats 
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Some examples of ways you might use split windows are to: 

D Simultaneously view directory trees of different disks and vol­
umes 

D Simultaneously view the contents of different directories on 
the same volume 

D Simultaneously view the contents of different directories on 
different volumes 

D View the contents of a potential destination directory or vol­
ume while retaining a view of your source 

Notice that the File specification box, Disk specification box and 
Statistics box disappear in a split display. The current file specifi­
cation is at the top of each window in the display. In a split dis­
play, statistics can be displayed by using the ? stats command. 

When you choose the Split window command, the currently active 
window and all subsequent active windows are split. To return to 
a single window at any time, select the Split/unsplit command 
again with any window (Directory or File) active. In a split dis­
play, only one of the two display windows is considered active at 
any time and the active window is the one that contains the high­
light bar. All XTreeGold commands are available, however only 
items in the active window are impacted when you select a com-
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mand. When you return to a single window format, it is the inac­
tive window that is closed. 

If you choose either a Copy, Move or other command that 
prompts for a destination when in split windows mode and then 
select the F2 point option to point to the destination directory, 
XTreeGold lets you point to the destination in one window while 
maintaining your view of the source files in the other window. 
And, XTreeGold automatically defaults to the destination path 
shown in the other side of the split display. (See Chapter 4 for ad­
ditional information on split windows.) 

D Splitting Windows 

To split the Main Display when any window is active: 

Key 

FS orFlO 
+(Right or 
Left arrow 
to) open 
the Win­
dow menu 
+p 

TAB 

? 

FS again 
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Mouse Action 

Click split or 
click FlO 
commands, 
then Window, 
then Split 
on/off 

Click in the 
other side with 
the mouse 

Click stats 

Click 
split/unsplit 

Purpose 

XTreeGold divides the current 
window in half and copies the 
contents of the current win­
dow into the new window 

To move between the split 
halves; the other window will 
be active 

To display statistics in a split 
display; extended statistics for 
the active window are dis­
played in a full screen over 
the windows 

A single window is displayed; 
the contents match the active 
window at the time you se­
lected the unsplit command 
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Comparing Files In Two Directories 

XTreeGold enables you to compare the file list in one directory 
with the file list in another directory on the same or a different 
volume using the Directory window Compare command. This 
Compare command works differently than the File window com­
pare command, by comparing the file list in the current directory 
with the second and then tagging the files in the source (first) list 
that meet the criteria you specify from the options displayed on 
the screen. It is available: 

V When the Directory window is active 

D From the Directory pull-down menu 

By clicking Compare or pressing the hotkey C 

Directory 

Delete 
Graft ... 
Hide-unhide 
Make .. . 
Prune .. . 
Re log 
RenaMe . .. 

Alt+G 
Al t+H 

M 
Al t+P 

Al t+F3 
R 

D Or, from the Standard directory command menu 

By clicking Compare or pressing C 

DIR Avail Branch ;:m:rm Delete Fi lespec Global Invert Log Make 
COMMANDS Oops! Print Rena .. e Showall Tag Untag UoluP1e eXecute Quit 
-.!file F7 autoview FB split F9 P1enu F10 coP1P1ands Fl help ? stats 
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When you select the Compare command, XTreeGold assumes you 
want to compare the file list in the current directory with an­
other. You are prompted for the directory to compare with this 
list. You can either: 

D Enter a drive letter and directory name by typing one at the 
prompt 

D Select an item from the history file (press Up Arrow or click 
history) 

D Use the Point command (press F2 or click point) to display 
the destination directory window, where you can point to the 
second directory; ifthe current display is a split window dis­
play, you'll be able to maintain your source directory display 
while pointing to the second directory in the other side of the 
split window, and the destination at the prompt will default 
to the one shown in the other window. 

XTreeGold displays these additional options: 

Identical 

Unique 

Newer 

Older 

Tags every file in the first directory that 
has the same name, date, size and attri­
butes as a file in the second directory 

Tags every file in the first directory that 
does not exist in the second directory 

Tags every file in the first directory that 
has a more recent date than the file of the 
same name in the second directory 

Tags every file in the first directory that 
has an earlier date than the file of the 
same name in the second directory 

Each option can be turned on (yes) or off (no) by pointing to it and 
clicking or by pressing the displayed key. Files are tagged if they 
meet any one of the criteria selected. The options are not mutu­
ally exclusive. You may select any combination that makes sense 
for a specific task. 

5-76 Working With Directories 



Here's an example of how to use this command to compare the 
files in a directory to those on a backup diskette for that directory. 

0 Select the Compare command and choose the Unique and 
Newer options, by setting those to yes. Set the Identical and 
Older options to no. 

XTreeGold tags all the files in the original directory that did 
not exist on the diskette (Unique) or that had been modified 
since you backed them up (Newer). 

0 Then use one of the Copy commands to copy the tagged files 
to the diskette in order to update your backup of the directory. 
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D Comparing File Lists 

Follow these steps to compare the file list in the current direc­
tory, MYDIR with a diskette in the A: drive and tag all the 
unique and newer files in MYDIR. 

Action 

1. If the words DIR COMMANDS 

are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the directory 
MYDIR and click or press the 
Up or Down Arrow to place 
the highlight bar on MYDIR 

3. Press C or click Compare or 
select Compare from the Direc­
tory pull-down menu 

4. Type A: and press Enter, or 
select F2 point and then Log 
disk or> to point to A: 

5. If necessary, turn on Unique 
and Newer and turn off Identi­
cal and Older by clicking or by 
pressing the hotkey 

6. Press Enter or click ok 
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Response 

The Directory commands are 
now available 

The selected directory MYDIR 
is highlighted and shown in 
the path line 

The prompt Compare file 
list in: with: is displayed, ask­
ing you the name of the direc­
tory you want to use in the 
comparison 

The prompt tag files that 
are and the options are dis­
played 

The display will show your se­
lections as Identical (no) 
Unique (yes) Newer (yes) 
Older (no) 

All unique or newer files are 
tagged in the File window 
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Relogging a Directory 

Occasionally, you may make changes to a volume while using the 
Open command, the Execute command, or by running a program 
from the Application menu. At these times, you'll need to refresh 
a directory to maintain an accurate and up-to-date display of its 
contents. 

The Relog directory command enables you to quickly refresh the 
file display by rereading the information for the current directory 
only. This is a much quicker process than relogging a disk or vol­
ume. The Relog directory command is available: 

V When the Directory window is active 

D From the Directory pull-down menu 

By clicking Relog or pressing the hotkey I 

Directory 

CoMpare ... 
Delete 
Graft... Alt+G 
Hide-unhide Al t+H 
Make... M 
Prune... Alt+P 

RenaMe ... 

V Or, when any window is active 

D From the Alt directory or Alt file command menu 

By double-clicking COMMANDS and then relog dir or 
pressing Alt + F3 

ALT DIR Edit File display Graft Hide/unhide Log disk Prune Release dis 
COMMANDS Sort criteria Tag Untag Uash disk eXecute Quit 

FZ forMat ~ F9 video Mode F10 configure 
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When you select the Relog directory command, the file display for 
the current directory is immediately refreshed. No additional 
prompts are displayed by XTreeGold. If you make or delete any 
directories, it is usually better to relog the entire volume, to keep 
the directory tree accurate (Use the Log disk command to relog 
the volume.) 

D Relogging a Directory 

To relog a directory named MYDIR, follow these steps. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the modified direc­
tory MYDIR and click or press 
the Up or Down Arrow to 
place the highlight bar on 
MYDIR 

3. Press Alt + F3 or select 
Relog from the Directory 
pull-down menu 
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Response 

The Directory commands are 
now available 

The directory to be relogged 
(MYDIR) is highlighted 

The directory MYDIR is 
relogged, and the file display 
is updated 
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Copying Directory Structures 

One of the most important aspects of directory and file manage­
ment is Lhe regular backup of files. XTreeGold's Copy with paths 
command offers an easy method for the regular backup of com­
plete directories and for copying files to be transferred to another 
disk or computer. The Copy with paths command copies all 
tagged files to another volume and/or directory, duplicating the 
original directory structure of the source files underneath the tar­
get directory. 

This Copy command is available: 

II' When any File window is active 

D From the Tagged pull-down menu 

By clicking Copy with paths or pressing the hotkey o 

Tagged 

Attributes... Ctrl+A 
Batch... Ctrl+B 
Copy files... Ctrl+C 

Delete... Ctrl+D 
Move files... Ctrl+M 
Move with paths... Alt+M 
New date... Ctrl+N 
Print... Ctrl+P 
RenaMe... Ctrl+R 
Search... Ctrl+S 
Uiew Ctrl+U 
Zip and Arc... Ctrl+FS 

D Or, from the Alt file command menu 

By double-clicking COMMANDS and then clicking Copy 
or pressing Alt + C 

ALT FILE Im File display Log disk Move Open Release disk Sort criteri 
COMMANDS Tag Untag eXecute Quit 

FZ forMat F3 relog dir F4 coMpare FS open archive 
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When you choose the Alt Copy command, you are prompted for 
the file specification of the new files. You can either: 

D Press Enter to retain the same file names 

D Enter any name of your choice with wild cards 

D Select an item from the history file (press Up Arrow or click 
history) 

You are then prompted for the destination of the new files. You 
can either: 

D Enter a drive letter or a directory path by typing one at the 
prompt 

D Select an item from the history file (press Up Arrow or click 
history) 

D Use the Point command (press F2 or click point) to display 
the destination directory window, where you can point to the 
destination; ifthe current display is a split window display, 
you'll be able to maintain your source directory display while 
pointing to the destination in the other side of the split win­
dow. 

You are then asked whether to automatically replace existing 
files. 

D If you choose Y(es) you'll automatically overwrite files of the 
same name. 

D If you choose N(o) XTreeGold will ask for confirmation each 
time a file with the same name is about to be copied over. 

When you select the Copy with paths command, its operation dif­
fers from the Copy files command in these ways: 

D XTreeGold copies each tagged file to the destination volume 
using the source path name as the destination path name. 

D The directory structure is recreated beneath the designated 
destination. 
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D XTreeGold checks to see if the destination directory exists. If 
it doesn't, XTreeGold creates the path. 

When using XTreeGold from the Branch, Showall or Global dis­
plays, XTreeGold temporarily sorts the tagged files by directory 
path order and copies the files in that order. The result is that 
when you copy files to several diskettes, files within one subdirec­
tory usually will be on the same diskette. 

When copying, XTreeGold moves the highlight bar over each 
tagged file as it is being copied. If you are copying tagged files to 
a disk that becomes full, XTreeGold alerts you. You can then re­
place the full disk with either another formatted diskette that has 
more available space (and press any key to continue) or format a 
new diskette and continue the process. This enables you to copy 
large groups of files in one operation regardless of whether they 
will fit on one destination disk. 

XTreeGold does not allow you to copy over a Hidden or System 
file. If you are sure you want to do this, first remove the system 
or hidden attributes and then perform the copy operation. If you 
attempt to copy over a file with a Read-Only attribute, XTreeGold 
asks you to confirm the operation before continuing. 

ll@f' Note: Normally, XTreeGold also copies the archive bit when it 
copies a source file. You can configure XTreeGold to operate 
like DOS and always set the archive bit for newly copied files. 
Chapter 10 provides full information on configuring 
XTreeGold. 

The example on the following page shows how to copy all the files 
on the current volume to a diskette in the A: drive. Remember to 
insert the diskette in the A: drive. 
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D Backing Up a Volume 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Press S or click Showall or 
select Showall from the Win­
dow pull-down menu 

3. Press Ctrl + T or select All 
in window from the Tag pull­
down menu 

4. Press Alt + C or select Copy 
with paths from the Tagged 
pull-down menu 

5. Type a new file specification 
and press Enter or click ok (or 
press Enter to keep the same 
file names) 

6. Type A (or the path where 
you will be backing up the 
files, for example, A:BACKUP) 
and press Enter or click ok 

7. Type Y or click Yes 

8. Press Ctrl + A or select At­
tributes from the Tagged 
pull-down menu to modify the 
tagged files' archive flag, then 
type -A and press Enter to re­
move the Archive attribute 
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Response 

The Directory commands are 
now available 

The Showall file window and 
the File command menu are 
displayed 

All the files are marked with a 
diamond to show they are all 
tagged 

The prompt Duplicate paths 
and copy all tagged files as 
is displayed 

The prompt to: is displayed 

The prompt Automatically 
replace existing files? is dis­
played 

All tagged files are copied 

The prompt Enter attributes 
is displayed and then the ar­
chive attribute is removed 
from the tagged files 
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Moving Directory Structures 

XTreeGold also provides the ability to move files with their paths 
to any destination by using the Move with paths command. The 
Move with paths command actually copies files with their paths 
to any destination and then deletes those files from their original 
location. For users, it provides a one-step method for transferring 
files with their directory structure to another disk or computer. 
The .Move with paths command moves all tagged files to any desti­
nation, duplicating the original directory structure of the source 
files under the specified directory path. 

This Move command is available: 

V' When any File window is active 

D From the Tagged pull-down menu 

By clicking Move with paths or pressing the hotkey w 

Tagged 

Attributes ... 
Batch ... 
Copy files ... 
Copy with paths ... 
Delete ... 
Move files ... 

New date ... 
Print .. . 
RenaMe .. . 
Search .. . 
Uiew 
Zip and Arc ... 

Ctrl +A 
Ctrl+B 
Ctrl +C 

Alt+C 
Ctrl +D 
Ctrl +M 

Ctrl +N 
Ctrl+P 
Ctrl+R 
Ctrl+S 
Ctrl+U 

Ctrl+FS 

D Or, from the Alt file command menu 

By double-clicking COMMANDS and then clicking Move 
or pressing Alt + M 

ALT FILE Copy Fi le display Log disk iil!m!l Open Release disk Sol't critel'i 
COMMANDS Tag Untag eXecute Quit 

FZ fo1'11at F3 l'elog dir F4 co11pal'e FS open al'chive 
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When you choose the Move with paths command, you are 
prompted for the file specification of the new files. You can either: 

0 Press Enter to retain the same file name 

0 Enter any name of your choice 

0 Select an item from the history file (press Up Arrow or click 
history) 

You are then prompted for the destination of the files. You can ei­
ther: 

0 Enter a drive letter or a directory path by typing one at the 
prompt 

0 Select an item from the history file (press Up Arrow or click 
history) 

0 Use the Point command (press F2 or click point) to display 
the destination directory window, where you can point to the 
destination; if the current display is a split window display, 
you'll be able to maintain your source directory display while 
pointing to the destination in the other side of the split win­
dow. 

You are then asked whether to automatically replace existing 
files. 

0 If you choose Y(es) you'll automatically overwrite files of the 
same name. 

0 If you choose N(o) XTreeGold will ask for confirmation each 
time a file with the same name is about to be copied over. 

When you select the Move with paths command, its operation dif­
fers from the Move files command in these ways: 

0 XTreeGold copies each tagged file to the destination using the 
source path name as the destination path name 

0 The directory structure is recreated beneath the designated 
destination 
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D XTreeGold checks to see if the directory that contains the file 
exists on the destination path. Ifit doesn't, XTreeGold cre­
ates the path. 

When using Move from the Branch, Showall or Global displays, 
XTreeGold temporarily sorts the tagged files by directory path 
order and moves the files in that order. The result is that when 
you move files to several diskettes, files within one subdirectory 
usually will be on the same diskette. 

When moving files, XTreeGold places the highlight bar over each 
tagged file as it is being moved. If you are moving tagged files to 
a disk that becomes full, XTreeGold alerts you. You can then re­
place the full disk with either another formatted diskette that has 
more available space (and press any key to continue) or format a 
new diskette and continue the process (specify the drive and path 
again). This enables you to move large groups of files in one oper­
ation regardless of whether they will fit on one destination disk. 

XTreeGold does not allow you to move a Read-only, Hidden or 
System file. If you are sure you want to do this, first remove the 
read-only, system or hidden attributes and then perform the 
move operation. 

D Moving Files with Their Directory Structures 

This example shows how to move all the files in two directories, 
MYDIR and OTHERDIR, on the current volume to a diskette in 
the A: drive. Remember to insert the diskette in the A: drive. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the directory 
MYDIR and click or press the 
Up or Down Arrow to place 
the highlight bar on MYDIR 
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Response 

The Directory commands are 
now available 

The directory MYDIR is the 
current directory 
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3. Press T or select Directory 
files from the Tag pull-down 
menu to tag all the files in 
MYDIR 

4. Point to the directory 
OTHERDIR and click or press 
the Up or Down Arrow to 
place the highlight bar on 
OTHERDIR 

5. Press T or select Directory 
files from the Tag pull-down 
menu to tag all the files in 
OTHERDIR 

6. Press Ctrl + S or select 
Disk tagged from the 
Window pull-down menu 

7. Press Alt+ Mor select 
Move with paths from the 
Tagged pull-down menu 

8. Type a new file specification 
and press Enter or click ok (or 
press Enter to keep the same 
file names) 

9. Type A (or the path where 
you will be moving the files, for 
example, A:\NEWDIR) and 
press Enter or click ok 

10. Type Y or click Yes 
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All the files are marked with a 
diamond to show they are all 
tagged 

The directory OTHERDIR is 
the current directory 

All the files are marked with a 
diamond to show they are all 
tagged 

The Showall tagged files win­
dow and the File command 
menu are displayed 

The prompt Duplicate paths 
and move all tagged files 
as is displayed 

The prompt to: is displayed 

The prompt Automatically 
replace existing files? is dis­
played 

All tagged files are moved 
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Grafting a Directory Branch 

With XTreeGold, it is possible to move an entire directory and all 
the subdirectories and files in it to another parent directory. The 
Graft command provides this capability. The Graft Command is 
available: 

V' When the Directory window is active 

D From the Directory pull-down menu 

By clicking Graft or pressing the hotkey G 

Di rectory 

CoMpare ... 
Delete 

Hide-unhide 
Make .. . 
Prune .. . 
Re log 
RenaMe ... 

Al t+H 
M 

Al t+P 
Al t+f3 

R 

D Or, from the Alt directory command menu 

By double-clicking COMMANDS and then clicking Graft 
or pressing Alt + G 

ALT DIR 0 Edit File display mi! Hide/unhidll Log disk Pl"une Release dis 
COHHAHDS Sol"t cl"i tel"i a' Tag Un tag Uash disk eXecute Quit 

FZ fol"Hat F3 l"elog dil" F9 uideo Mode F10 configul"e 

When you select the Graft command, XTreeGold prompts for a 
destination, and automatically displays the destination directory 
window. Use the Up or Down Arrow, or point to a destination 
with the mouse and click. 

XTreeGold then asks you to confirm that you want to graft the 
tree. 
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D If you choose Y(es) XTreeGold will graft the subdirectory. 

D If you choose N(o) the operation will be cancelled. 

The following are some possible error conditions that might exist 
when using the Graft command. 

D Cannot graft the XTreeGold directory 

The location of the XTreeGold program files can't be changed 
with the Graft command. XTreeGold would not be able to 
find the overlay files it needs. 

D Insufficient memory to complete graft 

There is not enough program memory to move the branch. 
The only solution is to release some memory by releasing 
some logged drives or collapsing another branch or directory 
using the - (minus) key. 

D Cannot graft a directory to itself 
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If you try to graft a directory to its current parent this mes­
sage will be displayed. (For example, you cannot graft the di­
rectory C:\COMM\XTALK to C:\COMM) 
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D Grafting a Directory Branch 

To graft a subdirectory name MYDIR to a directory named 
OTHERDIR, follow these steps. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the directory 
MYDIR and click or press the 
Up or Down Arrow to place 
the highlight bar on MYDIR 

3. Press Alt + G or select 
Graft from the Directory pull­
down menu 

4. Point to the new parent di­
rectory, OTHERDIR and click 
or press the Up or Down 
Arrow to place the highlight 
bar on it 

5. Press Enter or click ok to 
graft the subdirectory 

6. Press Y or click Yes 
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Response 

The Directory commands are 
now available 

The selected subdirectory, 
MYDIR, is highlighted and 
shown in the path line 

XTreeGold prompts Graft 
sub-directory: (subdirec­
tory name) to new parent: 

XTreeGold displays 
OTHERDIR (the new destina­
tion parent directory name) in 
the prompt line 

XTreeGold asks for confirma­
tion by prompting Continue 
and graft the tree? 

The subdirectory is grafted, 
and displayed under the new 
parent directory, OTHERDIR 
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Pruning a Directory Branch 

To delete the contents of a directory, including all subdirectories 
and files, XTreeGold provides a command called the Prune com­
mand. The Prune command is available: 

el' When the Directory window is active 

D From the Directory pull-down menu 

By clicking Prune or pressing the hotkey P 

D Or, from the Alt directory command menu 

By double-clicking COMMANDS and then clicking 
Prune or pressing Alt + P 

The Prune command is a convenient command to use to delete a 
directory's contents and to delete the directory itself. Remember, 
you cannot use the directory Delete command to delete a direc­
tory if it contains any files or subdirectories, but you can use the 
Prune command. 

When you select the Prune command, as an additional safeguard, 
XTreeGold prompts you to type the word "prune" in order to con­
firm your intention of pruning a selected directory. 

I@' Note: When you use the Prune command, all of the 
directory's contents will be permanently deleted, so 
use the command with extreme caution. 

If any files in the branch to be pruned are Read-only, System or 
Hidden, you must remove these attributes. Display the Branch 
file window, tag all the files and then select the Attributes com­
mand from the Tagged pull-down menu. Enter -R-S-H at the At­
tributes prompt. Then select the Prune command. 

Once you confirm the command, the contents of the directory are 
deleted. Then XTreeGold queries you about deleting the direc­
tory itself. 
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D If you choose Y(es) XTreeGold will delete the empty directory. 

D If you choose N(o) the empty directory will remain. 

D Pruning a Directory Branch 

To prune a directory called MYDIR, follow these steps. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to· the directory 
MYDIR and click or press the 
Up or Down Arrow to place 
the highlight bar on MYDIR 

3. Press Alt + P or select 
Prune from the Directory 
pull-down menu 

4. Type the word PRUNE and 
press Enter or click ok 

5. Press Y or click Yes 
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Response 

The Directory commands are 
now available 

The directory you want to 
prune, MYDIR is highlighted 
and shown in the path line 

XTreeGold prompts PRUNE: 
Delete the highlighted 
branch of the tree Enter 
the word PRUNE: 

XTreeGold deletes all the files 
in the directory MYDIR and 
then prompts: Delete this di­
rectory? 

The directory is pruned, and 
no longer displayed in the Di­
rectory window 
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Hiding/unhiding a Directory 

With XTreeGold, it is possible to conceal a directory from view in 
the conventional DOS display even though this directory may 
still be viewable in XTreeGold. The Hide/unhide command pro­
vides this capability and allows you to hide any directory other 
than the root directory. The Hide command is available: 

v When the Directory window is active 

D From the Directory pull-down menu 

By clicking Hide/unhide or pressing the hotkey H 

D Or, from the Alt directory command menu 

By double-clicking COMMANDS and then clicking 
Hide/unhide or pressing Alt + H 

To hide a directory, make the directory the current directory and 
select the Hide command. XTreeGold will display the name of 
the directory in lowercase to show that it is hidden. To return the 
directory to normal unhidden status, simply select the Hide/unh­
ide command again. 

You may also specify that hidden directories will not be displayed 
in the normal XTreeGold tree display, by using an option in the 
configuration program. If you make this configuration change, 
you won't be able to display any hidden directories until you mod­
ify the configuration again, and therefore won't be able to return 
them to unhidden status until you return the configuration item 
to its original state. 
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D Hiding a Directory Branch 

To hide a subdirectory name MYDIR, follow these steps. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the directory 
MYDIR and click or press the 
Up or Down Arrow to place 
the highlight bar on MYDIR 

3. Press Alt + H or select Hide 
from the Directory pull-down 
menu 
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Response 

The Directory commands are 
now available 

The selected subdirectory, 
MYDIR, is highlighted and 
shown in the path line 

XTreeGold display the direc­
tory in the tree in lowercase, 
as mydir 
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Summary 

This chapter provided descriptions of and step by step instruc­
tions for the following directory management tasks: 

D Making a new directory 

D Renaming a directory 

D Printing directory information 

D Deleting a directory 

D Splitting the directory window 

D Comparing file lists within directories 

D Relogging a directory 

D Copying directory structures 

D Moving directory structures 

D Grafting a directory branch 

D Pruning a directory branch 

D Hiding/unhiding a directory 

Continue to refer back to individual sections, to help you in your 
day to day activities until you can work from the menus and 
prompts without additional instructions. 
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Working With Volumes and Disks 

A hard disk may be divided into one or more volumes; this is done 
before you begin to use your hard disk, and may have been done 
for you when you purchased your computer. These volumes can 
contain many directories and files, depending on how large they 
are. Diskettes contain only a single volume with additional direc­
tories and files. Your use of these volumes and the directories 
and files on them form the basis for all your disk management 
tasks. This chapter explains how to work with volumes and disks 
to make disk management tasks more efficient and easier. 

~ Note: In the discussions, the term "disk" or "volume" is used 
when most appropriate. You'll find that many of the com­
mands which use the word "disk" (such as the Log disk com­
mand) can also be applied to a volume. 

In this chapter, we'll describe how to: 

D Log a disk or volume 

D Release a disk or volume 

D Expand and collapse the directory tree 

D Log multiple volumes and access them 

Working With Volumes and Disks 6-1 



D Use XTreeGold's partial logging capabilities 

D Rename a volume 

D Determine available space on a volume 

D Display extended disk statistics 

D Format a diskette 

D Wash a disk 
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Logging a Disk or Volume 

In order to access information on a volume or disk, you will first 
have to log that volume. When XTreeGold logs a volume, it phy;;i­
cally reads its directory and file information and displays it on 
the screen. It also saves that information in temporary memory 
to display on the screen upon demand. The Log commands en­
able you to log a volume that has information you want to access 
and each of the Log commands provides different capabilities. 
The Log disk command is available: 

V When any Directory or File window is active 

D From the Volume pull-down menu 

By clicking Log disk or pressing the hotkey L 

UoluMe 

I •• I 

Log options... Alt+L 
Release disk... Al t+R 

Next 1 ogged disk 
Switch to disk... Ctrl+L 

Available space... A 
ForMat diskette... Al t+FZ 
NaMe... U 
Print... P 
Statistics 
Wash deleted space Al t+W 

D Or, from the Standard directory or file command menu 

By clicking Log or pressing L 

DIR Avail Bl"anch CoMpal"e Delete Filespec Global lnvel"t !!Jil Make 
COMMANDS Oops! Pl"i nt RenaMe Showall Tag Untag UoluMe eXecute Quit 
.....,J file F7 autouiew FB split F9 Menu F10 coMMands Fi help ? stats 
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When you use this Log command, XTreeGold performs a log on 
the selected volume and retains information about the current vol­
ume in memory. When XTreeGold performs a full log using the 
default configuration settings, it logs the entire volume including 
all directories and files. 

When you select the Log command, XTreeGold prompts you for 
the new volume. You can either: 

D Enter a disk drive by typing its drive letter at the prompt 

D Or select it from the displayed list with the mouse 

XTreeGold then reads the new volume, directory and file informa­
tion (regardless of whether it has been previously logged). If your 
selection is valid, XTreeGold logs the volume or disk and con­
structs a new directory tree within the Directory window display. 
The Disk specification box and Statistics box are also updated. 
Once a disk or volume is logged, it remains logged until you re­
lease it or until you exit XTreeGold. 

When you perform a full log of a volume or disk, you can im­
mediately apply all of XTreeGold's commands to it, working with 
the files and directories displayed in the windows. 

Remember that when you start XTreeGold, it automatically per­
forms a full log of the current volume (unless you indicate an­
other option when you start) and this is the information you first 
see in the Main Display. 

Logging Exceptions 

There are two exception conditions which can occur during log­
ging: 

D User Initiated Exception 
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If you press Esc to interrupt the logging process, XTreeGold 
prompts: 

Continue logging Quit XTreeGold ESC cancel" 

Press C to continue the logging process, or press Q to exit the 
program and return to the DOS prompt. If you press Esc 
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again, XTreeGold returns to the previous volume (if you al­
ready performed a log operation) or prompts you to log a vol­
ume: 

Log volume: 

ESC cancel 

Enter the volume letter for the volume you want to log. If you 
press Esc here, XTreeGold again prompts you to log a vol­
ume. XTreeGold requires that you log at least one volume. 

D Out of Memory Exception 

If you attempt to log a volume without first releasing the cur­
rent volume, it is possible that XTreeGold will discover that 
there is not enough memory available to log the new volume, 
so the new volume has only been partially logged. XTreeGold 
prompts you with a message and offers two options: Quit 
XTreeGold and exit to DOS or press ESC to remain on the 
original volume. 

Some alternatives are: 

Use the Release command to release all logged volumes 
and then log the current volume 

Use the Log options command to log the first level directo­
ries on a new volume 

If a single volume requires more memory than is available, 
XTreeGold displays a partial tree structure of the volume and 
prompts you with a message: 

Out of Memory - Partial volume logged 

You can then work with the directories and files that are dis­
played. 
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D Performing a Full Log of a Volume 

Follow these steps to perform a full log of a volume on a hard disk 
or diskette when either the Directory or File window is active. In 
this example, we'll log a volume on the hard disk called D:. 

Action 

1. Press L or select Log disk 
from the Volume pull-down 
menu 

2. Point to D (or the letter of 
your choice from the selections 
shown) and click or type D and 
press Enter 
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Response 

The prompt Log disk drive 
is displayed, along with a list 
of drive letters you can select 

The volume is logged and the 
Directory window is updated 
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Logging and Selecting Multiple Volumes 

As we said, the Log disk command saves directory and file infor­
mation in memory to be displayed upon request. You can log ad­
ditional volumes with any of the Log commands, until you have 
logged a total of 26 volumes or exhausted the memory available 
in your computer. 

When you have more than one volume logged, you can easily 
move between logged volumes to work with files and directories 
on more than one volume at a time. XTreeGold provides two 
methods for selecting a previously logged volume, the Switch to 
disk (Ctrl Log) command and the Switch keys. 

Selecting a Previously Logged Volume 

To quickly switch directly to another logged volume of your 
choice, use the Switch to disk (Ctrl Log) command. This com­
mand has two capabilities: 

D It enables you to select a volume that has already been logged 
without relogging it. 

D It will log a volume or disk you select that has not been pre­
viously logged. 

It is available: 

V' When any Directory or File window is active 

D From the Volume pull-down menu 

By clicking Switch to disk or pressing the hotkey S 
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0 Or, from the Ctrl directory or Ctrl file command menu 

By clicking COMMANDS and then Log or pressing 
Ctrl + L 

CTRL FILE Attributes Batch Cop!j Delete Inuert ~ Moue lieu date 
COMMANDS Print Rena11e Search Tag Untag U i eu 

FS archiue files F6 11erge tags FB partial untag 

When you select this Switch/Log command, you are prompted for 
a drive letter. You can either: 

0 Select a drive letter with the mouse pointer 

0 Or type the drive letter at the prompt 

The directories and files for the selected volume will then be dis­
played in the Directory window. 

Using the Select Keys 

To cycle through all the logged volumes, use the<> Select keys. 
It is not necessary to press the Shift key when using< or>. The 
Select keys and mouse operations enable you to cycle forward or 
backward through logged volumes, with a single keystroke: 

0 Use the> (called the greater than sign or right angle bracket) 
or click select to cycle forward, according to a volume's as­
signed drive letter. 
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D Use the< (called the less than sign or left angle bracket) to 
cycle backward, according to a volume's assigned drive letter. 

The Switch to disk command is also available: 

V When any Directory or File window is active 

D From the Volume pull-down menu 

By clicking Next disk or pressing the hotkey N 

D Selecting a Previously Logged Volume 

To select a previously logged volume, A: from memory without 
relogging it, follow these steps when any window is active. 

Action 

1. Press Ctrl + L or select 
Switch to disk from the Vol­
ume pull-down menu 

2. Click A or type A and press 
Enter 

Response 

The prompt Enter volume 
name is displayed 

The volume information is dis­
played, and the Directory win­
dow is active 

D Cycling Through Previously Logged Volumes 

Key Mouse Action 

> Click select 

< 

Working With Volumes and Disks 

Purpose 

Displays the directory tree for 
the next logged volume (in al­
phabetical order) 

Displays the directory tree for 
the previous logged volume (in 
alphabetical order) 
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Releasing a Volume or Disk 

The Release command enables you to release the information 
stored for one or more volumes, freeing memory needed when 
working with large volumes and directories. It is available: 

V' When any Directory or File window is active 

D From the Volume pull-down menu 

By clicking Release disk or pressing the hotkey R 

UoluMe 

Log disk... L 
Log options... Alt+L 

Next logged disk > 
Switch to disk... Ctrl+L 

Available space... A 
ForMat diskette... Alt+FZ 
NaMe... U 
Print... P 
Statistics 
Wash deleted space Al t+W 

D Or, from the Alt directory or Alt file command menu 

By double-clicking COMMANDS and then clicking 
Release disk or pressing Alt + R 

ALT DIR Edit File dispia!:I Graft Hidel'unhide Log disk Prune 
COMMANDS Sort criteria Tag Untag Uash disk eXecute Quit 

FZ for11at F3 relog dir F9 video 11ode F10 configure 

When you select the Release command from a File window, 
XTreeGold asks you to enter a disk letter. You can either: 

D Choose to release the current volume (the default) by not en­
tering a disk letter at the prompt 
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D Enter a drive letter by pointing and clicking with the mouse 
or by typing one at the prompt 

When you select the Release command with the Directory window 
active, XTreeGold provides additional options: 

Branch Release the directory branch from the cur­
rent subdirectory down 

Disk drive Release an entire volume (identical to the 
standard Release command available with 
the File window active) 

Files in branch Release the file information for the direc­
tory branch but maintains the directory 
tree display 

If you release the currently logged volume from memory, 
XTreeGold will switch to the next logged volume. 

D Releasing a Volume 

To release a volume named D: on the hard disk from memory, fol­
low these steps when any window is active. 

Action 

1. Press Alt + R or select Re­
lease from the Volume pull­
down menu 

2. Enter the drive letter D of 
the volume you wish to release 
and press Enter 
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Response 

The prompt Enter volume 
name is shown 

The file and directory informa­
tion on selected volume is re­
leased from memory 
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Expanding and Collapsing the Directory Tree 

XTreeGold enables you to expand and collapse the directory tree 
in order to selectively log only the directories and files you'll be 
working with and release unneeded information from memory. 
Once you partially log a volume, you can expand the directory 
tree to log additional branches you want to work with. Once you 
perform a full log on a volume, you can collapse the directory tree 
to release information from memory that isn't needed. And the di­
rectory tree is dynamic in that you can log or release directories 
or branches as you need to. These capabilities help you speed up 
the logging process, dedicate memory to your selected tasks and 
customize the tree display to meet specific needs. 

They are available by using the Log options command (described 
in the next section) and by using the following expand and col­
lapse keys and mouse functions. 
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A blank space to the left of the directory indicates that the direc­
tory has been logged. When a directory has been logged, the file 
names of all the matching files are always displayed in the File 
window, and you see at least the first level subdirectories on the 
tree. 

A+ (plus sign) indicates that a directory has not been logged. 
When a directory is not logged, Dir Not Logged is always dis­
played in the File window. 

In the directory tree display, the. (dot) to the left of the directory 
indicates a directory which has been logged but contains addi­
tional subdirectories which are not displayed in the directory 
tree. You may see the dot if you have logged directories and then 
used the F5 key to hide the display. 

A? (question mark) to the left indicates that the directory files 
are not logged but there are logged subdirectories that are not dis­
played. 

To log additional directories and files, expand the directory tree. 
Either: 

D Use the* (asterisk) key to log any directory and all the sub­
directories and files in that directory. 

D Use the+ (plus) key to log any directory and all the files and 
first level subdirectories only in that directory or double-click 
the + (plus sign) with the mouse. 

D Select a directory and press Enter to log only the files in that 
directory and display the Directory window for that directory. 
You can also select a directory and then click in the file win­
dow. 

~ Note: This technique works if the selected directory is not 
logged (you'll see a + to the left of it). If the directory is al­
ready logged and you press Enter the highlight bar moves to 
the File window. 
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To release directory and file information from XTreeGold memory 
and contract the directory tree. Either: 

D Use the - (minus) key to release any branch and all the files 
in that branch from the display 

D Select the Release command from the Volume pull-down 
menu or Alt directory or Alt file command menu. 

To toggle between temporarily hiding and showing directory infor­
mation in the tree: 

D Double-click the blank space directly to the left of the direc­
tory name with the mouse. 

D Use the F5 key to expand or collapse the directory tree dis­
play one level below the current subdirectory. 

D Use the F6 key to expand or collapse the directory tree dis­
play to the current subdirectory level. 

~Note: Double-clicking the blank space and the F5 and F6 
keys provide the ability to quickly collapse the tree displayed 
in the Directory window while leaving all the currently logged 
files still logged. 
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D Expanding and Collapsing the Tree 

To expand or collapse the directory tree, highlight the desired di­
rectory and use these options. 

Key 

* 
(asterisk) 

+ 
(plus) 

Enter 

(minus) 

F5 

F6 

Mouse Action 

Double-click 
the+ (plus 
sign) 

Double-click a 
directory 

Double-click 
the blank 
space 
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Purpose 

Logs the current branch and 
expands the directory tree 

Logs the current directory and 
the first level subdirectories 

Logs the current directory and 
the first level subdirectories if 
the directory is not already 
logged 

Releases the files and directo­
ries in the current branch 
from XTreeGold memory 

Shows or hides the directory 
tree display one level below 
the current directory 

Shows or hides the directory 
tree display to the current sub­
directory level 
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Additional Logging Capabilities 

In addition to logging an entire volume, XTreeGold provides a se­
ries of logging options to partially log the directory tree. When 
you perform a partial log, you can only work with the files that 
have been logged thus far. To work with other files and directo­
ries on the volume, you can then selectively log only the directo­
ries and subdirectories you'll be working with, by expanding or 
partially logging additional directories or branches on the direc­
tory tree. An advantage of partial logging is that it provides the 
ability to work quickly and easily with portions of several large 
hard disks and drives at the same time, keeping all the needed in­
formation in memory, while not committing memory to non-rele­
vant file and directory information. 

The Log options command is available: 

V' When any Directory or File window is active 

0 From the Volume pull-down menu 

By clicking Log options or pressing the hotkey o 

0 Or, from the Alt directory or Alt file command menu 

By double-clicking COMMANDS and then clicking Log 
disk or pressing Alt + L 

When you select the Log options command with the Directory win­
dow active, XTreeGold displays these additional options: 

Branch 

Disk drive 

One level 
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Logs (like the * key) the directory branch 
from the current subdirectory down 

Logs an entire volume (identical to the 
standard log command) 

Logs (like the + key) only the first level of 
files and directories 
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Refresh directory 

Tree only 

Relogs the current subdirectory (identical 
to the Relog directory command) 

Logs the tree structure only, starting from 
the current directory, releasing all the files 

When you select the Log options command with the File window 
active, only the Disk drive and Refresh directory options are 
available. 

Once you select an option, XTreeGold immediately performs the 
option on the current volume, unless you selected the Disk drive 
option. When you select Disk drive, you will be presented with a 
list of available volumes. Enter your choice with the keyboard or 
mouse, as always. 

Command Line Logging Options 

You can also indicate specific logging choices by using a command 
line option. These are list~d in Chapter 10, Configuring 
XTreeGold. 
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D Performing a Partial Log on a Volume 

Follow these steps to perform a partial log on a branch whose par­
ent is MYDIR on the current volume when the Directory window 
is active. 

Action 

1. If the words DIR COMMANDS 

are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to directory MYDIR 
with the mouse and click or 
use the Up or Down Arrow to 
highlight MYDIR 

3. Press Alt + L or select Log 
options from the Volume pull­
down menu 

4. Press B or click Branch 
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Response 

The Directory commands are 
now available 

MYDIR is the current direc­
tory 

The Log options are displayed 

All the subdirectories and files 
in the branch are logged and 
displayed in the Directory and 
File windows 
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Renaming a Volume 

XTreeGold enables you to easily change the volume name or label 
with the Volume name command. The Volume name command is 
available: 

II' When the directory window is active 

D From the Volume pull-down menu 

By clicking Name or pressing the hotkey m 

Uol UMe 

Log disk ... 
Log options... Al t+L 
Release disk... Alt+R 

Next logged disk 
Switch to disk... Ctrl+L 

Available space ... 
ForMat diskette... Al t+FZ 

Print ... 
Statistics 
Wash deleted space Al t+W 

D Or, from the Standard directory command menu 

By clicking Volume or pressing V 

DIR Avai 1 Branch Co11pare Delete Fi lespec Global Invert Log Make 
COMMANDS Oops' Print Rena11e Showall Tag Untag ;!.l!l;m eXecute Quit 
.___irile F7 autoview F8 split F9 11enu F10 co1111ands F1 help ? stats 

' When you select the Volume command, you are prompted for a 
new volume name. You can either: 

D Type any volume name of your choice 

D Select an item from the history file (press Up Arrow or click 
history) 

Working With Volumes and Disks 6-79 



After you enter the volume name, XTreeGold writes it to the vol­
ume. If the new volume name is the same as the name of a file or 
directory in the Root directory, XTreeGold will report an error. 

D Changing a Volume Name 

Use the following steps to change the volume name from 
VOLUMEl to VOLUME2. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Press V or select Name from 
the Volume pull-down menu 

3. Type VOLUME2 (the new 
volume name) and press Enter 
or click ok 
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Response 

The Directory commands are 
now available 

The prompt Change volume 
name to: is displayed 

The Volume name is changed, 
and the new volume name is 
displayed in the Disk specifica­
tion box 
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Available Space on a Volume 

The Available command quickly displays the amount of unused, 
or available, space on a volume. The Available command is dis­
played: 

V When the directory window is active 

D From the Volume pull-down menu 

By clicking Available space or pressing the hotkey A 

D Or, from the Standard directory command menu 

By clicking Avail or pressing A 

To display the amount of unused disk space on a volume, select 
the Available space command. XTreeGold then prompts you to 
enter the disk drive letter and displays a list of drives. You can ei­
ther: 

D Enter a drive letter by pointing and clicking 

D Or type the letter at the prompt 

XTreeGold then checks the volume and displays the number of 
bytes available. 
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D Displaying Unused Disk Space 

Follow these steps to display available disk space on a volume 
with the assigned drive letter C:. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Press A or select Available 
space from the Volume pull­
down menu 

3. Point to C and click or type C 
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Response 

The Directory commands are 
now available 

The prompt Available space 
on disk is displayed 

XTreeGold checks the volume 
and displays the available 
bytes 
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Extended Statistics Window 

The Extended statistics window displays additional disk and file 
information not included in the Main Display. It can be displayed 
by selecting the Stats command. The Stats command is available: 

al' When any Directory or File window is active 

D From the Volume pull-down menu 

By clicking Statistics or pressing the hotkey t 

D Or, when any window is active 

By pressing? (although it may not displayed on the menu) 

D Or, by clicking anywhere in either the File specification, 
Disk specification or Statistics box. 

The Extended statistics window is immediately displayed when 
you select the command. 
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It provides the following disk and file statistics: 

Disk drive 

Capacity 

Available space 

Used space 

Slack space 

Cluster size 

Sector size 

Total sectors 

Total clusters 

Sectors per cluster 

File specification 

Total files 
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The name of the current volume 

The total number of bytes that can be 
stored on the disk 

The number of bytes of data which can 
still be stored 

The number of bytes of data which are al­
ready stored on the disk 

The total amount of allocated space on the 
disk not actually used by files 

The number of bytes in each cluster (a 
cluster is a physical block on the disk) 

The number of bytes in each sector (a sec­
tor is a division of a disk track) 

The number of sectors into which the disk 
has been divided 

The number of clusters into which the 
disk has been divided 

For optimum performance, the number of 
sectors that are in each cluster on the disk 

The current file name and extension in 
the File specification Box, used for deter­
mining matching files 

The total number of files and their size (in 
bytes), on the disk 
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Matching files 

Tagged files 

Displayed files 

Average size 

The total number of files that match the 
current file specification and their size (in 
bytes) 

The number of files, and their size (in 
bytes) that have been selected and 
marked for subsequent operation 

The number of file names, and their size 
(in bytes) that are displayed in the cur­
rent file window 

The average size (in bytes) of each file on 
the disk 
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Formatting a Diskette 

XTreeGold enables you to format a diskette of any type config­
ured for use on your system, with the Format command. The 
command is displayed: 

t/ When any Directory or File window is active 

D From the Volume pull-down menu 

By clicking Format diskette or pressing the hotkey F 

D Or, from the Alt directory or Alt file command menu 

By double-clicking COMMANDS and then clicking 
format or pressing Alt + F2 

ALT FILE Copy File display Log disk Moue Open Release disk Sort cri teri 
COMMANDS Tag Untag eXecute Quit 

am::!ll! F3 relog dir F4 co11pare FS open archive 

When you choose this option, XTreeGold lists the available disk 
drives and asks you to choose a drive for the formatting proce­
dure. Select the drive letter from those listed. XTreeGold then 
asks you to select a media type (for example, a high density or 
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low density diskette). Again, select the appropriate media type 
from those listed. Then follow the disk insertion prompts. The 
diskette will be formatted, and XTreeGold will ask if you want to 
format another one. You can either: 

D Continue formatting as many diskettes as needed by pressing 
Enter or clicking ok 

D Discontinue the formatting operation on additional disks by 
pressing or clicking Esc 

D Formatting a Diskette 

These steps show how to format a diskette in the A: drive and can 
be followed with any window active. Remember to insert the disk­
ette in the A: drive. 

Action 

1. Press Alt + F2 or select For­
mat diskette from the Vol­
ume pull-down menu 

2. Type A: 

3. Type Hor click High Den­
sity (or Dor click Double Den­
sity) 

4. If you have not inserted the 
disk to be formatted, now is the 
time to do so. Then press 
Enter or click ok to confirm 

5. Press or click Esc 
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Response 

The prompt Select diskette 
drive A: is displayed (this is 
determined by how the drives 
are configured on your system) 

The prompt Select media 
type is displayed 

The prompt: Format disk­
ette in drive A: is displayed 

The diskette is formatted, 
then the prompt Format an­
other diskette in drive A: is 
displayed 

The Main Display is on the 
screen 
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Washing a Disk 

The Wash disk capability is a security feature available from 
XTreeGold. When XTreeGold washes a disk, it clears all unallo­
cated areas of the current volume. This prevents anyone from 
being able to view or restore your deleted files. It is available: 

II' When the Directory window is active 

0 From the Volume pull-down menu 

By clicking Wash deleted space or pressing the hotkey 
w 

0 Or, from the Alt directory command menu 

By double-clicking COMMANDS and then clicking Wash 
disk or pressing Alt + W 

lkiF Note: Once you wash a disk, you cannot undelete files that 
were deleted prior to the washing. 

When you select the Wash option, XTreeGold waits for confirma­
tion. Either: 

0 Press Enter or click ok to confirm 

0 Press or click Esc to cancel 

XTreeGold then washes the current disk. No additional action is 
necessary. The prompt Washing drive is displayed and 
XTreeGold counts and displays the bytes on the disk. Washing a 
disk does not harm your existing files. 

6-28 Working With Volumes and Disks 



D Using Wash Disk 

To wash the current disk C:, follow these steps. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Press Alt + W or select 
Wash deleted space from the 
Volume pull-down menu 

3. Press Enter or click ok 
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Response 

The Directory commands are 
now available 

The prompt Wash disk drive 
C: (the current disk) is dis­
played 

The prompt Washing drive 
C: and the number of bytes 
are displayed, then the Direc­
tory window is displayed again 
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Summary 

This chapter explained how to apply XTreeGold commands to 
disks, volumes and diskettes. Those tasks include how to: 

0 Log a disk or volume 

0 Release a disk or volume 

D Expand and collapse the directory tree 

0 Log multiple volumes and access them 

0 Use XTreeGold's partial logging capabilities 

D Rename a volume 

0 Determine available space on a volume 

D Display extended statistics for a disk or volume 

D Format a diskette 

0 Wash a disk 

XTreeGold gives you the big picture of files, directories and vol­
umes and lets you perform file management tasks on multiple vol­
umes in highly efficient ways. Use the information and the steps 
in this chapter as a reference the first few times you try the proce­
dures described. After you complete the procedures several 
times, you'll probably be able to use the menus and prompts to 
walk you through the steps without additional directions. 
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Using View, Autoview and Search 

Through the use of the View, Autoview and Search commands, 
XTreeGold gives you the ability to: 

0 Display the contents of a selected file in its native format, 
even if it is a file you created in a spreadsheet, database or 
word processing program 

0 Browse through files in a directory, either to find a particular 
item or review the contents of several files in rapid succession 

0 Browse through a directory for a particular file and then 
zoom in on the contents more closely 

0 Search through one or more files in one or more directories 
for a specific character string 

This chapter provides the step-by-step instructions you'll need to 
quickly and easily perform these tasks. 
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The View Command 

XTreeGold provides viewers to enable you to look through one or 
more files quickly and easily, by displaying the contents of the 
files on the screen. The View file command gives you the ability 
to look through the contents of the current file. The View file com­
mand is available: 

V' When any File window is active 

D From the File pull-down menu 

By clicking View or pressing the hotkey V 

File 

Attributes ... 
COplJ ... 
Delete 
Edit 
Move ... 
New date ••. 
Open <quick) 
Open (al 1 MeMOrlj) 
Open Zip and Arc 
Print ... 
RenaMe ..• 

A 
c 
D 
E 
M 
N 
0 

Al t+O 
Al t+FS 

p 
R 

D Or, from the Standard file command menu 

By clicking View or pressing V 

FILE Attributes Cop!J Delete Edit Filespec Invert Log disk Moue 
COMMANDS Neu date Open Print RenaMe Tag Untag m eXecute Quit 
.____.tree F7 autouieu F8 split F9 Menu F10 COMMands Fl help ESC cancel 

D Or, by pointing to a file with the mouse and double-click­
ing the right button 
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The View tagged files command displays the contents of the first 
tagged file and displays a command for viewing the next tagged 
file in the list. The View tagged files command is available: 

V When any File window is active 

0 From the Tagged pull-down menu 

By clicking View or pressing the hotkey V 

0 Or, from the Ctrl file command menu 

By double-clicking COMMANDS and then clicking View 
or pressing Ctrl + V 

Special XTreeGold File Viewers 

XTreeGold provides many special viewers to enable you to look at 
the contents of files created with popular word processing, 
spreadsheet and database programs. If the file type detection is 
set to automatic when you choose View, XTreeGold tries to deter­
mine the kind of file it is opening and adjust to accommodate the 
file type by displaying the file in the appropriate format. 

0 XTreeGold first checks whether the selected file has a .WKl, 
.WKQ, .WKS, .WKT, .WQl, .XLM or .XLS extension. Ifit 
does, XTreeGold tries to interpret it as a spreadsheet file. An 
error message will be displayed if it can't. 

0 XTreeGold then checks whether the selected file has a .DBF 
or .DB extension. If it does, XTreeGold tries to interpret it as 
a database file. An error message will be displayed if it can't. 

If the file falls into neither of these categories, XTreeGold brings 
it up in one of three modes: 

0 ASCII, if all the characters are displayable ASCII characters. 

0 Wordwrap, if most but not all the characters in the file are 
displayable ASCII characters; most word processing docu­
ment files are displayed in Wordwrap format. 
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D Dump, if there are more than a few non-displayable charac­
ters in the file. 

XTreeGold's automatic choice of display mode will be sufficient 
for most browsing purposes. When you need to see every charac­
ter in a word processor file, take the extra time required to use 
the Formatted command, (available in View mode, but not View 
all mode) which will analyze the file and then display every char­
acter. 

XTreeGold will not automatically format word processing files, 
but will format files created with any of the following programs, 
when the Format command is selected. XTreeGold will automati­
cally display the following spreadsheet and database programs in 
their correct format. 

D Spreadsheets 

Lotus lA, 2.0, 2.2 and compatibles 

Excel 

» Quattro and Quattro Pro 

D Databases 

» dBase III, IV and compatibles 

Paradox 

D Word processors 

DCA/FFT (Final Form Text) and DCA/FFT (Revisable 
Form Text) 

» DisplayWrite 2, 3, 4, 5 Native, 5/2 

» Enable (wp) 1.0, 2.0, 2.15 

» Framework III (wp) 1.0, 1.1 

» HP Advance Write Plus 
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» IBM Writing Assistant 1.0 

Lotus Manuscript 2.0, 2.1 

Microsoft RTF (Rich Text Format) and Microsoft Word 
3.0, 3.1, 4.0, 5.0 

Microsoft Windows Write 3.0 

» MultiMate 3.3, 4 and MultiMate Advantage I, II, 3.6, 3. 7 

Office Writer 4.0, 5.0, 6.0, 6.1 

PFS: First Choice 1.0, 2.0 and PFS: Write Version C 

Professional Write 1.0, 2.0, 2.1 

Q &A(WP)3.0 

» RapidFile (Memo) 1.0, 1.2 

Samna Word IV 1.0, 2.0 and Samna Word IV Plus 1.0, 2.0 

Total Word 1.2, 1.3 

Volkswriter 3, 4 and Volkswriter Deluxe 2.2 

» Wang PC Version 3 

WordPerfect 4.1, 4.2, 5.0, 5.1 

Wordstar 3.3, 3.31, 3.45, 4.0, 5.0, 5.5, 5.6, 6.0 and 
W ordstar 2000 

» XyWrite III, III Plus 
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The View Window 

The View window is divided into separate areas for displaying the 
contents of selected files and additional View commands, and pull­
down menus are available by first selecting FlO commands or 
clicking in the menu header area at the top of the screen. 

File· C • 'WP50,SCHEDULE. DOC FORMATTED U I EW 

Uer':::I Best Products CoMpany 

DOCUMENT DEUELOPMENT SCHEDULE 

Feb. 10. 1991' 
The following is a I ist of key course developMent events and a 
Model ti Meline. Your proposal should either conf i rM your ability 
to Make such a schedule or include your scheduling requireMents. 
Final dates will be deterMined by Mutual agreeMent. 

Key Event: After Startup: 

Project Startup 
Design docuMent to us for review 
Design docuMent approval Meeting 
Draft Manuscript <part I) to us for review 
Draft Manuscript returned to you 
Draft Manuscript (part I I) to us for review 
Draft Man user i pt returned to you 

S wee.ks 
b weeks 
14 weeks 
10 wee.ks 
Z0 weeks 
22 weeks 

IEW ASCII DuMp ForMatted Gather Hex Mask Wordwrap 
OMMANDS FZ F3 F4 F5 Fe goto bookMark F9 search SPACE search again 

i .I. scroll ALT SHFT Menus F10 cOMMands Fl help ESC cancel 

When you select either View command, XTreeGold displays the 
first page of the contents of the selected file, or the first file in the 
list of tagged files, on the screen. However, you cannot view pass­
word protected files with the view command 

To scroll the contents of the file in the View window, either: 

D Press the Arrow keys 

D Click the top or bottom of the contents side with the mouse. 

Use the Shift+ F2-F6 keys to set the automatic scrolling speed. 
F2 provides the fastest scrolling; F6 provides the slowest. 

The View commands also enable you to look for a character 
string, (for example a person's name) in a file or in a group of 
files, and then display those files in which it finds the character 
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string. If you see highlighted portions of the screen, these indi­
cate the text string you specified in the last Search operation. 

Additional View Commands 

At the bottom of the screen, XTreeGold displays additional com­
mands that can be used while the View window is active and 
which are also available from the pull-down menus. Some com­
mands are not available when you select a spreadsheet or 
database file for viewing, as noted. Here are the commands and 
their purpose, organized by pull-down menu headers. 

Pull-down 
menu item 

D XTree 

Help 

Quit view 

o Bookmark 

1-5 Go to 
mark 1to5 

Set mark 1 
to 5 

Command 
menu item 

Fl help 

Esc cancel 

F2-F6Go to 
bookmark 
lto 5 

Alt+ F2-F6 
Set bookmark 
lto 5 

Purpose 

Displays a context sensitive 
help screen 

Closes the view of the selected 
file and returns you to the 
standard XTreeGold display 

Goes to the markers you've 
previously set with the Set 
bookmark command 

Sets markers at selected loca­
tions in the file you are view­
ing 

~ Note: The Bookmark menu is not displayed when you enter 
View mode with the View tagged files or Ctrl +View com­
mand 
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D Edit 

Gather Gather Permits you to mark a block of 
lines in the displayed file and 
append that block to an ASCII 
disk file. XTreeGold creates 
the file if it doesn't exist. You 
can use either the keyboard or 
mouse to mark blocks of text 
for gathering. 

Hex edit Edit When the file's contents are 
displayed hexadecimal format, 
it permits the editing of a file, 
in typeover mode. (Displayed 
only when in Hex view mode.) 

Next file Next tagged Displays the first page of the 
file next tagged file. (Available 

only if you entered the View 
mode with the Ctrl + View 
Command.) 

Search F9 search Lets you search for character 
strings within the displayed 
file 

Search space search Searches for the next occur-
again again rence of the character string 

that you specified with the 
Search command 

D View 

ASCII ASCII Displays the file's contents in 
a normal character display 
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Dump Dump 

Formatted Formatted 

Hex Hex 

Wordwrap Wordwrap 

Mask Mask 

Using View, Autoview And Search 

Shows all displayable charac­
ters in the file without line for­
matting. The file's location is 
displayed in hexadecimal char­
acters on the left of the dis­
play. 

Displays formatted word pro­
cessor files, spreadsheet files, 
or database files. (Not avail­
able if you entered the View 
mode with the Ctrl + View 
Command.) 

Displays the file's contents in 
hexadecimal format where 
you can view the binary value 
of each byte in the file. You 
can also edit files in Hex view 
if the program is configured to 
support hex editing. 

Displays text in an 80-column 
ASCII display, which is partic­
ular useful for viewing files 
created with a word processor. 
In Wordwrap view, XTreeGold 
only shows displayable charac­
ters and automatically breaks 
lines of text at spaces between 
words. 

Masks the eighth bit. Some 
text programs use the eighth 
(or high) bit of each byte to 
hold special information. Be­
cause of this, the text may be 
displayed with odd characters 
and symbols in place of the ex­
pected alphanumeric text. 
The Mask command turns off 
the high bit for viewing. 
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Hex Editing 

When you select the Hex option, the screen on the following page 
is displayed. The Edit option is also displayed on the command 
menu, and Hex edit is displayed on the Edit pull-down menu. 
This command permits the editing of a file in Hex view, in 
typeover mode. Simply move the cursor to a character you want 
to change, and type the replacement over it. When you select the 
Hex edit option, additional commands are displayed in the com­
mand line. 

ile C 'XTGOLD,XTG_MENU.OAT HEX (Masked ) 

000000 02 20 58 54 72 &5 &5 40 &5 &E 75 20 28 74 &O 29 XTreeMenu ( tM) 
000010 lA 00 05 00 0& 00 00 00 00 00 00 00 00 00 00 02 
000020 FF 00 00 20 20 20 20 20 20 20 20 20 20 58 20 54 X T 
000030 20 52 20 45 20 45 20 47 20 4F 20 4C 20 44 20 20 REEGOLO 
000040 20 32 20 2E 20 30 20 20 20 40 20 45 20 4E 20 55 2 . 0 M E N U 
000050 00 00 FF 01 00 C4 C4 C4 C4 C4 C4 C4 C4 C4 C4 C4 
0000&0 C4 C4 C4 C4 C4 C4 C4 C4 C4 C4 C4 C4 C4 C4 C4 C4 
000070 C4 C4 C4 C4 C4 C4 C4 C4 C4 C4 C4 C4 C4 C4 C4 C4 
000080 C4 C4 C4 C4 C4 C4 C4 C4 C4 00 00 FF 01 00 42 55 ··BU 
000090 53 49 4E 45 53 53 00 00 FF 02 00 48 &1 72 7& &1 SI NESS· · Harva 
0000A0 72 &4 20 47 72 &1 70 f,8 f,9 f,3 73 20 &2 79 20 53 rd Graphics by S 
0000B0 f,F f,& 74 77 f,1 72 f,5 20 50 75 f,2 &C f,9 73 &8 &9 oftware Puhl ishi 
0000C0 f,E f,7 20 43 f,F 72 70 2E 00 00 FF 02 00 51 75 &1 ng Corp. · · ·Oua 
000000 74 74 72 f,F 20 50 72 f,F 20 o2 79 20 42 f,F 72 &C t tro Pro by Borl 
0000E0 &1 f,E f,4 20 49 &E f,3 2E 00 00 FF 02 00 57 f,F 72 and Inc. War 
0000F0 &4 50 f,5 72 &o &s &3 74 20 f,2 79 20 57 f,F 72 f,4 dPerfect by Word 
000100 50 &5 72 f,f, f,S &3 74 20 43 f,F 72 70 2E 00 43 3A Perfect Corp. · C: 
000110 00 43 44 SC 57 50 35 30 00 77 70 20 25 31 00 00 · CO,WP50 · wp %1 · 
000120 FF 01 00 44 41 54 41 42 41 53 45 00 00 FF 02 00 DATABASE 

IEW ASCII DuMp Ed It ForMat ted Gather Hex Mask Wordwrap 
OMMANDS FZ F3 F4 FS Fb goto hookMark F9 search SPACE search again 

1 J. scroll ALT SHFT Menus F10 cOMMands Fl help ESC cancel 

.J save and exit 

F8undo 

Tab hex/ASCII 

Enables you to save any changes made to 
the file 

Reverts back to the original file, cancel­
ling any changes made since the last save 
operation 

Enables you to toggle between the file in 
hex and ASCII modes 

The Fl help and Esc cancel commands are also available in 
Hex editing mode. 
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D Viewing the Contents of a File 

This example shows how to view the contents of file MYFILE. 
TXT in directory MYD IR. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to directory MYDIR 
and double-click or press the 
Up or Down Arrow until 
MYDIR is highlighted, then 
press Enter 

3. Point to the file MYFILE 
and click or press the Down 
Arrow until MYFILE.TXT is 
highlighted 

4. Press V or select View from 
the File pull-down menu -

5. Press Up or Down Arrow 
to scroll through the entire con­
tents, or click the top or bottom 
of the screen with the mouse 

6. Click cancel or press Esc to 
end the viewing process 

Using View, Autoview And Search 

Response 

The Directory commands are 
now available 

Directory MYDIR has a 
pointer next to it and the File 
commands are displayed 

File MYFILE.TXT is selected 

The contents of file 
MYFILE.TXT are displayed 

Text is scrolled on the screen 

The File commands are now 
active 
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D Searching for Character Strings In a Directory 

This example shows how to search for the text John Smith, which 
may be in any file in directory MYDIR. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to directory MYDIR 
and double-click or press the 
Up or Down Arrow until 
MYDIR is highlighted, then 
press Enter 

3. Press Ctrl +Tor select All 
in window from the Tag pull­
down menu 

4. Press Ctrl + V or select 
View files from the Tagged 
pull-down menu 

5. Press F9 or select Search 
from the Edit pull-down menu 

6. Type John Smith and press 
Enter 

7. Press space or select 
Search again from the Edit 
pull-down menu 
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Response 

The Directory commands are 
now available 

Directory MYDIR has a 
pointer next to it .and the File 
commands are displayed 

All files in directory MYDIR 
will be tagged (selected and 
marked with a diamond) 

The beginning of the first 
tagged file is displayed 

The prompt Search for text: 
is displayed 

The first occurrence of the 
text John Smith is displayed 

The next occurrence of the 
text John Smith is dis­
played, either in the same or 
another file 
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8. Continue selecting Search 
again until you have found the 
location you were searching 
for, then click cancel or 
press Esc 

The File Commands are active 

D Gathering and Appending a Block 

This example shows how to gather a block of text when in View 
mode. You can also gather a block of database records or 
spreadsheet cells using these steps. 

Action 

1. Once in View mode, press G 
or select Gather from the Edit 
pull-down menu 

2. Use the Arrow keys to move 
the highlight cursor to the first 
line of text that you want to 
gather and press Enter or 
click the first line of text you 
want to gather with the left 
mouse button 

3. Use the Arrow keys to move 
the highlight cursor to the last 
line of text that you want to 
gather and press Enter or hold 
down the left mouse button 
and drag across the remaining 
lines of text you want to mark 
for gathering and release the 
left mouse button 

4. Type a filename and press 
Enter or type PRN to send the 
file to your printer 
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Response 

XTreeGold prompts you to 
begin marking text 

XTreeGold highlights the first 
line of text in the block to be 
gathered 

XTreeGold highlights the se­
lected text and prompts for a 
filename in which to save the 
text 

The marked text is appended 
to the ASCII file you indi­
cated, or sent to the printer 
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Viewing Database Files 

When you are viewing a file created in a database format, 
XTreeGold displays it in a view that permits you to easily browse 
database records. When you select the View command, 
XTreeGold first checks to determine if the file you've selected is a 
database file it can view and then displays it accordingly. For ex­
ample: 

lie' C 'DOCUMENT,CLDICT. DBF Record l/21 

LUARNAME CLUARTYPE M204NAME SCREENHEAD P 
DIUISION DIU. CODE Division Code Di 

!STRICT DIST. CODE District Code Di 
RANCHNO BRANCH. NBR Branch NuMber B 
ALES ID SALES. ID Sales ID s 
PERSONNM SALES PER. NAME Sal es person Na Me s 
EFERID REF. ID Referral ID 
EFERNAME REFPER. NAME Referral Person Na Me 
CCOUNTNO CUSTACCT. NUM CustoMer Account NuMber 
USTNAME CUST. NAME CustoMer NaMe 
RODCODE PROD. CODE Product Code 
RODCATCD PRODCAT. CODE Product Category Code 
PENBAL OPENG. BAL Opening Balance 
ALEDATE SALES. DATE Sale Date 

INCPDDATE I NC TU PD. DATE Incentive Paid Date In 
INCTUAMT INCPUTAMT. PD Incentive AMount Paid In 

RCEDEPCD SRCEDEP. CODE Source of Deposit Code s 
ALEORGCD SALEORIG. CODE Sales Origin Code s 
EWCUST NEWC UST. I ND New CustoMer Indicator N 

JEW DBF ASCII DuMp Gather Hex Structure Wordwrap 
OMMANDS FZ go to record F9 search F10 search aga 1 n 

11 scroll Fl help ESC cancel 

At the top of the database View window, XTreeGold displays the 
total number of records in the database file and the number of 
the currently highlighted record. Use the arrow keys or mouse to 
select records in the displayed file. 

At the top of the screen in the prompt line, XTreeGold displays 
structure information about the currently highlighted field. 

In addition to the standard View commands, XTreeGold provides 
special commands for viewing database records. If you choose 
one of the standard View commands to view the database file in 
ASCII, Dump, Hex, or Wordwrap formats, when you want to re­
turn to the database view of the file you must choose the Format­
ted command. 
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When using the Ctrl + View command or the View command from 
the Tagged pull-down menu, the files will not be automatically 
formatted. Use the F7 autoview command available from the 
Window pull-down menu to view a group of database files auto­
matically formatted by XTreeGold. 

Viewing Spreadsheet Files 

When you are viewing a file created in any application that saves 
files in a spreadsheet format XTreeGold recognizes, it displays 
the file in a view that permits you to easily browse it, just as it 
does for database files. When you select the View command, 
XTreeGold first checks to determine if the file you've selected is a 
spreadsheet file with an extension it recognizes and then displays 
it accordingly. For example: 

1 le• C• 'DOCUMENT,CASH. WKS 
11• <FZHoSUM<Bo •• B10J 

CASH FLOW IN 

SALARY 
INTEREST 
TAX REFUND 
SAVINGS ACCOUNT 

TOTAL CASH IN 

CASH FLOW OUT 

MORTGAGE 
FOOD 
CLOTHING 

JANUARY 

3000. 00 
lZS.00 

Wimlml 

1Z00. 00 
'!ZS. 00 
17S. 00 

FEBRUARY 

3000. 00 
lZS. 00 

37ZS. 00 

1Z00. 00 
'IZS.00 
17S.00 

I 

MARCH 

3000. 00 
lZS. 00 

37ZS. 00 

1Z00. 00 
'!ZS. 00 
17S.00 

APRIL 

3000. 00 
lZS.00 

37ZS. 00 

1Z00. 00 
'IZS.00 
17S. 00 

MAY 

'1000. 00 
lZS. 00 

1S00. 00 

SoZS. 00 

1Z00. 00 
'!ZS. 00 
17S. 00 

IEW 123 ASCll DuMp Gather Hex Wordwrap version 1.5 
OMMANDS FZ 90 to eel 1 F9 search F10 search again 

Tl scroll Fl help ESC cancel 

At the top of the spreadsheet View window, XTreeGold displays 
the address of the currently displayed spreadsheet cell. Use the 
arrow keys or mouse to select cells in the spreadsheet. 

At the top of the screen in the prompt line, XTreeGold displays 
the formula used to calculate the entry in the currently high­
lighted cell. 
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In addition to the standard View commands, XTreeGold provides 
special commands for viewing spreadsheets. If you choose one of 
the standard View commands to view the spreadsheet file in 
ASCII, Dump, Hex, or Wordwrap formats, when you want to re­
turn to the spreadsheet view of the file you must choose the For­
matted command. 

When using the Ctrl + View command or the View command from 
the Tagged pull-down menu, the files will not be automatically 
formatted. Use the F7 autoview command available from the 
Window pull-down menu to view a group of spreadsheet files auto­
matically formatted by XTreeGold. 

Follow the steps provided in this section (beginning on page 7 -11) 
to view a spreadsheet or database file, search for a cell or record, 
or gather a block of cells or records. 

D View Database and Spreadsheet Commands 

The View commands that are available when viewing 
spreadsheet or database files vary slightly. The following com­
mands perform different functions. 

Pull-down 
menu item 

D Bookmark 

Go to re­
cord or cell 
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Command 
menu item 

F2 go to 
record or cell 

Purpose 

Lets you go directly to a re­
cord or cell within the dis­
played database 
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D Edit 

Gather Gather Permits you to mark a block of 
database records or 
spreadsheet cells and append 
that block of records to an 
ASCII disk file. XTreeGold 
creates the file if it doesn't 
exist. You can use either the 
keyboard or mouse to mark 
blocks for gathering. 

Search F9 search Lets you search for records or 
the contents of a cell within 
the displayed database file, ig-
noring the case of characters 
when-it searches 

Search space search Searches for the next occur-
again again rence of the record or cell that 

you specified with the Search 
command 

D View 

Structure Structure Displays additional informa-
tion about the structure of the 
database file currently being 
viewed (available only when 
viewing a database file) 
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The Autoview Command 

The Autoview command enables you to look through files in a di­
rectory without first specifying precisely what you are looking for. 
The Autoview command is available: 

V When any Directory or File window is active 

D From the Window pull-down menu 

By clicking Autoview or pressing the hotkey A 

Window 

Split on/off FB 
Video Mode Al t+F9 

Directory files Enter 
Branch files B 
Branch tagged Ctrl+B 
Disk files CShowalll S 
Disk tagged Ctrl+S 
Global G 
Glob al tagged Ctr 1 +G 

File specification ... 
File display coluMns Alt+F 
Sort criteria .. , Alt+S 

D Or, from the Standard directory or Standard file com­
mand menu 

By clicking autoview or pressing F7 

DIR Avail Branch Co11pare Delete Filespec Global Invert Log Make 
COMMANDS Oops! Print Rena11e Showa!! Tag Untag Uolu11e eXecute Quit 
<4--lfiie !iiE:'1!l!i1'!I FB split F9 11enu F10 co1111ands Fl help ? stats 
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The Autoview Window 

The Autoview window is divided into separate areas for display­
ing: 

D Lists of files 

D The contents of selected files 

D Additional autoview commands 

Path' c' 'DOCUMENT WRAP (no Mask) 

AGENDA , BAK 
BONUS • BAK 
CASH • BAK 
CLDICT • BAK 
I NUENTOR. BAK 
LABELS . BAK 
MEMO • BAK 
MEMOl . BAK 
MEMOZ • BAK 
MEM03 • BAK 
NETWORTH. BAK 
SCHEDULE. BAK 
DOC • BAT 
XTG MENU.BIN 
CLDICT • DBF 
COMMLOAN. DBF 
AGENDA • DOC 
LABELS • DOC 
MEMO • DOC 

TO: Robert Jones 
Uery Best Products Corporation 

FROM' EMil~ SMith 

DATE' Januar~ 24, 1991 

RE: Reproduction Options 

Bob, based on the new paper specifications you faxed 
us on Friday, 
and the revised page counts of both books. we can 
now provide a 
final quote to you to reproduce, collate and shrink 
wrap the 
Materials. At Dean ThoMas·s request. we are providing 
two options 
to you. 

UTOUIEW Tag Untag Uiew (zooM in) 
OMMANDS 

F10 coMMands Fl help ESC cancel 

When you choose the Autoview command, the Autoview window 
is displayed. The first file in the current directory is highlighted 
in the list on the left of the screen and the first lines of the file 
contents are displayed on the right of the screen. 

You'll use the Arrow keys or mouse to select files on the left side 
of the window for viewing. As you select a file, it is displayed on 
the right. You can scroll the contents in the right window by ei­
ther: 

D Holding down the shift key and press the Arrow keys 

D Clicking the top or bottom of the contents side with the mouse 
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D Additional Autoview Commands 

XTreeGold displays additional commands that can be used with 
the autoview window. Here are the commands and their purpose, 
organized by pull-down menu headers. 

Pull-down 
menu item 

0 XTree 

Help 

Quit au-
to view 

0 Tagged 

View 

Search 

0 Tag 

File 

All in 
window 
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Command 
menu item 

Fl help 

F7 cancel 

Ctrl +View 

Ctrl + Search 

Tag 

Ctrl +Tag 

Purpose 

Displays a context sensitive 
help screen 

Closes the autoview window 
and returns you to the stan­
dard XTreeGold display 

Displays all the tagged files in 
the Autoview window 

Searches all tagged files in the 
Autoview window for a speci-
fied text string 

Tags the currently selected 
file in the Autoview display 

Tags all the files listed in the 
Autoview window 
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All by Alt+ Tag Tags all the files on the cur-
attributes rent disk that have certain at-

tribute settings 

(untag) Untag Removes the tag from a se-
File lected file in the Autoview dis-

play 

(untag) All Ctrl + Untag Removes the tags from all 
in window tagged files in the Autoview 

window 

(untag) All Alt+ Untag Removes the tags from all the 
by attri- files on the current disk that 
butes have certain information set-

tings 

0 View 

ASCII Shift + ASCII Displays the file's contents in 
a normal character display 

Dump Shift+ Dump Shows all displayable charac-
ters in the file without line for-
matting. The file's location is 
displayed in hexadecimal char-
acters on the left of the dis-
play. 

Hex Shift+ Hex Displays the file's contents in 
hexadecimal format where 
you can view the binary value 
of each byte in the file. You 
can also edit files in Hex view 
if the program is configured to 
support hex editing. (See the 
Hex editing section on page 7-
10.) 
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Wordwrap 

Mask 

Zoom in 

Shift+ 
Wordwrap 

Shift+ Mask 

View 

Displays text in an SO-column 
ASCII display, which is partic­
ular useful for viewing files 
created with a word processor. 
In Wordwrap view, XTreeGold 
only shows displayable charac­
ters and automatically breaks 
lines of text at spaces between 
words. 

Masks the eighth bit. Some 
text programs use the eighth 
(or high) bit of each byte to 
hold special information. Be­
cause of this, the text may be 
displayed with odd characters 
and symbols in place of the ex­
pected alphanumeric text. 
The Mask command turns off 
the high bit for viewing. 

Displays a selected file in the 
standard View display. When 
you leave the View display se­
lected from here, you will re­
turn to the Autoview display 

When you select the View command from the Autoview window, 
all the additional View commands become available. These addi­
tional. View commands let you change the format of the displayed 
file and enable you to search it easily. Refer to the previous sec­
tion, Additional View Commands, for information on these addi­
tional commands and their capabilities. 
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D Browsing Through Files In a Directory 

To browse through the files in the current directory and then 
zoom in on a file, follow these steps with either the Directory or 
any File window active. 

Action 

1. Press F7 or select Autoview 
from the Window pull-down 
menu 

2. Point to a file on the left side 
of the window and click or use 
the Up or Down Arrow or 
mouse to select a file (it is not 
necessary to press Enter) 

3. Use the Up or Down 
Arrow or mouse to select an­
other file 

4. Press V or click View zoom in 

5. Use the Up or Down 
Arrow or click the top or bot­
tom of the screen with the 
mouse to scroll the file contents 
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Response 

The Autoview window is dis­
played for the current direc­
tory 

The first page of the file is 
displayed on the right side 

The first page of the next 
file is displayed 

The contents of the file and 
the additional View com­
mands are displayed 

The entire contents of the file 
can be viewed 
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The Search Command 

The Search command searches all tagged files for a specific text 
string, highlights each file as it searches for the string and re­
moves the tag from any file that does not contain the string. 

The Search command is available: 

V When any file window is active 

D From the Tagged pull-down menu 

By clicking Search or pressing the hotkey S 

Tagged 

Attributes ••• 
Batch ... 
Copy files ... 
Copy with paths .•. 
Delete ... 
Move files ... 
Move with paths ... 
New date .•• 
Print ..• 
RenaMe ... 

Uiew 
Zip and Arc •• , 

Ctrl+A 
Ctrl+B 
Ctrl +C 

Al t+C 
Ctrl+D 
Ctrl+M 

Al t+M 
Ctrl+N 
Ctrl+P 
Ctrl +R 

Ctrl +U 
Ctrl+FS 

D Or, from the Ctrl file command menu 

By clicking COMMANDS and then clicking Search or 
pressing Ctrl + S 

CTRL FILE Atfributes Batch Copy Delete Invert Log disk Move New date 
COMMANDS Print RenaMe i!ml!31!1i! Tag Untag Uiew 

FS arch i ue files F6 Mel"ge tags FB par ti a I untag 

D It is also available when the Autoview window is active (see 
the discussion on page 7-20). 
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When you choose the Search command, XTreeGold prompts for a 
specified text string. You can either: 

D Enter a text string by typing one at the prompt 

D Enter a text string and specify a wild card asterisk (*) in the 
target search string (and the * can be specified more than 
once, allowing you to perform searches, when you're not sure 
exactly what you are looking for). For example you could 
search for the string XTree* if you were looking for all occur­
rences of the text string XTreeGold, but couldn't quite remem­
ber the product name. 

D Select an item from the history file (press Up Arrow or click 
history) 

The Search command is not case sensitive. It searches all tagged 
files for a specific text string, highlights each file as it searches 
for the string and removes the tag from any file that does not con­
tain the string. At the end of the search process, only those files 
that contain the specified string remain tagged. 
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0 Searching for Text in Files 

This example shows how to search for the text John Smith, which 
may be in any file in directory MYDIR, by using the Search com­
mand when the File window is active. 

Action 

1. If the words DIR COMMANDS 

are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to directory MYDIR 
and double-click or press the 
Up or Down Arrow until the 
highlight bar is on directory 
MYDIR, then press Enter 

3. Press Ctrl + T or select 
All in window from the Tag 
pull-down menu 

4. Press Ctrl + S or select 
Search from the Tagged 
pull-down menu 

5. Type John Smith and press 
Enter or click ok 

6. If you wish to view the first 
file, press Ctrl + V or select 
View from the Tagged pull­
down menu. 
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Response 

The Directory commands are 
now available 

Directory MYDIR has a 
pointer next to it and the File 
commands are displayed 

All files in directory MYDIR 
are selected 

The prompt Search all 
tagged files for text: is 
displayed 

The files are searched. All the 
files that contain the search 
string are still tagged. All the 
files that do not contain the 
search string are untagged. 

The contents of the first file 
are displayed in the View win­
dow and the first occur­
rence of the text John 
Smith is displayed 
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7. Select search again 

8. Continue selecting search 
again until you have found the 
location you were searching 
for, then press Esc or click 
cancel 

9. Press Ctrl + U or select 
(untag) All in window from 
the Tag pull-down menu 

Using View, Autoview And Search 

The next occurrence of the 
text John Smith is displayed 

The File Commands are active 

No files are now tagged 
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Summary 

This chapter described how you can use the View, Autoview and 
Search commands to: 

D Display the contents of selected files in their native format 

D Browse through files in a directory in rapid succession 

D Zoom in on the contents of files more closely 

D Look through files for a specific character string 

D Look through one or more directories for a specific character 
string 

These commands are especially convenient time savers when you 
need to look up something in a file, or search for something. As 
you gain some experience with these commands, you'll find them 
extremely useful on a day to day basis. Until that time, use this 
chapter as an ongoing reference. Refer back to individual sections 
when you need directions for a task or additional directions to 
complete a procedure, until you can work from screen menus and 
prompts. 
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Running Applications and 
Executing Commands 

Among XTreeGold's capabilities that go far beyond the routine 
tasks of managing files and organizing directories are several ca­
pabilities that make it easier for you to run applications and exe­
cute DOS commands. You can: 

0 Create and modify a customized Application Menu to include 
applications and DOS commands that you use often 

0 Run a program or DOS command from an existing Applica­
tion Menu 

0 Use the Open command to start an executable program and 
load a selected data file 

0 Use the Command shell to run applications and execute DOS 
commands 

0 Easily create batch files to perform custom operations on 
tagged files 
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The Application Menu 

XTreeGold lets you create a custom menu that you can use to 
start applications or perform other types of operations without ex­
iting XTreeGold. An Application Menu can list an unlimited num­
ber of selections, each of which can be associated with up to 17 
lines of DOS batch file commands. When you installed 
XTreeGold, you were given the option of creating a customized 
menu to include all the applications on your hard disk. At any 
time, you can add new items manually after you install new appli­
cations on your hard disk. The Application Menu is available: 

V When any Directory or File window is active 

D From the XTree pull-down menu 

By clicking Application Menu or pressing the hotkey A 

D Or, from the Standard directory or Standard file com­
mand menu 

By clicking menu or pressing F9 

DIR Auail Branch CoMpare Delete Fi lespec Global Jnuert Log Make 
COMMANDS Oops! Print RenaMe Shouall Tag Untag UoluMe eXecute Quit 
.___Jfile F7 autouieu F8 split ~ F10 COMMands Fl help ? stats 
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This sample Application Menu contains a menu tree. First level 
menu items are logically named for the items found under them. 
Items that start applications are then grouped by categories 
below. 

ree Edit Options XTreeMenu 2-02-91 3, 55, 22 PM 

XTREEGOLD 2.0 MENU 

= BUSINESS 

Barvard Graphics by Software Puhl ishing Corp. 
Quattro Pro by Borland Inc. 

ordPerfect by WordPerfect Corp. 
1-2-3 by Lotus DevelopMent Corp. 

= DATABASE 
L-ciBASE JU by Ashton-Tate 

= DISKGRAF FOR XTREEGOLD 2. 0 
= ENTERTAINMENT 

L-f-19 by Microprose 
= NETWORK 

t=~:~~~r~M~ ~!in 
==rnrNDOWS PROGRAMS 

When the Application Menu is displayed, shortcut keys are listed 
at the bottom of the screen. Pull-down menus provide access to 
the additional Application Menu commands which are generally 
used for maintenance of the menu. They are not needed when se­
lecting items. Press FlO or point and click with the mouse to use 
the pull-down menus. 

From XTreeGold you can: 

D Create an Application Menu for use by yourself or others 

D Select an item from an existing Application Menu 

D Modify an Application Menu 

D Prevent modifications of an Application Menu you've created 
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Using the Menu 

You can easily select items from the menu and customize the dis­
play of the menu tree once it has been created. 

Selecting Items From the Menu 

To select items from the Application Menu, with any window ac­
tive press the F9 key or click menu or select Application Menu 
from the XTree pull-down menu to first display the Menu. Then 
select the item of you choice by using the Arrow keys to highlight 
your selection and pressing Enter or highlighting and double­
clicking the item with the mouse. 

The Menu Tree Outline 

Just as you can expand and collapse the directory tree, you can ex­
pand and collapse the menu tree to customize the display of the 
Application Menu. This feature allows you to display the seg­
ments of the menu tree you use most often while still including 
on the menu all the items you'd like. You can also toggle the 
graphics feature of the menu to suit your preference. 

By organizing the menu tree into several or many different levels 
you can create a menu that is comprehensive in its inclusion of ap­
plications and custom batch files. But those items need not be dis­
played on an ongoing basis because the menu can be collapsed to 
show only the branches you use regularly or any combination of 
items and levels that best meets your. needs. 

In the menu tree: 

0 A + (plus sign) next to an item indicates that additional menu 
items can be found below that item although they are not cur­
rently displayed. 

0 A blank space to the left of an item indicates that no addi­
tional items exist beneath that item. That branch of the 
menu tree is fully expanded. 
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To expand a menu tree: 

D Use the +(plus) key to expand the display one level below the 
level of the currently highlighted item 

D Point to the + (plus) sign and double-click to expand the dis­
play one level below the level of the currently highlighted item 

D Use the* (asterisk) key to expand the display of the branch 

D Select Expand all from the Options pull-down menu 

D Highlight an item and select either Expand 1 level or Ex­
pand branch from the Options pull-down menu 

To collapse a menu tree: 

D Use the - (minus) key to collapse the display of the entire 
branch below the currently highlighted item 

D Point to the space next to an item and double-click the left 
button 

D Highlight an item and select Collapse branch from the Op­
tions pull-down menu 

The Graphics Toggle 

On the Options pull-down menu you'll also find the Graphics 
toggle command. This command enables you to turn off the dis­
play of the tree which connects all the menu items while leaving 
the menu intact. 
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D Expanding and Collapsing the Menu Tree 

To expand or collapse the menu tree, highlight the desired item 
and use these options. 

Key 

+(plus) 

- (minus) 

Mouse Action 

Double-click 
the+ (plus 
sign) 

Double-click 
the blank 
space 

Purpose 

Expands the menu tree dis­
play one level 

Collapses the branch on the 
menu tree 

Creating and Modifying the Application Menu 

Both creating and modifying an Application Menu are accom­
plished through the use of the Application Menu editor com­
mands. To create a menu, you'll display the menu which is 
created when you installed XTreeGold and add items to the 
menu. Of course, if you used the automatic install process, you'll 
no longer have a blank menu, but one which contains the applica­
tions on your hard disk. To modify the menu, you'll display the 
existing menu and add, delete or modify items. 

When the Application Menu is displayed, XTreeGold displays ad­
ditional commands for editing and organizing this menu on its 
pull-down menus. Once you select the Edit script option to edit 
an associated script, additional editing commands are displayed 
on another set of pull-down menus and on the command menu dis­
played at the bottom of the screen. 

In general, menu item command lines follow the same syntax as 
DOS batch commands. To add a new item to the menu, select the 
Add item command from the Edit pull-down menu. To write or 
edit a script for the item highlight the item and select the Edit 
script command from the Edit pull-down menu to display addi­
tional editing commands. Or point to an item with the mouse 
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and double-click the right mouse button to immediately enter edit­
ing mode. 

Most of the time, you can use the mouse or Arrow keys to select 
the command line that you want to edit (add to, modify or delete), 
than choose a command to perform an operation on that line. 
Press Enter to edit that line. Click cancel or press Esc to leave 
the edit mode. 

You'll use the Move item command on the Edit pull-down menu 
in conjunction with the Arrow keys to locate an item as a subor­
dinate of another item in order to organize the menu outline. 
(See the example on page 8-13.) 

D Application Menu Commands 

These Application Menu commands are available on pull-down 
menus. 

o XTree 

Help Displays relevant help screens 

DOS commands Displays a prompt that allows you to 
enter a DOS command to execute, as you 
would from the Command shell 

Exit to DOS 

Quit to Gold 

Exits XTreeGold and displays the DOS 
prompt 

Cancels the display of the Application 
Menu, and returns to XTreeGold's Main 
Display 
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D Edit 

Undo changes 

Add item 

Delete item 

Edit script 

Move item 

Renameitem 

o Options 

Graphics toggle 

Expand 1 level 

8-8 

Reverses all editing operations you per­
formed since you invoked Edit item 

Creates an empty line on the currently se­
lected line, moves down the existing lines 
and prompts for the name of the new item 

Removes the contents of the selected line 
from the menu and all of its subordinate 
items in the outline. XTreeGold prompts 
you to confirm the Delete command before 
removing the line. 

XTreeGold goes into Editing mode, where 
you can modify existing items by modify­
ing lines in the script. Additional com­
mands are then displayed on the 
pull-down menus. 

Initiates a two-step operation for moving 
menu items. First, select a line and choose 
the Move command; then select the loca­
tion where you want to relocate the line 
and press Enter. 

Lets you modify the name of the item that 
you are editing. When you choose the Re­
name item command, XTreeGold displays 
the prompt at the current item. Edit the 
name and press Enter or click ok to ac­
cept the new name. 

Toggles the display of the menu tree 

Expands the menu display to show the 
next level of items in the menu outline 
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Expand branch Expands the menu display from the cur­
rently highlighted item to show all the 
items in that branch of the menu 

Expand all Expands the menu display to show all the 
items on the menu 

Collapse branch Collapses the menu display to hide all the 
items beneath the currently highlighted 
item 

0 Application Menu Editing Commands 

The following commands are displayed in editing mode. They are 
organized in the chart according to pull-down menu headers. 

Pull-down 
menu item 

0 ><Tree 

Help 

Quit edit 

0 Edit 

Undo 
changes 

Copy to 
scrap 

Command 
menu item 

Fl 

Esc 

Undo 

cOpy to scrap 

Purpose 

Displays relevant help screens 

Exits editing mode and dis­
plays the Application Menu 

Reverses all modifications 

Deletes a line but saves it for 
subsequent insertion at an­
other location 
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Paste to Paste to scrap Allows you to insert a line pre-
scrap viously deleted with the Copy 

to scrap command 

Copy line Copy Copies the contents of a se-
lected line. Select a line first 
then choose Copy. XTreeGold 
opens a new line beneath the 
current line and copies the 
contents of the current line 
into the new line. 

Delete line Delete Removes the contents of the 
selected line from the script. 
XTreeGold prompts you to con-
firm the Delete command be-
fore removing the line. 

Edit line Edit Places the prompt at the line 
you want to edit. To continue 
editing, use the Down Arrow 
to move to the next line and re-
main in editing mode 

Insert line Insert Creates an empty line on the 
currently selected line, moves 
down the existing lines be-
neath it and places the 
prompt at the line. 

Move line Move Initiates a two-step operation 
for moving menu items. First, 
select a line and choose the 
Move command; then use the 
Arrow keys to select the loca-
tion where you want to relo-
cate the line and press Enter. 
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D Item 

Rename 
item 

Next menu 
item 

Previous 
menu item 

Rename 

Tab 

Backtab 

Changes the name as it ap­
pears in the Application Menu 

Displays the contents of the 
next menu item, in editing 
mode 

Displays the contents of the 
previous menu item, in editing 
mode 

Batch File Parameters 

When you're entering command lines for an item that will appear 
in the Application Menu, you can use one of the parameters listed 
below to provide the command lines with necessary information. 
When XTreeGold executes a script chosen from the Application 
Menu, it automatically fills in the required information specified 
by the variable. 

%1 

%2 

%3 

%4 

%5 

Inserts the full path specification of the 
currently highlighted directory and/or file 

Inserts the current ID of the currently 
highlighted directory and/or file 

Inserts the current path of the currently 
highlighted directory and/or file 

Inserts the file name of the currently high­
lighted file 

Inserts the file extension of the currently 
highlighted file 
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Here is an example of ~ow you would use these parameters. 

D To write a script that would start the program WordPerfect 
and open the currently highlighted file at the same time, in­
sert the appropriate parameter in the item script. 

C: 

CD\WP51 

WP.EXE %1 

D Then, if the file MYFILE.DOC is the currently selected file 
when you choose Start WordPerfect and load document 
from the Application Menu, it would be loaded into Word­
Perfect and displayed on the screen. 

ANY MENU GROUP 

L_Start Any Word Processing Program 

L Start WordPerfect and load document 

Preventing Modifications 

When designing an Application Menu for use by others, 
XTreeGold can be configured so that the menu can or cannot be 
modified. Refer to Chapter 10 for details. 
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0 Creating and Modifying a Menu 

1 In this example, you'll add a new item to the Application Menu to 
start WordPerfect (or your own word processing program) and 
open the currently highlighted file. You'll locate it as a subordi­
nate item under the menu item that starts your word processing 
program. Make appropriate substitutions to write a script that 
starts another program of your choice. You may begin from any 
active window. 

Action 

1. Press F9 or click menu 

2. Point to the menu item that 
starts your word processing 
program and click or use the 

1 Up or Down Arrow to place 
the highlight bar on it 

3. Select Add item from the 
Edit pull-down menu 

4. Type in the name for the 
item, for example Start Word­
Perfect and load document 
and press Enter 

5. Select Move item from the 
Edit pull-down menu 

6. Press the Down Arrow to 
move the new item down below 
the current WordPerfect item, 
then the Right Arrow to 
make it a subordinate item of 
that item, and then press 
Enter 

Response 

The Application Menu is dis­
played 

The item is highlighted 

The cursor is displayed at a 
new line above the currently 
highlighted one 

The name of the item is dis­
played in the menu 

The prompt Arrows move 
the item tree is displayed 

The new item is positioned as 
a third level item within the 
menu tree 
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7. Select Edit script from the 
Edit pull-down menu 

8. Select Edit line from the 
Edit pull-down menu or just 
press Enter 

9. Type C: and press Down 
Arrow to move the cursor to 
line 02, then type CD\ WP51 
and press Down Arrow and 
then type WP.EXE %1 and 
press Down Arrow 

10. Press Esc to exit the Edit­
ing mode 

11. Highlight the item with the 
mouse and double-click, or 
highlight with the Arrow keys 
and press Enter 

Line 01 is highlighted and ad­
ditional editing commands are 
available 

The cursor is on line 01 

The contents of the script are 
displayed as you type them 

The new item is displayed on 
the Menu 

The item is executed 
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Launching Applications 

XTreeGold provides a command that lets you launch an applica­
tion by opening a file in its associated application without first 
having to start the application. The command for launching appli­
cations is called the Open command. Two forms of this command 
are available: a quick version and an Open command that maxi­
mizes available memory for the application you select. The com­
mands work in a similar manner, except that the (Alt) Open (all 
memory) command shrinks the size ofXTreeGold, freeing mem­
ory needed to run large applications. The Open command is avail­
able: 

v' When any File window is active 

D From the File pull-down menu 

By clicking Open (quick) or pressing the hotkey 0 

D Or, from the Standard file command menu 

By clicking Open or pressing 0 

FILE Attributes Cop<J Delete Edit Filespec Invert Log disk Move 
COMMANDS New date m Print Rem>Me Tag Untag Uiew eXecute Quit 
.___i tree F7 autoview F8 split F9 11enu F10 co1111ands F1 help ESC cancel 
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The Open command that shrinks XTreeGold's size in memory is 
also available: 

ti When any File window is active 

D From the File pull-down menu 

By clicking Open (all memory) or pressing the hotkey I 

D Or, from the Alt file command menu 

By double-clicking COMMANDS and then clicking Open 
or pressing Alt + 0 

When selected, it always acts on the current file. When you se­
lect either Open command for a current file that contains a .BAT, 
.EXE, or .COM extension, XTreeGold executes the program. If a 
file is not executable, XTreeGold searches for an associated batch 
file with a name that is identical to the extension of the file you 
are attempting to open. 

This is how it works: 

D Instead of starting your spreadsheet program and then select­
ing the spreadsheet file you want to load, you can select the 
spreadsheet file while in XTreeGold, and your spreadsheet 
program will be started with the file loaded automatically. 

D If you attempt to open a spreadsheet file named 
TAXES.WKS, XTreeGold searches for a file named WKS.BAT 
and runs that batch file. IfXTreeGold can't find an associated 
batch file, the Open command is ignored. 

Remember that a large application may run out of memory when 
started with the Open command. If this happens, select the Open 
all memory (Alt+Open) command instead. Alt Open shrinks the 
size ofXTreeGold, freeing additional memory for running the ap­
plication. 

If you are planning to use the Open command, you must first cre­
ate some batch files that will start applications. 
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Creating Batch Files To Start Applications 

You can use either XTreeGold's Edit command and lWord or any 
other text editor to create a batch program that will enable you to 
use the Open command. For each application you want to start 
using the Open command, you'll create a batch file whose name is 
the same as the extension on the files you create, and save the 
batch files in the XTGOLD directory. For example, to create a 
batch file that will enable you to open: 

D Spreadsheet files, which have the extension .WKl, create a 
batch file called WKl.BAT 

D Word processing files, which have the extension .DOC, create 
a batch file called DOC.BAT 

D Database files, which have the extension .DBF, create a batch 
file called DEF.BAT 

The batch file should contain a command to start the program as 
well as a variable that passes the selected file's name to the com­
mand so that the application will open the file. A batch file can 
include the parameters listed below to provide the batch file with 
variable values that depend on current directory and file selec­
tions: 

%1 Inserts the full path specification 

%2 Inserts the current ID 

%3 Inserts the current path 

%4 Inserts the file name 

%5 Inserts the file extension 
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Here is an example of how to use these parameters: 

D Open a WordPerfect document with a .DOC extension by 
using the XTreeGold Edit command to create a batch file 
called DOC.BAT. This batch file would contain a command to 
start WordPerfect as well as a variable that passes these­
lected file name to the command so that the application will 
open the file. 

D First, create a batch file in the XTGOLD directory called 
DOC.BAT that contains the following line: 

C: 

CD\WP51 

WP.EXE %1 

Where %1 is the parameter that inserts the full path specifica­
tion of the file you highlight in XTreeGold. (The one you wish 
to open.) 

D When you select a WordPerfect document that has the .DOC 
extension such as MYFILE.DOC and choose the Open com­
mand, XTreeGold finds the associated batch file and executes 
it, substituting the full path specification and filename MYF­
ILE.DOC for the variable so that WordPerfect opens these­
lected document upon start up. 

Follow the steps on the next page to create the sample batch file. 
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D Creating a Batch File to Use the Open Command 

Follow these steps to create the sample batch file described to 
open WordPerfect documents with the extension .DOC in Word­
Perfect. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the XTGOLD direc­
tory and click or use the Up or 
Down Arrow to place the 
highlight bar on the XTGOLD 
directory 

3. Press E or select Edit file 
from the File pull-down menu 

4. Type the name of the file, 
DOC.BAT and press Enter 

5. Type C: and press Enter 
then type CD\WP51 and press 
Enter then type WP.EXE %1 
and press Enter (the path, the 
start up command, and the pa­
rameter) 

6. Press Esc to quit lWord 

Response 

The Directory commands are 
now available 

The XTGOLD directory is se­
lected 

The prompt EDIT file: is dis­
played 

The !Word text editor is dis­
played and the path and file 
name are displayed in the 
upper left of the screen 

You have created a file con­
taining the path for the appli­
cation Wordperfect and the 
command to start it, followed 
by the parameter to insert a 
selected file when you open it 

The Quit commands are dis­
played 
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7. Highlight Save file and 
quit and press Enter 

D Opening a File 

The batch file DOC.BAT is 
saved and in the XTGOLD di­
rectory, to be used when you 
select the Open command 

To open a file that has an associated batch file, follow these steps. 
In this example, you'll open a WordPerfect file named MYF­
ILE.DOC in directory WP51 using the batch file you just created. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the WP51 directory 
and double-click or use the Up 
or Down Arrow to place the 
highlight bar on the WP51 di­
rectory and press Enter 

3. Point to the file 
MYFILE.DOC and click or use 
the Up or Down Arrow to 
place the highlight bar on 
MYFILE.DOC 

4. Press Alt + 0 or select 
Open (all memory) from the 
File pull-down menu 

Response 

The Directory window is active 

The File window is displayed 
for directory WP51 

The highlight bar is on the file 
MYFILE.DOC which can be 
Opened in WordPerfect be­
cause you've previously cre­
ated an associated batch file 
(DOC.BAT) for it 

The file you selected is opened 
in its associated application 
(WordPerfect) 
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The Command Shell 

The Command shell provides a place for you to execute programs 
or DOS commands without leaving XTreeGold. 

-..,,"llF-li-:r:I• 9i:Ji:•--=--=i..-.~ • • •" -- - 1 •• • I • • 

I I I 

The Command shell also provides useful statistical information, 
displaying the: 

0 System day, date and time in hours, minutes and seconds 

0 Amount of memory (in bytes) available to application pro­
grams 

0 Amount of space (in bytes) available on the current volume 

0 Current volume and directory path as part of the Command 
shell prompt 

You can access the Command shell by using the Execute com­
mand. Two forms of this command are available (as with the 
Open command): a quick version and an Execute command that 
maximizes available memory for the command you enter. The 
commands work in a similar manner, except that the Alt+ Exe­
cute command (all memory) shrinks the size ofXTreeGold, free­
ing memory needed to run large applications. 
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The Execute commands are available: 

V When any File window is active 

0 From the XTree pull-down menu 

By clicking Execute (quick) or pressing the hotkey x or 
by clicking Execute (all memory) or pressing the 
hotkeyE 

0 Or, from the Standard directory or Standard file com­
mand menu 

By clicking eXecute or pressing X 

DIR Avai I Branch Co11pare Delete F1 lespec Global Invert Log Make 
COMMANDS Oops• Print Rena11e Showa!! Tag Untag Uolu11e ~ Quit 
--1 file F7 autoview F8 split F9 11enu F10 co1111ands Fi help ? stats 

0 Or, from the Alt directory or Alt file command menu 

By double-clicking COMMANDS and then clicking 
execute or pressing Alt + x 

When the File window is active, the Execute command defaults to 
and displays the currently selected file if the file is an executable 
file. You may also enter commands. When the Directory is active, 
the Execute command defaults to and displays the currently se­
lected directory and enables you to conveniently enter commands. 
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When you select the Execute command, the Command shell is dis­
played with a blinking cursor waiting for a command input. The 
keys available for entering items in the Command shell are identi­
cal to those you use when responding to prompts. Mouse options 
are only available for the Command history. You can either: 

0 Type a DOS command or the identical command to run an ap­
plication program (up to 127 characters) in the Command 
shell just as you would at the standard DOS prompt. 

0 Select an item from the history file (press Up Arrow or click 
history) 

0 Accept the file shown 

I@" Note: If you selected the Execute command with the file win­
dow active, the current file when you select the Execute com­
mand will be displayed in the Command shell automatically 
ifit has a .BAT, .EXE or .COM extension. This shortcut elimi­
nates the need for you to type the name of the application pro­
gram before running it. 

Then confirm the input by pressing Enter. 

The amount of memory XTreeGold occupies depends on the total 
number of directories and files that are logged. Since XTreeGold 
remains in memory when you execute commands from the Com­
mand shell and maintains all information intact, less memory is 
available for program operation and command execution. So, the 
Alt+ Execute (all memory) command provides the maximum free 
memory space to the command or application you specify. 

If there is insufficient memory to perform an operation when you 
select the Execute command, return to XTreeGold and either: 

0 Release any volumes which are not currently needed, then se­
lect the Execute command again. 

0 Use the Execute (all memory) command instead. Remember, 
when you do, XTreeGold remains in memory but temporarily 
releases all logged volumes and reduces itself to 7K in size to 
free memory for running programs. 
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After you leave the Command shell, XTreeGold displays the cur­
rent volume and directory information and places the highlight 
bar on the current directory. If you have not added, removed, or 
changed any files or directories on the logged volumes while work­
ing from the Command shell, XTreeGold will perform normally. 
However, if any changes were made to logged volumes, 
XTreeGold may report errors while performing its operations. If 
XTreeGold displays a warning that the volume has been changed, 
use the Log command again to relog the volume. 

D Executing Commands from the Command Shell 

To execute the DOS command CHKDSK when the Directory or 
any File window is active, follow these steps. 

Action 

1. Press X or select either 
Execute command from the 
XTree pull-down menu. 

2. Type the command you wish 
to execute, CHKDSK, and 
press Enter 

Response 

The Command shell is dis­
played 

The CHKDSK command is ex­
ecuted 
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0 Running Applications from the Command Shell 

To quickly run an application program from the File window, fol­
low these steps. In this example, we'll run the program SAMPLE 
by selecting the file SAMPLE.EXE from the SAMPLE directory. 

Action 

1. If the words DIR COMMANDS 

are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to the SAMPLE direc­
tory and double-click or use the 
Up or Down Arrows to place 
the highlight bar on directory 
SAMPLE and press Enter 

3. Point to the application pro­
gram you want to run, 
SAMPLE.EXE in the list of 
files and click or use the Up or 
Down Arrow to highlight 
SAMPLE.EXE 

4. Press Alt+ X or select 
Execute (all memory) from 
the XTree pull-down menu 

5. Press Enter or click ok 

Response 

The Directory commands are 
now available 

The File window is displayed 
for directory SAMPLE 

The highlight bar is on the file 
SAMPLE.EXE 

The Command shell is dis­
played, and the file you se­
lected, SAMPLE.EXE is 
displayed at the prompt 

The application program runs, 
and XTreeGold shrinks in size 
to 7K 
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Creating Batch Files 

The Batch command is especially useful for quickly creating 
batch files to perform operations on tagged files. Once you've cre­
ated a file with this command, you can use a text editor to modify 
the file to fit any special needs. After you create a batch file with 
Batch, you can perform the batch commands by selecting the file 
and choosing either the Open command or the Execute command. 
It is available: 

V' When any File window is active 

D From the Tagged pull-down menu 

By clicking Batch or pressing the hotkey B 

Tagged 

Attributes... Ctrl+A 

COpLJ files... Ctrl+C 
CopLJ with paths... Alt+C 
Delete... Ctrl+D 
Move files... Ctrl+M 
Move with paths... Alt+M 
New date... Ctrl+N 
Print... Ctrl+P 
RenaMe... Ctrl+R 
Search... Ctrl+S 
View Ctd+V 
Zip and Arc... Ctrl+FS 

D Or, from the Ctrl file command menu 

By clicking COMMANDS and then Batch or pressing 
Ctrl + T 

CTRL FILE Attributes !mll Copy Delete Invert Log disk Moue Hew date 
COMMANDS Print RenaMe Search Tag Untag Uiew 

FS archive files Fo Merge tags F8 partial untag 
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The Batch command lets you create a batch file that contains a 
command line for each tagged file. When you choose it, 
XTreeGold allows you to create a line mask which is a template 
that generates a DOS command line for each tagged file. You can 
also use the line mask to supply parameters about tagged files. 

To create the file, first tag the files you'll be acting upon and then 
choose the Batch command. Then enter a path and filename at 
the prompt. (If you don't specify a path in the filename, 
XTreeGold places the batch file in the current directory). After 
you press Enter or click ok, XTreeGold prompts you for a line 
mask. At the line mask prompt, either: 

0 Type the DOS command you wish to perform on each tagged 
file, supplying parameters from the table to provide addi­
tional information about the file 

0 Or select an item from the history file (press Up Arrow or 
click history) 

You can enter up to 127 characters at the line mask prompt. 
When you confirm, XTreeGold creates the batch file. 

%1 Inserts the full path specification 

%2 Inserts the current ID 

%3 Inserts the current path 

%4 Inserts the file name 

%5 Inserts the file extension 

%6 Inserts the parent subdirectory name 
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Some examples of batch files that would use these parameters 
are: 

0 If you want to create a batch file that appends the contents of 
the tagged files to a single file called CHAPTERl, enter the 
following at the line mask prompt: 

TYPE %1>>CHAPTER1 

0 The two greater than symbols(>>) tell DOS to append the 
contents of each tagged file's output to the CHAPTERl file in­
stead ofrewriting the designated file each time the TYPE 
command redirects output to the file. 

0 If there were a series of tagged files such as PARTlA.TXT, 
PART2A.TXT, PART3A.TXT, an so on, when you created the 
batch file with the Ctrl Batch command, the resulting batch 
file would look like this: 

TYPE C:\BOOK\PARTlA.TXT>>CHAPTERl 

TYPE C:\BOOK\PARTlB.TXT>>CHAPTERl 

TYPE C:\BOOK\PARTlC.TXT>>CHAPTERl 

TYPE C:\BOOK\PARTlD.TXT>>CHAPTERl 

TYPE C:\BOOK\PARTlE.TXT>>CHAPTERl 

TYPE C:\BOOK\PARTlF.TXT>>CHAPTERl 

TYPE C:\BOOK\PARTlG.TXT>>CHAPTERl 

TYPE C:\BOOK\PARTlH.TXT>>CHAPTERl 

0 When you execute this batch file (using the Execute com­
mand), it will combine all the small text files into one larger 
file in a few seconds. 
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D You can create multiple DOS command lines for each tagged 
file by inserting two exclamation points(!!) between entries at 
the line mask prompt. For example: 

TYPE %1 ! ! DIR.%5 

D At the Batch file name prompt, place double exclamation 
marks in the batch file name. Everything to the right of them 
is used for the line mask. You can then retrieve a file name 
and line mask from the input history with one selection. En­
tering: 

C:\FILELIST.TXT ! ! %1 

for the Batch file name will create a file in the root directory 
on drive C: named FILELIST.TXT. Each line in the file will 
contain the full DRIVE:\PATH\NAME.EXTofone of the 
tagged files from the file display. 
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D Creating a Batch File 

Follow these steps to create the sample batch file to append the 
contents of tagged files in directory MYDIR to a single file, using 
the TYPE command. Substitute any other command for the 
TYPE command in batch files you create and any destination file 
name with the extension .BAT. 

Action 

1. If the words DIR COMMANDS 

are not displayed on the bot­
tom left of the screen, press Esc 

2. Point to directory MYDIR 
and double-click or use the Up 
or Down Arrow to highlight 
MYDIR, then press Enter 

3. Tag each file you'll include 
by placing the highlight bar on 
it and pressing T or pointing 
and clicking the right mouse 
button 

4. Press Ctrl + B or select 
Batch from the Tagged pull­
down menu 

5. Type the name of the batch 
file SAMPLE.BAT and press 
Enter or click ok 

6. Type TYPE %1 » 
CHAPTER! and press Enter 
or click ok 

Response 

The Directory commands are 
now available 

The File window is active and 
directory MYDIR is the cur­
rent directory 

All the tagged files which will 
be included in the batch file 
are marked with a diamond 

The prompt Enter destina­
tion path and file name is 
displayed 

The prompt Enter batch file 
line mask is displayed 

The batch file is created and 
then the file window is dis­
played with the file you cre­
ated displayed in the file list 
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7. Select the batch file 
SAMPLE.BAT with the high­
light bar and press X or click 
execute 

8. Press Enter or click ok to 
run the batch file 

9. Press Esc or click cancel to 
exit the Command shell 

10. Press Esc to return to the 
Directory window, then select 
Relog from the Directory 
pull-down menu 

11. Press Ctrl + U or click 
COMMANDS and then Untag 
to remove the tags from the 
tagged files 

The batch file is displayed in 
the Command shell 

The batch program will run 
and create or append the desti­
nation file you specified 

The File window is displayed 
but the destination file is not 
displayed 

The destination file CHAP­
TERl is now displayed in the 
File window 

No files are now tagged 
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Summary 

This chapter described how you can: 

D Create an Application Menu 

D Modify or add a new item on the Application Menu 

D Select an item from an Application Menu 

D Use the Open Command to launch an executable program 

D Use the Command shell to run applications 

D Create batch files with a command for each tagged file 

Remember to use this chapter as an ongoing reference as you 
begin to use these capabilities. Refer back to individual sections 
when you need directions for a task or additional directions to 
complete a procedure, until you become familiar with the steps in­
volved. 
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Archiving and Extracting Files 

This chapter describes the XTreeGold archiving capabilities and 
commands that permit you to quickly archive and extract files 
from within XTreeGold. Discussed are: 

D Archiving features and formats 

D Archiving files 

D Opening and extracting archived files 
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Using Archives 

Archives are collections of files that have been combined and com­
pressed so that they can be easily stored and manipulated. Pri­
marily, you use archives to conserve hard disk space and transfer 
files more efficiently. 

When working with a hard disk, you will find that your available 
storage space quickly fills up with older and little-used files. For 
example, if your hard disk contains 12 spreadsheet files from the 
previous year that were named JAN89.WKS, FEB89.WKS, 
MAR89.WKS, and so on, you could archive the files into a single 
89WKS.ZIP file that requires considerably less disk space than 
the original files. 

Afterwards, the archive files can be moved to a disk for storage 
elsewhere. If you need the files at a later date, they can be ex­
tracted from the archive and restored to their original form for ed­
iting and viewing. 

Additionally, archiving provides a more efficient means of trans­
ferring files. If you need to send files to other users, you can ar­
chive them for transport on a minimum of disk space or for faster 
(and less expensive) transfer via telecommunication programs. 
Also, because many files can be compressed into a single archive 
file, you can minimize the risk of overlooked or misplaced files 
when transferring files. 

XTreeGold Archiving Features 

XTreeGold provides the following archiving features: 

D Ease of use. You can quickly archive or extract files in a few 
simple steps. 

D Encryption. Add password protection to your archives to pro­
tect them from unwanted intrusion. 
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D Multiple formats. Archive files in the industry standard Zip 
or PK.arc formats. 

D Archiving options. You can specify the replacement of exist­
ing archived files or the addition of new files. 

D Standard XTreeGold commands are available while you are 
examining an archive, providing features such as file specifi­
cation, destination directories and on-line help. 

D Selective extraction. Extract any number of files from an ar­
chive file and restore the extracted files to their original direc­
tories or to new locations. 

Archive Formats 

XTreeGold provides two archiving formats: the industry-stan­
dards Zip and PK.arc. During the archiving operation, XTreeGold 
permits you to choose one of the archive formats. The primary dif­
ference between the two formats is in their efficiency to compress 
files and their compatibility with other users. We recommend 
you use the Zip format. 
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Archiving Files 

The Archive files command archives (copies and compresses) files 
tagged in the File window. The command is available: 

v When any File window is active 

D From the Tagged pull-down menu 

By clicking Zip and Arc or pressing the hot key Z 

Tagged 

Attributes ... Ctrl +A 
Batch ... Ctrl+B 
Cop~ files ... Ctrl +C 
Cop~ with paths ... Al t+C 
Delete ... Ctrl+D 
Move files ... Ctrl +M 
Move with paths ... Al t+M 
New date ... Ctrl +N 
Print. .. Ctrl+P 
RenaMe ... Ctrl+R 
Search ... Ctrl +S 
View Ctrl +U 

D Or, from the Ctrl file command menu 

By clicking COMMANDS and then archive files or 
pressing Ctrl + F5 

CTRL FILE Attributes Batch Cop~ Delete Invert Log disk Move Hew date 
COMMAHDS Print Rena11e Search Tag Untag Uiew 
~ ff, 11erge tags FB partial untag 

When you choose the command, XTreeGold sorts the tagged files 
listed in the File window and prompts you for the name of an ar­
chive file. 
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l@f' Note: When you type in a file name, XTreeGold defaults to ar­
chiving in Zip format unless you specify the PKarc format by 
typing a file name with the extension .ARC. If you type in 
any other extension, XTreeGold uses the extension and de­
faults to the Zip format. 

You can either: 

0 Enter a file name and extension by typing one at the prompt 

-OR-

0 Select an item from the history file (press Up Arrow or click 
history) 

XTreeGold then prompts you to select from a menu of archiving 
options. 

Paths 

Compatibility 

XTree 

PKarc 

Encryption 

Enables you to preserve path information 
in the archive file (only available when ar­
chiving in Zip format) 

Toggles between two archive compatibility 
formats. This option is not available when 
archiving in Zip format or when archiving 
to an existing .ARC file. 

The XTree format preserves information 
about the tagged files' paths. If you ex­
tract files archived with the XTree format, 
you can restore the original directory 
structure of the files. 

PKarc archives files in a "flat" format 
which does not include information about 
the original path of the tagged files. 

Enables you to specify a password of up to 
32 characters for the archived file 
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Method 

add 

update 

freshen 

Speed/size 

Enables you to choose one of three archiv­
ing methods. When creating a new ar­
chive file, this selection is not available, 
since XTreeGold must create the new ar­
chive file 

Unconditionally adds the files to the ar­
chive 

Adds new files and replaces any files that 
exist in the archive if the files to be added 
are a more recent replacement 

Replaces any files that exist in the archive 
if the files to be added are a more recent 
replacement, but does not add new files 

Enables you to specify whether you want 
to archive as quickly as possible or com­
press the files as much as possible at a 
slightly slower speed. 

If you specified Encryption, XTreeGold prompts for a password be­
fore continuing. Once you enter a password, XTreeGold begins 
the archiving process. 

~ Warning If you forget your password, you will never be 
able to extract the file. 

The example on the next page shows how to tag and then archive 
all files in Zip format in a directory named MYDIR on the current 
volume. 
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D Archiving All Files in a Directory 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Press Up or Down Arrow 
until directory MYDIR is high­
lighted, then press Enter 

3. Press Ctrl + T or select All 
in window from the Tag pull­
down menu 

4. Press Ctrl + F5 or select 
Zip and Arc from the Tagged 
pull-down menu 

5. Type a path and filename for 
the archive file and press 
Enter (Don't add a filename ex­
tension; XTreeGold automati­
cally adds the .ZIP extension) 

6. Select the archiving options 
you want from Paths, Encryp­
tion, Method and Speed/size 

7. Press Enter to continue the 
procedure 

8. Type a password of up to 
32 characters and press Enter 

Archiving and Extracting Files 

Response 

The Directory Commands are 
now available 

The directory MYDIR has a 
pointer next to it, and the File 
Command are displayed 

The files to be archived are 
tagged and marked with a dia­
mond 

XTreeGold sorts the files 
listed and prompts Enter 
name of file 

XTreeGold prompts for the ar­
chiving option of your choice 
(If you add a .ARC extension, 
XTreeGold archives in PKarc 
format. If you add any other 
extension, XTreeGold uses it 
and archives in Zip format.) 

XTreeGold prompts for addi­
tional input based on your 
choices 

If you specified encryption, 
XTreeGold prompts Enter 
password 

XTreeGold archives the files 
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Extracting Archived Files 

The Open Zip and Arc files command opens an archive file se­
lected in the File window. The command is available: 

V When any File window is active 

D From the File pull-down menu 

By clicking the command name Open Zip and Arc or 
pressing the hot key Z 

File 

Attributes ••• 
COplJ ... 
Delete 
Edit 
Move ••• 
New date ... 
Open (quick) 
Open (all MeMOrlj) Alt+O 

··-Print. .. 
RenaMe ... 
IJiew 

D Or, from the Alt file command menu 

T 

By double-clicking COMMANDS and then clicking open 
archive or pressing Alt + F5 

ALT l'ILE Copy Fi le displal) Log disk Moue Open Release disk Sort cri teri 
COMMANDS Tag Untag eXecute Quit 

FZ forMat F3 relog dil" F<I coMpal"e ~ 

When you choose the command, XTreeGold displays the contents 
of the archive file and provides commands for displaying and ex­
tracting archived files. 
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FILE ><. >< 

D If the archive file that is opened contains path information, 
the Archive directory window is displayed and Archive direc­
tory commands are available from the pull-down menus and 
displayed on the command line. 

D If the archive file that is opened contains no path informa­
tion, the Archive file window is displayed and Archive file 
commands are displayed on the command line and are accessi­
ble from the pull-down menus. 

In the Archive file window, the file size displayed next to each 
file name is the size of the original file and therefore the size 
it will be when extracted. The% is the amount of reduction 
from the original size. 

D If you open a file archived in Zip format, the words ZIP DIR 
COMMANDS or ZIP FILE COMMANDS are displayed in 
the command line. 

D If you open a file archived in Arc format, the words ARC DIR 
COMMANDS or ARC FILE COMMANDS are displayed in 
the command line. 

First select the files you want to extract from the archive by tag­
ging those files. Then select one of the Extract commands avail­
able from the Files pull-down menu or the command menus to 
extract the files. 
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When you choose one of the Extract commands, you are prompted 
for the file name of the new file(s). You can either: 

D Press Enter to retain the same file name 

D Enter any name of your choice 

D Select an item from the history file (press Up Arrow or click 
history) 

You are then prompted for the destination of the new file(s). You 
can either: 

D Enter a directory name by typing one at the prompt 

D Type a drive letter to specify a disk or volume as the destina­
tion 

D Select an item from the history file (press Up Arrow or click 
history) 

D Use the Point command (press F2 or click point) to display 
the destination directory window, where you can point to the 
destination 

You are then asked whether or not to automatically replace exist­
ing files. 

D If you choose Y(es) you'll automatically overwrite files of the 
same name. 

D If you choose N(o) XTreeGold will ask for confirmation each 
time a file with the same name is about to be copied over. 

When extracting more than one file, XTreeGold moves the high­
light bar over each tagged file as it is being extracted. 

l@f' Note: You must have adequate space on the destination disk 
to successfully add to or update the archive file. XTreeGold 
needs free disk space that exceeds the size of the files to be 
added in order to write some temporary files to the disk. If 
you are trying to add selected files to an archive file and their 
total size is 100,000 bytes you must have 100,000 bytes free 
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on the destination disk and about 60,000 additional bytes of 
temporary work space to successfully add the files. If you do 
not have adequate free space XTreeGold will not add some of 
the files successfully; it will display an error message when it 
runs out of space and inform you the operation was cancelled. 

D Archive Directory Commands 

The following commands are available when the Archive direc­
tory window is active. 

Pull-down 
menu item 

D XTree 

Help 

Quit to 
XTreeGold 

D Volume 

Print 

D Tag 

Directory 
files 

Command 
menu item 

Fl help 

Esc 

Print 

Tag 

Archiving and Extracting Files 

Purpose 

Displays a context sensitive 
help screen 

Closes the Archive window 
and returns you to the stan­
dard XTreeGold display 

Enables you to print a catalog 
of archived files 

Marks (with a diamond sym­
bol) all the archived files in 
the selected directory that 
meet the current file specifica­
tion 
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All zip files Ctrl + Tag all Places a tag next to each ar-
chived file on the volume 

(untag) Untag Removes the tags from all 
Directory matching files in the current 
files directory. Only files matching 

the current file specification 
are untagged. 

(untag)All Ctrl + Untag Removes the tags from all 
zip files all tagged files, preventing them 

from being affected by 
XTreeGold's multiple-file ar-
chive commands 

0 Window 

Directory Enter Opens the Archive file window 
files and displays the files in the 

current directory 

Branch Branch Changes the display to the 
files Branch file window and lists 

all the files in the selected 
branch of the archive file that 
match the current file specifi-
cation 

Branch Ctrl + Branch Displays the Branch file win-
tagged dow and lists all the tagged 

files in the branch 

All files Show all Changes display to the 
(Show all) Showall file window and lists 

all the files in the archive file 
that match the current file 
specification 
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All tagged Ctrl + Displays the Showall file win-
Showall tagged dow and lists all the tagged 

files on the current volume 

File specifi- Filespec Changes the file specification 
cation that XTreeGold uses to select 

archived files for display and 
operations 

File dis- Alt+ File Changes the format that 
play col- display XTreeGold uses to display the 
umns names of archived files in the 

File window; one, two and 
three column formats are 
available. 

Sort cri- Alt+ Sort Changes the order in which 
teria criteria files are displayed in the File 

window 

0 Archive File Commands 

If a File window becomes active while an archive file is open or an 
archive file which contains no path information is opened, the Ar­
chive file commands become available. 

Pull-down 
menu item 

o ><Tree 

Help 

Quit to 
XTreeGold 

Command 
menu item 

Fl help 

Esc 

Archiving and Extracting Files 

Purpose 

Displays a context sensitive 
help screen 

Closes the Archive window 
and returns you to the stan­
dard XTreeGold display 
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D File 

Extract Extract Extracts a selected file from 
the archive file. When you 
choose Extract, XTreeGold 
prompts you for a filename 
and destination path for the 
extracted file. You will be 
prompted for a password. 
Press Enter if you are not en-
tering a password. 

Print Print Enables you to print a catalog 
of archived files 

View View Displays the View window, 
with the contents of the cur-
rent file 

D Tagged 

Extract Ctrl + Extract Extracts all tagged files from 
the archive window 

Extract Alt+ Extract Extracts tagged files with 
with paths their directory paths 

D Tag 

File Tag Places a tag next to the cur-
rent file 

All in win- Ctrl + Tag all Places a tag next to each ar-
dow chived file displayed in the 

File window 
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(untag) Un tag Removes the tag from the cur-
File rent file, preventing it from 

being affected by XTreeGold's 
multiple-file archive com-
mands 

(untag) All Ctrl + Untag Removes the tags from all 
in window all tagged files, preventing them 

from being affected by 
XTreeGold's multiple-file ar-
chive commands 

D Window 

Tree Enter Displays the Archive directory 
window 

File specifi- File spec Changes the file specification 
cation that XTreeGold uses to select 

archived files for display and 
operations 

File dis- Alt+ File Changes the format that 
play col- display XTreeGold uses to display the 
umns names of archived files in the 

File window; one, two and 
three column formats are 
available. 

Sort cri- Alt+ Sort Changes the order in which 
teria criteria files are displayed in the File 

window 
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D Extracting Archived Files 

Follow these steps to extract all archived files from a file named 
MYFILE.ZIP in directory MYDIR. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Press Up or Down Arrow 
until directory MYDIR is high­
lighted, then press Enter 

3. Press Up or Down Arrow 
until file MYFILE.ZIP is high­
lighted and press Alt + F5 or 
select Open Zip and Arc from 
the File pull-down menu 

4. Press Ctrl + T to tag all the 
files in the archive file 

5. If the Zip File Commands 
are not displayed, press Enter. 
Then press Ctrl + E to extract 
all the tagged files 

6. Either accept the one shown 
or type a new filename or 
filename extension and press 
Enter 
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Response 

The Directory window is active 

The File window for directory 
MYDIR lists all the files 

XTreeGold modifies the Main 
Display to provide you with in­
formation about the archive 
file and its contents and dis­
plays additional Zip Directory 
or Zip File commands 

All the files are marked with a 
diamond 

XTreeGold prompts Enter 
file spec or press Enter 

XTreeGold prompts Enter 
destination path 
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7. Type a pathname and press 
Enter or press Enter to ex­
tract the file(s) in the current 
directory 

8. Type a password and press 
Enter or just press Enter if 
you are not entering a pass­
word. 

9. Type Y or click Yes 

Archiving and Extracting Files 

If you are extracting multiple 
files, XTreeGold repeats the 
process for each tagged file. If 
the archived file was en­
crypted, XTreeGold prompts 
for a password. 

The prompt Automatically 
replace existing files? is dis­
played 

XTreeGold extracts the speci­
fied files from the archive file. 

9-17 



Summary 

This chapter described XTreeGold's archiving capabilities and 
commands including: 

0 Archiving features and formats 

0 Archiving files 

0 . Opening and extracting archived files 

Use this chapter as a reference when archiving or extracting ar­
chive files. 
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Configuring XTreeGold 

This chapter describes XTreeGold's Configuration Utility, which 
enables you to modify the default parameters and to configure the 
display attributes or colors to fit your special needs and tasks. In­
cluded are: 

D Descriptions of the configuration items 

D Color display selection techniques 

D Command line configuration options 

D The video mode command 
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Configuring XTreeGold 

XTreeGold allows you to modify the default parameters and to 
configure the display attributes or colors. The Configuration Util­
ity is available: 

V' When any Directory or File window is active 

D From the XTree pull-down menu 

By clicking Configuration or pressing the hotkey C 

D Or, from the Alt directory command menu 

By double-clicking COMMANDS and then clicking 
configure or pressing Alt + FlO 

ALT DIR Edit Fi le display Graft Hide/unhide Log disk Prune Release dis 
COMMANDS Sort criteria Tag Untag Uash disk eXecute Quit 

FZ for11at F3 relog dir F9 uideo 11ode ~ 

When you start the Configuration program from within 
XTreeGold, you will be modifying the configuration values cur­
rently set for program operation. When you start the Configura­
tion program, it displays the Configuration Main Menu. 
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XTreePro Gold - Conf19urat1on Main Menu 

The Configuration Main Menu provides options for modifying con­
figuration items and color selections, reading the permanent set­
tings from disk, restoring the factory default settings that the 
program is shipped with and saving the configuration to the file 
that XTreeGold uses upon startup. 

Click the menu item you want to select, or use the Up and Down 
Arrow keys to scroll the highlight bar through the selections and 
press Enter, or press the number key that corresponds to the 
menu item of your choice. Select Save configuration and quit 
to leave the configuration program and save your changes. 

l@i" Note: If you exit the configuration program by pressing Esc 
(or selecting Quit configuration program), you'll exit with­
out saving the changes you've made. 
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Modifying XTreeGold's Configuration Items 

If you select Modify configuration items fr:om the Main Menu, 
the Configuration program displays a five-page Configuration 
menu. Click items or use the Arrow keys to highlight options and 
press Enter to change the option value. The following table pro­
vides brief explanations of each option in the Configuration menu. 

o Application Menu 

1 Opening screen is the Application Menu 

Choose YES to start XTreeGold with the Application 
Menu 

2 Pause after application program execution 

» Choose NO to bypass the "strike any key" message when 
returning to XTreeGold. 

o Directories 

3 Program path: 

Set the path where XTreeGold program files are stored. 
This option is not available when configuring from within 
XTreeGold, but is when you run the configuration pro­
gram from the DOS prompt. 

4 Editor program: 

70-4 

Select the option to enter the path and filename of the 
word processor you want to use when editing a file from 
within XTreeGold. A prompt line at the bottom of the 
screen allows you to type the full path and file name of 
the editor program you will use. Press Esc to cancel this 
prompt line. 
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o Disk logging 

5 Disk logging method 

XTreeGold's quick logging method doesn't use standard 
DOS calls as the standard logging method does. Change 
to STANDARD if errors are reported during logging. 

6 Log disk commands only read the root directory 

» Select YES if you want XTreeGold to only log the root di­
rectory when selecting the Log disk command. This will 
display the files in the root directory and first level sub­
directories only. 

7 Log disk commands only read the directory tree 

Select YES if you want XTreeGold to only log the direc­
tory tree when selecting the Log disk command. This will 
display the directory structure only; no file information 
will be displayed. 

D Display 

1 Display monitor type 

Identify your monitor type: either monochrome if you 
have a Composite, LCD or "Paper White" monitor or color 
if you have a CGA, EGA or VGA monitor. 

2 Display is flicker-free 

Your graphics card may display "snow" or flickering lines 
on the screen. If so, choose NO for a clear display. 

3 EGA 43 line or VGA 51 line display mode 

Identify an expanded display mode for your screen. 
Choose YES if you have an EGANGA system and want 
more than 25 display lines. 
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4 EGANGA cursor underline shape 

» Change from STANDARD to ALTERNATE if the over­
write mode does not display properly 

5 Enable high intensity DOS EGA backgrounds 

» Choose YES to disable the EGA blinking attribute for 
DOS programs. 

D File Window Options 

A Filename separator 

» Define the filename/extension delimiter as either a period 
or a space. 

B File type detection when viewing files 

» Sets file type detection to automatic or manual for view­
ing the contents of files. 

C Initial number of display columns 

Change the file display default to a one, two or three col­
umn format. 

D Initial sort criteria 

Change the default sort criteria of the file display. Dis­
play files alphabetically by name, extension, date or size. 
XTreeGold also displays files in unsorted order, the ac­
tual order in which they are stored on the disk. 

E Initial sort order 

» Display files in either ascending or descending order. 
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F Initial sort by path in showall 

» Change the default by selecting YES if you want the 
showall display to be listed in path order. 

G Skip Alt-Copy/Move sorting by path 

» Select YES to tell XTreeGold to skip the usual step of sort­
ing the file display by path, when you use the Alt Copy 
and Alt Move commands. 

H Small file window access 

Choose to bypass the Small file window if you want to 
move directly from the Directory window to the Expanded 
file window. 

o File and Tree Windows 

1 File and tree displays are lower case 

Choose YES if you want directory and files names dis­
played in lower case. Once you select this option, you can 
quickly switch to displaying directory and file names in 
upper case by pressing the Caps Lock key. 

2 Mouse scroll bar display 

» Select whether to display scroll bars or arrows for mouse 
scrolling. 

o International 

3 Date format 

» Choose Month-Day-Year or Day-Month-Year date format. 

4 Time format 

Choose 12-hour or 24-hour clock time format. 
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5 Numeric format 

» Choose commas or periods for number formatting. 

D Memory Utilization 

6 Application Menu programs 

Choose whether to use available memory or all memory to 
run applications started from the Application Menu. 
Choosing all memory instructs XTreeGold to collapse to 
7K to free the maximum memory for program execution. 

7 Mouse double-click on file name 

Choose whether to use available memory or all memory to 
run applications executed by double-clicking on a file 
name. 

8 Text editor 

Choose whether to use available memory or all memory to 
run the user-defined text editor when editing files. 

D Miscellaneous 

1 Archive file attribute on copied files 

» Select whether or not to always set the archive attribute 
or copy the existing attribute when copying a file. 

2 Audible error indicator 

Specify whether or not XTreeGold should "beep" to indi­
cate an exception condition during its operations. 

3 Ignore error message for missing overlays 

» Choose YES to bypass the missing overlay error message. 
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4 Skip Edit command prompt 

» Select whether or not to display a prompt when choosing 
the Edit command. 

5 Skip Quit command prompt 

Select whether or not to request confirmation when quit­
ting XTreeGold. 

o Mouse 

6 Acceleration 

Change from Standard to High if the mouse pointer speed 
seems too slow. 

o Printer 

A Printer bit 7 character masking 

» Select YES if your printer cannot print graphics charac­
ters. 

B Printer form length 

XTreeGold's factory setting is 55 lines, which is standard 
for an 11-inch form. If you set the form length to 1, no 
form feeds are issued, either within the document, or a 
the end of it. This feature is useful for printing a series of 
small text files, such as batch files, which you want to re­
view on the same page. A prompt line at the bottom of 
the screen allows you to type any number up to 65,535 
lines or type 0 to print over the perforations. Backspace 
over the number displayed to change the.number. Press 
Esc to cancel this prompt line. 
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C Printer redirection 

» Choose to print to the printer or the standard output de­
vice. A standard option device can be a DOS file or other 
destination. 

D Printer tab expansion 

Enter the Tab field width in columns, or 0 to print Tab 
characters. Backspace over the number displayed to 
change the number. Press Esc to cancel this prompt line. 

D Security 

1 Allow modifications to Application Menu 

» Choose whether or not to permit editing of the Applica­
tion menu. 

2 Allow modifications to files in hex mode 

» Choose whether or not to permit editing of files displayed 
in hex mode. 

3 System/Hidden file access and directory 

» Specify whether or not XTreeGold displays system and 
hidden files and directories. If you select YES, XTreeGold 
will display these files but will not allow them to be modi­
fied or deleted. 

~Note: These security options are not available when configur­
ing from within XTreeGold, but are when you run the configu­
ration program from the DOS prompt. 
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o Tree Window 

4 Initial highlighted directory 

Choose either the root directory or your current DOS di­
rectory for initial display in XTreeGold. 

5 Show actual path for substituted drives 

» Change from NO to YES if the substituted drive path 
should be shown in the path line. 

6 Directory window highlight bar 

The highlight bar may be fixed in the Directory window 
so that the tree display scrolls and the bar remains sta­
tionary. 
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D Using the Configuration Utility 

To run the Configuration Utility from within XTreeGold and 
change configuration items, follow these steps. Refer back to the 
chapter for an explanation of all the menu items. 

Action 

1. If the words DIR COMMANDS 
are not displayed on the bot­
tom left of the screen, press Esc 

2. Select Configuration from 
the XTree pull-down menu or 
press Alt + FlO 

3. Select 1 Modify configura­
tion items by clicking it or 
highlighting it and pressing 
Enter. 

4. Point to an item of your 
choice and click or press the 
number shown to select an 
item, then press Enter to tog­
gle the change 

5. Click Main menu or press 
Esc to return to the Configura­
tion Main Menu 

6. Press S or click Save config­
uration and quit to save your 
changes and click Yes or press 
Y to confirm 
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Response 

The Directory commands are 
now available 

The Configuration program 
menu is displayed 

Additional configuration items 
are displayed, with prompts 

The changes you make are dis­
played in the Configuration 
window; as you highlight each 
item, a summary of its pur­
pose appears in the prompt 
line 

The Configuration window 
Main Menu is displayed 

The changes are saved 
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To run the Configuration Utility from outside XTreeGold to 
change configuration items, at the DOS prompt: 

Type XTG_CFG and press 
Enter 

The Configuration program 
menu is displayed 

Now follow the previous steps, beginning at step 3. 

Configuring XTreeGold Color Selections 

When you select Display color selection from the Main Menu, 
the Configuration program displays small simulation screens 
where you can experiment with different color combinations. 
The left side of the simulated display represents XTreeGold's 
Main Display, while the right side represents the appearance of 
the Branch, Global or Showall file window. The middle of the dis­
play represents XTreeGold's pull-down menus. Press Tab to se­
lect the area to which you want to apply your color selections. 
Choose from the commands displayed on the bottom of the win­
dow to select different components of the XTreeGold display. 
After you select a component, use the F5 and F6 function keys to 
select character colors and the F7 and F8 keys to select back­
ground colors. Press Esc to return to the Main Menu. 

You can also select one of ten predefined color sets by pressing 
one of the numeric keys (0-9) at the top of your keyboard. (On a 
CGA system, you may need to specify a different cursor back­
ground color for a predefined color set.) 

If you have a monochrome system, you can use the color configu­
ration controls to set up combinations of highlight, lowlight, and 
reverse video for XTreeGold's displays. 

In addition to the two items which let you modify the configura­
tion, the Configuration Utility's Main Menu also provides four op­
tions for saving your configurations and leaving the utility. 
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Exit Options 

3 Read permanent settings from disk 

» Displays a dialogue box that asks if you want to use the 
configuration settings currently saved in the configura­
tion file. 

4 Restore factory default settings 

» Displays a dialogue box that asks if you want to revert to 
the default configuration settings originally shipped with 
XTreeGold. 

S Save configuration and quit 

» Displays a dialogue box that asks if you want to save the 
modified configuration settings in the configuration file 
and quit the Configuration Utility. 

Q Quit configuration program 

» Displays a dialogue box that asks if you want to quit the 
Configuration Utility and discard any changes you made. 
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Command Line Configuration Options 

As an alternative to modifying default parameters from the Con­
figuration Utility, XTreeGold allows you to modify configuration 
items by entering command line options when you start 
XTreeGold. Use this method when you want to experiment with 
a configuration option or when you want to override a configura­
tion default for one-time use only. Command line options do not 
modify the configuration file. 

The following criteria pertain to all command line options: 

D A command line option begins with a I and is followed by one 
or more characters. 

D Letters may be upper or lowercase. 

D Multi-character options may not have any intervening spaces. 

D Multiple options may be entered with or without space separa­
tors. 

D For options which end in + or - (indicating on or offi, the + 
may be omitted to turn the option on. 

D All options must follow the disk drive specifier (if one is en­
tered). For example: XTGOLD /LQ /Q+ /P70 

The command above starts XTreeGold and configures the pro­
gram for quick logging of disks (/LQ), audible error indication 
(/Q+ ), and sets the default printer form length to 70 lines (/P70). 

Invalid entries are ignored. 

When you enter a command line switch to redirect printer output 
to standard output, you must include a > to designate the redirec­
tion to a filename. For example: XTGOLD /PS> filename 

The command above redirects printer output to a file. The 
filename could identify a file already created or a new one you 
want to create. If you do not enter a proper command, the print­
out goes to the screen. 
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The available command line options are organized alphabetically 
in the following list. 

D Command Line Options 

/1 /2 and /3 

» File display format. Enter /1 /2 or /3 to display files in 1, 
2, or 3-column format. 

/43+ and /43-

» Expanded display mode. Enter /43+ to turn on EGANGA 
expanded display mode. Enter /43- to turn off EGANGA 
expanded display mode. 

IA and/A-

Directory highlight bar option (Anchor on and anchor offi. 
Enter I A to fix the highlight bar and scroll the directory 
tree display. Enter /A- to enable highlight bar movement. 

/C<space> and IC<.> 

» Filename separator character. Enter a period or a space 
as a character. Do not type the greater than or less than 
symbols above. If you omit the character, a space is as­
sumed. 

/DD and/DC 

Display monitor type. Enter /DD for CGA, EGA or VGA 
monitor. Enter /DC for Composite, LCD or "Paper White" 
monitor. 

IDN and/DS 

» Display snow. Enter /DN if your screen display is flicker­
free. Enter /DS if your screen displays snow. 
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IE 

Ignore missing overlay errors. 

/ll<path> 

» XTreeGold program directory path. Example: 
/HC:\XTGOLD 

/Ll and/LT 

» Disk directory logging method. Enter /Ll to log one level 
or IL T to log only the tree. 

/LQ and/LS 

Disk directory logging method. Enter /LQ for quick log­
ging or /LS for standard logging. Quick logging is the de­
fault method. 

/OAand/OD 

IP# 

!PM 

Sort order. Enter /OA for ascending order. Enter /OD for 
descending order. 

Print form length in lines. Example: /P60. Enter /PO to 
eliminate form feeds. 

Enter /PM for printer bit 7 character masking. 

!PP and/PS 

Printer redirection. Enter /PP for printer output. Enter 
/PS for standard output. To direct printouts to a file, load 
XTreeGold by typing XTGOLD /PS filename. 
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/Q+ and/Q 

/R 

Quiet option and audible error indicator. Enter /Q for 
quiet (disables audible alarms). Enter /Q+ to enable 
alarms. 

Make the Root directory the current directory when 
XTreeGold is first loaded. 

/SN /SE /SD /SS and /SU 

Sort criteria. Enter /SN to sort by name. Enter /SE to 
sort by extension. Enter /SD to sort by date. Enter /SS to 
sort by size. Enter /SU for an unsorted file display. 

IT and IT-

Scroll bar option. Enter IT to display scroll bars and 
"thumbs." Enter IT- to display arrows and lines. This op­
tion provides a cleaner display. 

IU<path> 

XTreeGold users' directory path. Specifies a directory for 
storing data files. Example: /UC:\XTGOLD\DAT 

/W and/WS 

/XA 

/XB 

» Small file window access. Enter /W to bypass the Small 
file window. Enter /WS to display the Small file window. 

» Make the Application Menu the opening screen of 
XTreeGold. 

» Set the DOS cursor as a block. 
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!XC 

/XE 

In the Showall window, skip automatic sort by path that 
normally occurs during an Alt Copy or Alt Move operation. 

» Skip editor dialogue from the file display. 

fXM 

IXP 

!XQ 

!XS 

IZ 

» Display memory usage (above free disk space). Number 
displayed is the number of blocks available for storing file 
information. 

Sort files by path (for Showall and Global). 

No confirmation prompt when quitting. 

Display real root of substitute drive (necessary if you use 
SUB ST). 

Reset all factory defaults except the XTreeGold path and 
color selections. 
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Setting the DOS Environment 

The DOS environment is a reserved area in computer memory 
that contains parameter information which you specify with the 
SET command. After you specify these parameters, they are 
used by application programs. To use the capability set the DOS 
environment before running XTreeGold. 

As an alternative to setting XTreeGold configuration options on 
the DOS command line, you can use the SET command to define 
parameters. For example: 

SET XTGOLD=/1/Q 

The preceding command tells XTreeGold to display files in a sin­
gle column format and suppress the beep during exception condi­
tions. 

Environment options remain in effect until you enter another 
SET XTGOLD = command, or until you reboot the system. You 
can place a series of SET commands in your AUTOEXEC.BAT 
file so that they will be executed upon startup. 

Specifying a Text Editor 

You can also use the SET command to specify a text editor to be 
started in place ofl Word when you open text files from within 
XTreeGold. Use SET XTEDITOR = command pathname from the 
DOS command line to specify the editor. For example: 

SET XTEDITOR=C:\WORD\WORD.COM 
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Video Mode 

XTreeGold's Video mode command sets the display to 43/50 lines 
for EGANGA systems or returns it back to 25 line mode. The 
Video mode command is available: 

V When the Directory window is active 

D From the Window pull-down menu 

By clicking Video mode or pressing the hotkey V 

Window 

Autoview F7 
Split on/off FS 

Directory files Enter 
Branch files B 
Branch tagged Ctrl+B 
Disk files ( Showall) S 
Disk tagged Ctrl+S 
Global G 
Global tagged Ctrl+G 

File specification ... 
File display coluMns Alt+F 
Sort criteria... Al t+S 

D Or, from the Alt directory command menu 

By double-clicking COMMANDS and then clicking 
video mode or pressing Alt + F9 

ALT DIR Edit File display Graft Hide-'unhide Log disk Prune Release dis 
COMMANDS Sort criteria Tag Untag Wash disk eXecute Quit 

FZ for11at F3 relog dir ~ F10 configure 

When you select the Video mode command, the display toggles 
43/50 line expanded display mode. No other action is required. 
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Summary 

This chapter described how to customize XTreeGold to your indi­
vidual needs and tasks. Refer back for information on 
XTreeGold's: 

0 Configuration items 

0 Color display selections 

0 Command line options 

0 Video mode command 
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The 1Word Text Editor 

This chapter presents a complete description ofXTreeGold's built­
in text editor, lWord. Included are: 

D Descriptions of all commands and options 

D Steps for beginning a 1 Word editing session 

D Instructions for configuring the function keys 
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Editing With 1 Word 

lWord is a dynamic text editor that serves as an easy editing tool 
within XTreeGold. To access lWord, select the Edit command. It 
is available: 

V When any Directory or File window is active 

D From the File pull-down menu 

By clicking Edit or Edit file or pressing the hot key E 

File 

Attributes ... 
COpLJ ... 
Delete 

Move ••• 
New date ... 
Open (quick) 
Open (all MeMOrLJ) 
Open Zip and Arc 
Print. .. 
RenaMe ... 
View 

M 
N 
0 

Al t+O 
Al t+FS 

p 
R 
v 

D Or, from the Standard file command menu 

By clicking Edit or pressing E 

FILE Attributes Cop~ Delete m! Fi lespec Invert Log disk Move 
COMMANDS New date Open Print RenaHe Tag Untag Uiew eXecute Quit 
~tree F7 autoview F8 split F9 Menu F10 COHHands Fl help ESC cancel 
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It is also available: 

V When the Directory window is active 

D From the Alt directory command menu 

By double-clicking COMMANDS and then clicking Edit 
or pressing Alt + E 

When you select the Edit command with a File window active, the 
current file is immediately opened in the text editor if that file is 
a text (ASCII) file. When you select the Edit command with a Di­
rectory window active, XTreeGold prompts for the name of the 
file to edit. You may: 

D Type the name of any new or existing file and press Enter 

D Or select a file name from the history (press F2 or click his­
tory) 

The selected file is then opened in the text editor if that file is a 
text file. 

With lWord, you can modify any text file on any volume or create 
a new text file. Although many lWord commands are compatible 
with WordStar, you can configure the function keys to execute 
any lWord command or command series. In addition, an on­
screen status line maintains statistics and current editing infor­
mation. The status line is displayed when you start 1 Word. 

Esc cancel 

To display lWord's menus, press Ctrl + U. 

E..-c cancel 

The 7 Word Text Editor 7 7-3 



1 Word does not support mouse operations. XTreeGold commands 
are not available while you are using I Word. To begin working 
with I Word for the first time, first select the Edit command, then: 

0 Press Ctrl + U to display I Word's menus 

-OR-

0 Press the Fl key to access help 

~ Note: The Fl key is not available when the menus are dis­
played. 

Refer to the following charts for a list and description of all of 
I Word's commands. 

D Cursor Controls 

When you are editing text, the cursor points to where you will 
make changes, deletions, or insertions. Use the following keys to 
move the cursor: 

Left Arrow or Move cursor 1 position to the left 
Ctrl + S 

Right Arrow or Move cursor 1 position to the right 
Ctrl + D 

Ctrl + Left Arrow Move cursor 1 word to the left 
or Ctrl +A 

Ctrl + Right Arrow Move cursor 1 word to the right 
or Ctrl + F 

Up Arrow or Move cursor 1 position up 
Ctrl + E 
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Down Arrow or Move cursor 1 position down 
Ctrl +X 

Home or Ctr I + QS Move cursor to beginning of line 

End or Ctrl + QD Move cursor to end of line 

Ctrl + Home or Move cursor to top of screen 
Ctrl+ QE 

Ctrl + End or Move cursor to bottom of screen 
Ctrl+ QX 

Pg Up or Ctrl + R Move cursor to previous screen 

Pg Dn or Ctrl + C Move cursor to next screen 

Ctrl + Pg Up or Move cursor to beginning of file 
Ctrl +QR 

Ctrl + Pg Dn or Move cursor to end of file 
Ctrl +QC 

Ctr I + QB Move cursor to start of marked block 

Ctr I + QK Move cursor to end of marked block 

Ctrl + QQ Set a quick place marker 

Ctrl + QP Move cursor to quick place marker 

Ctrl + OG Move cursor to line number 

Ctrl + QW Scroll the display up 1 line, keeping the 
cursor on the same screen row 
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Ctrl + ] or Ctrl + QZ Scroll the display down 1 line, keeping the 
cursor on the same screen row 

D Entering and Editing Text 

With your cursor appropriately positioned in the text file, you 
can begin entering text by typing in characters. Typically, any 
text you enter is inserted to the left of the cursor, and all charac­
ters to the right of the cursor are moved to the left (Insert On). 

Press the Insert key to toggle Insert on and off. With Insert Off, 
any text you type replaces the text under the cursor. 

Press Enter to end a line of text. The cursor moves to the begin­
ning of the next line. Press Ctrl +OJ to toggle word wrap on 
and off. With Word Wrap On, you do not need to press Enter at 
the ends oflines; lWord reformats the text automatically. 

Use the following keys to insert or delete text: 

Ins 

Ctrl + OI 

Ctrl + 00 

Ctrl + N 

Ctrl + M 

Backspace 

Del 

Ctrl + T 
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Toggle insert on and insert off 

Set insert on 

Set overwrite on and set insert off 

Insert a new line 

End a line 

Delete the character to the left of the cur­
sor 

Delete the character under the cursor 

Delete the word under the cursor 
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Ctrl + Y 

Ctrl + QY 

Delete the line under the cursor 

Delete from the cursor to the end of the 
line 

Use the following commands to mark and manipulate blocks of 
text: 

Ctrl+ KB 

Ctrl+KK 

Ctrl+KH 

Ctrl+KV 

Ctrl +KC 

Ctrl +KY 

Ctrl+KW 

Mark the beginning of a block of text 

Mark the end of a block of text 

Hide the marked block 

Move the marked block to the cursor posi­
tion 

Copy the marked block to the cursor posi­
tion 

Delete the marked block 

Write the marked block to another file 

0 Search and Replace Commands 

When you invoke search and replace commands, lWord prompts 
you to enter the text to find. 

Ctrl+ QF 

The 7 Word Text Editor 

Find a string of characters. Type in the 
text you want to find. The cursor moves 
to the first occurrence. Press Ctrl + L to 
move the cursor to subsequent occur­
rences. 
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Ctrl+ QA 

Ctrl + L 

Ctrl+ QG 

Search and replace a string of characters. 
Invoke this command to replace one 
string of characters with another. Type in 
the text to be replaced. When you are 
prompted with "Replace (?)", type in the 
new text. The cursor moves to the first oc­
currence and prompts you to confirm the 
replacement. Press Y to replace the text 
at the cursor. 

Search and replace again. Continues a 
search or search and replace operation 
without re-entering the text. 

Global search and replace. Find all occur­
rences of a string in the entire file. You 
are prompted to replace each one. 

D Search and Replace Options 

Set these options before you invoke the search and replace com­
mands: 

Ctrl+ OA 

Ctrl+ OB 

Ctrl+ OC 
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Toggle ask option on and off. With this op­
tion Off, the "Replace (?)" question is not 
asked in a Ctrl + QA or Ctrl + QG com­
mand. The text is replaced automatically. 

Toggle the search direction backward or 
forward 

Toggle search case sensitivity on and off. 
With this option On, the case of each char­
acter (upper or lower) is included as part 
of the match criteria in a search. With 
this option Off, a string of characters is 
found whether or not their case matches 
the search case. 
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Ctrl+OW Toggle search full-word sensitivity. With 
this option On, the target text is consid­
ered to be whole words. With this option 
Off, a match occurs ifthe text matches 
part of a word in the file. 

D Tab Option Commands 

1 Word provides three options for using tabs, depending on your 
needs: 

Ctrl+ OH 

Ctrl +OS 
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Set hard tab mode (every 8 columns). As 
with standard ASCII files, tab stops are po­
sitioned every eighth column. When you 
press the Tab key, you place the TAB 
ASCII character into the file. The Tab 
key moves the cursor to the next position 
which is a multiple of eight from the left 
side of the screen. Subsequently, the cur­
sor jumps when you move it over that 
spot. If you delete the Tab, text jumps to 
the left to fill the gap. Hard tabs conserve 
space on your disk, which is helpful if you 
use a lot of Tabs. 

Set soft tab mode. Soft tabs place spaces 
in the file, rather than characters, so the 
cursor will not jump when you move it 
over a tab stop. Tab stops are determined 
by the spaces in the line of text directly 
above the current line. When you are in­
denting a series of lines, press Tab to 
move the cursor directly to the column 
where the text begins on the above line. 
Soft tabs are useful for programming in 
high-level languages. 
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Ctrl+ OU 

Ctrl +OT 

Ctrl+ OE 

Set user tab mode (ruler line). When you 
press Ctrl +OU, lWord displays a tab 
ruler indicating where each tab stop is lo­
cated. You can edit the ruler using Ctrl + 
OE, or you can set or release a tab stop at 
the current column position by using Ctrl 
+ OT. Automatic word wrap and para­
graph reformatting are enabled in this 
mode with the Ctrl + OJ command. 

Set or clear a tab stop. See the Ctrl + OU 
discussion above. 

Edit tab stop ruler line. When you press 
Ctrl +OE, the cursor is placed on the 
ruler line. Use the right and left arrow 
keys to move the cursor without changing 
the ruler. Press the space bar to remove a 
tab under the cursor and press T to add a 
tab under the cursor. 

D Word Processing Commands 

Ctrl+ OJ 
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Toggle automatic word wrap on and off 
With Word Wrap On, you don't need to 
press Enter at the ends of lines. En­
abling Word Wrap automatically enables 
User Tabs. With Word Wrap Off, you 
need to press Enter to end a line of text. 
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Ctrl +OR or 
Ctrl + B 

Reformats a paragraph. Paragraphs are 
reformatted according to the positions of 
the first and last tab stops on the ruler. A 
paragraph is considered to be any number 
oflines up to a completely blank line. 
Press Ctrl + B or Ctrl + OR to shift lines 
of text into well-formed paragraphs. To 
reformat with different margins, first edit 
the ruler. Place the first and last tab 
stops at the columns where you want the 
text to start and end. Move the cursor to 
the first line of the paragraph and press 
Ctrl + B or Ctrl + OR. 1 Word puts as 
many words as will fit into each line, and 
it honors the indenting of the first line. 
Note: 1 Word does not justify text on the 
right side. 

D 1 Word's File Commands 

Ctrl+KS 

Ctrl+KD 

Ctrl+KX 

Ctrl+KP 

Ctrl+KQ 

Ctrl+KR 
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Save the file and continue editing. Keeps 
the cursor at the same position in the file. 

Save the file and edit another 

Save the file and return to XTreeGold 

Print the file 

Quit (abandon) the file without saving 

Read another text file and insert its text 
at the cursor position 
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D Returning to XTreeGold 

Ctrl+KX Save a file and return to XTreeGold 

Esc Display a menu of exit options 

When you edit a single file, the filename you enter at the Edit 
prompt is subsequently displayed in XTreeGold. .BAK files are 
also displayed and information is updated. 

If you edit more than one file, or write data to another file or cre­
ate a new PFK file to define the programmable function keys, 
those files will not be displayed until you relog the disk on which 
those files are stored. 

D Miscellaneous Commands 

Esc 

Ctrl+ QU or 
Alt+ u 

Ctrl + QL or 
Alt+L 

Ctrl +QT 

Ctrl+ OQ 

Ctrl+ U 

Ctrl+OM 
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Cancel the current operation 

Make character upper case 

Make character lower case 

Insert time and date in the text at the cur­
sor 

Quiet: toggle beeper on and off 

Use the menu prompter 

Turn the prompter on and off 
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Ctrl + 0] 

Ctrl + [ 

Clear high bits from the file. This can be 
useful for converting some word-process­
ing files to regular ASCII files. 

Inserts an Esc character into a I Word doc­
ument. Type a string of characters (for ex­
ample, xy or 'Esc') where you want to 
insert an Esc character, then use the 
search and replace command (Ctrl +QA) 
to replace the string with Ctrl + [. 

Entering Graphic Characters 

To enter graphic characters into a I Word file, hold down the Alt 
key and use the numeric keypad to type the ASCII decimal equiv­
alent for a graphic character. 

Programmable Function Keys (PFK) 

Within I Word, you can configure the function keys Fl to FlO to 
execute any I Word command or series of commands. PFKs ex­
tend your range of operations, enabling you to: 

D Replace Ctrl + key sequences with function keys 

D Perform frequent multi-key editing operations with a single 
keystroke 

D Enter hard-to-type text such as semi-graphic box characters 

Initially, I Word searches for a file named lWORD.PFKin the di­
rectory which was current when 1 Word was invoked. If it is not 
found there, I Word looks in the root directory. If the file is pres­
ent, I Word reads it and uses it to set the programmable function 
keys. If you do not define a lWORD.PFK file, the function keys 
have no settings. 
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To change the value of a function key, press Ctrl + PE. 1 Word 
prompts you for the function key you want to define. Press the 
function key to display the current value definition (if any) in re­
verse video. Press the Backspace key to back up and delete one 
character at a time or press Ctrl + Backspace to delete the en­
tire value definition. 

Enter a 1 Word command or series of commands, or enter a string 
of characters that define a multi-key editing operation. Enter a 
Ctrl + key command by holding the Ctrl key and pressing the 
command key. Press Alt+ N to place an Enter key into the func­
tion key definition at any point. 

If you reprogram the Fl key, you can use Ctrl +Backslash(\) to 
access lWord help. 

Press Enter when you are finished editing a function key defini­
tion. Or, press Esc to cancel an edit, restoring the previous value 
of the function key. 

You may create as many as 10 function key definitions and press 
Ctrl + PW to write them to a PFK file for later recall. Once a 
function key has been defined, pressing that key while editing 
causes lWord to type the corresponding string. 

You can also create multiple .PFK files for different editing re­
quirements. To reload a specific .PFK file, press Ctrl + PR. 
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D Editing a File 

To begin a lWord editing session, follow these steps. 

Action 

1. With the File window active, 
and the highlight bar on the 
file you want to edit, select 
Edit from the File pull-down 
menu or, press E 

2. Press Enter to edit the file 
shown (or type the file name of 
a new file and press Enter) 

Response 

The prompt Enter name of 
file to edit: is displayed 

The lWord text editor is dis­
played with the file you indi­
cated 

-OR-

1. With the Directory window 
active, select Edit file from 
the File pull-down menu or 
press Alt+ E 

2. Type the file name of a new 
or existing file 

The 7 Word Text Editor 

The prompt Enter name of 
file to edit: is displayed 

The lWord text editor is dis­
played with the file you indi­
cated 
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Summary 

This chapter presented a complete description ofXTreeGold's 
built-in text editor, lWord, including: 

D Descriptions of all commands and options 

D Instructions for configuring the function keys 

D Steps for beginning a lWord editing session 

Use either this chapter or the on-screen menus and help during 
1 Word editing sessions, depending on your preference. 
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Appendix 

Contacting XTree Company 

To contact XTree Company for technical support, site licensing or 
sales information, or to share your ideas for other software pro­
grams, please refer to the following information: 

Mailing Address: 4330 Santa Fe Road 

San Luis Obispo, CA 93401 

General Information: (805) 541-0604 

FAX Number: (805) 541-8053 

XTree BBS: (805) 546-9150 

Technical Support: (805) 541-0604 

Please have your serial number ready when you call for technical 
support. Technical support hours are from 8 a.m. to 5 p.m. 
Pacific time, Monday to Friday. 
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Glossary 

Active Window 

Any window in which the highlight bar appears. 

Branch 

A directory and all its subdirectories. 

Click 

To click the mouse button to select an item on the screen; in this 
guide, click always means to click the left mouse button, unless 
the right button is specified in the description. 

Current Directory 

The directory which is highlighted while the Directory window is 
active or which is marked by the left-arrow indicator when the 
File window is active. 

Current Disk or Current Volume 

The disk or volume on which XTreeGold is currently operating. 
Only those directories and files on the current disk or volume are 
displayed (except when the Global window is active). The current 
volume for XTreeGold operations is displayed in the Disk specifi­
cation box. 

Current File 

The file which is highlighted when one of the File windows is ac­
tive. 

Default 

The standard value or option that is used if no other is specified. 
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Destination 

The targeted location to which data will be sent, for example, 
where files will be copied to. 

Directory 

A structure for organizing and accessing computer data. Directo­
ries are organized into a hierarchical framework and each direc­
tory can contain files and/or other sub-directories. 

Directory Path 

Specifies how you find your way to a particular directory or sub­
directory on a volume. The path is the route you follow to trace 
your way to some point on a volume. 

Directory Tree 

The tree-like structure created by a root directory, its subdirector­
ies and all subsequent subdirectories. 

Disk 

Either a hard disk or diskette used to store data. A hard disk 
may be partitioned into more than one volume. 

Disk Drive 

A spindle or device that reads the data stored on a disk and 
writes data on a disk for storage. 

DOS 

Disk Operating System, an operating system for personal comput­
ers. 

File 

An organization of data on a disk. Each file has its own name, 
which is from 1-11 characters long. 
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File Specification 

A pattern of characters which XTreeGold uses to select which file 
names to display. Sample file specifications are *.EXE, TEST*.*, 
and *.WK?. 

Log a Disk or Log a Volume 

A disk or volume must be logged (physically read) by XTreeGold 
before its directories and files can be accessed and acted upon. 

Matching Files 

Those files whose names match the current File specification. 
Only matching files are displayed, to be acted on by XTreeGold's 
file operations. 

Parent 

A directory which includes subdirectories. 

Path 

Specifies how you find your way to a particular directory or sub­
directory on a volume or disk. The path is the route you follow to 
trace your way from the root directory to some point in its branch­
ing directory tree. 

Root Directory 

The main directory on any volume or disk. All other directories 
are subdirectories of the root directory. 

Select a Command or Option 

Choose a command or option from an XTreeGold menu by press­
ing the highlighted key or using a mouse to highlight the com­
mand, and then clicking the left mouse button. 
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Select a Disk or Select a Volume 

Choose a disk or volume which is already logged to be the current 
disk or volume. 

Tagged Files 

Those files which have been marked by a Tag command. Tagged 
files have a diamond marker next to their names. A file stays 
tagged even after the File specification has been changed. Files 
which are both tagged and matching can be acted upon by 
XTreeGold's multiple-file operations. 

Volume 

A physical portion of hard disk space. 
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Technical Notes 

This section provides technical information about XTreeGold. 

Understanding Cluster Size 

XTreeGold reports the total number of bytes that files occupy and 
the total number of available bytes. If you add these numbers to­
gether, they are different from the total amount of disk space re­
ported by CHKDSK. This is because DOS allocates space in 
chunks called clusters and the size of these clusters depends on 
your particular system. 

For example, ifthe cluster size on your system is 2048 bytes, 
DOS allocates at least 2048 bytes for every file. A file containing 
only 85 bytes actually uses 2048 bytes of disk space. XTreeGold 
displays the 85 bytes actually used, but considers 2048 bytes 
when it determines the number of bytes available. 

Using the example above, a disk with only 6144 bytes available 
would have only 4096 bytes available after an 85-byte file is 
added to it. This is because the 85-byte file actually uses 2048 
bytes of disk space (6144 - 2048 = 4096). 

Look at the Slack Space field in the Extended Statistics window 
to see the total amount of unusable space that results from DOS 
allocation methods. 

Loading TSR Programs 

If you run Terminate-and-Stay Resident (TSR) programs, you 
should load them directly from DOS before you start up 
XTreeGold. You may include them in your AUTOEXEC.BAT file 
to load them automatically upon booting. This is the correct pro­
cedure because TSR programs remain resident in memory even 
when they are terminated, unlike most programs which are re­
moved from memory when you exit them. TSR programs con-
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tinue to occupy memory that can be used by executable programs 
and can also fragment memory. 

High Memory 

XTreeGold Work Buffers 

XTreeGold Program 

XTreeGold Loader (7K) 

TSR program loaded prior to XTreeGold 

DOS 

Low Memory 

Memory with properly loaded TSR 

Whenever you execute a program from the Command shell, 
XTreeGold releases some of the memory it uses to run the pro­
gram. When the program is terminated, XTreeGold reinitiates 
its memory areas. 

Loading a TSR from XTreeGold interferes with XTreeGold's mem­
ory allocation; the TSR program remains resident in memory and 
limits the memory available to XTreeGold memory for performing 
its tasks. When you return from running a TSR program, one of 
two situations can occur. The first situation occurs when you run 
the TSR using the Execute command, the Open command, or the 
Application Menu where XTreeGold is configured to allow applica­
tions to use only available memory. In this case, XTreeGold is in­
hibited from resuming and memory will look like this: 
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High Memory 

TSR program loaded from XTreeGold 

(this memory is now unavailable) 

XTreeGold Program 

XTreeGold Loader (7K) 

TSR program loaded prior to XTreeGold 

DOS 

Low Memory 

Memory with TSR loaded from XTreeGold (Case One) 

If you attempt to return to XTreeGold, the following error mes­
sage is displayed: 

A Ram resident program has been executed. XTreeGold cannot 
continue. Strike any key to exit to DOS. 

After exiting to DOS, XTreeGold is released completely from 
memory. However, subsequent DOS operation may be limited be­
cause the TSR was loaded in the middle of memory, fragmenting 
memory space. 

The second situation occurs when you run a TSR program with 
the Alt eXecute command, the Alt Open command, or from the Ap­
plication Menu when XTreeGold is configured to use all system 
memory. In this case, memory will look like this: 
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High Memory 

XTreeGold Work Buffers 

XTreeGold Program 

TSR program loaded from XTreeGold 

XTreeGold Loader (7K) 

TSR program loaded prior to XTreeGold 

DOS 

Low Memory 

Memory with TSR loaded from XTreeGold (Case Two) 

In this case, XTreeGold will be able to reinstate its memory and 
continue operations. 

In both of the situations described, you may encounter problems 
after quitting XTreeGold. This is because memory fragmentation 
can limit DOS operations. DOS is not designed to operate in this 
mode and unpredictable system errors may result if you call up a 
program that requires more memory than is contiguously avail­
able. 
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High Memory 

Limited DOS memory 

(may be insufficient to run programs with 

medium or large memory requirements) 

TSR program loaded from Command shell 

Unusable memory left after exiting XTreeGold 

TSR program loaded prior to XTreeGold 

DOS 

Low Memory 

Fragmented memory 

Rebooting is the only way to completely reallocate memory when 
you load a TSR from the XTreeGold. The best strategy with TSR 
programs is to load them before you begin any other work. In­
clude your favorite TSR in your AUTOEXEC.BAT file. 

File Attribute Security 

Your operating system expects certain files to be in a specific loca­
tion on a disk; in addition, some application programs use the po­
sition of the file on the disk as a key to allow access to the 
application. Many copy protection schemes use this technique. 
These files are protected with the system or hidden attribute. To 
maintain your system's security, XTreeGold does not display Sys­
tem and Hidden files. However, any System or Hidden files cre­
ated during an XTreeGold session remain visible until the drive 
they were created on is logged again. You may choose to config­
ure XTreeGold to display system and hidden files. 
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Read-Only files can't be moved, deleted, or renamed. XTreeGold 
prompts for confirmation before overwriting a Read-Only file. 
Hidden and System files cannot be moved, deleted, renamed, or 
overwritten. If you want to change these files, you must first re­
move the Read-only, System, and/or Hidden attribute. 

Substituted Drives 

Substituting drives is a way to segment a drive into other drive 
designations or substitute a drive for a path. Use the DOS com­
mand SUBST, valid in DOS versions 3.1 or greater, to substitute 
a drive ID. XTreeGold recognizes these substitute drives as ac­
tual drives and allows you to log them. 

The error message, Directory in Use, occurs when you try to re­
name or delete a subdirectory which is part of a substituted direc­
tory. In order to delete or rename this directory, you must 
remove the definition of the substituted drive. 

You cannot rename the Volume for a substituted drive. See the 
DOS manual for more information on substituted drives. 

Joined Drives 

If you have joined drives and want XTreeGold to recognize the 
joined drive, you need to select the Standard Logging method. 
Refer to the Configuration section for more information. 

Networking Compatibility 

This version ofXTreeGold is not designed to fully support a net­
work. 
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Error Messages 

This section provides descriptions of error messages you may en­
counter while working with XTreeGold. 

Disk Errors 

Any of the error messages listed below may occur if a disk be­
comes damaged. Check your disk and your drive and press R to 
retry. If you are still unsuccessful, press C to cancel. You may 
have a defective disk. 

Bad File Allocation Table 

Data CRC Error 

Sector Not Found 

Seek to Track Failed 

Unable to Read Data 

Unable to Write Data 

Undetermined Error 

General Error Messages 

The error messages listed may appear while you are using 
XTreeGold. Refer to this list for brief explanations and sugges­
tions on how to recover from the errors. The messages are listed 
alphabetically for your convenience: 
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Alt Copy must be to another disk 

When entering a destination for the Alt Copy command, you must 
specify a disk other than the currently logged disk. To copy files 
to the same disk, use the Ctrl Copy command. 

Cannot Copy File into Itself 

Make sure the file specification that follows the "as" in the 
prompt is not*.*, or specify a different destination directory. 

Cannot Delete Root Directory 

The root directory is a permanent part of every MS-DOS disk and 
cannot be removed. Directory delete operations can only be per­
formed on subdirectories. 

Cannot edit non-text file 

You can't use the Edit command to edit a program file. 

Cannot Move File to Itself 

Make sure the file specification is not a wild card, or specify a dif­
ferent destination directory. 

Cannot Rename File to Itself 

Either the filename already exists or the rename file specification 
is*.* . 

Cannot Rename substituted volume 

You cannot rename the volume label for a disk that was created 
with the SUBST command. 

Cannot Rename the Root Directory 

The root directory is permanently designated by a backslash(\) 
in MS-DOS and cannot be renamed. 
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Destination file is System/Hidden 

You cannot copy over a System file or a Hidden file. Use one of 
the Attribute commands to turn the attribute setting off. 

Device Not Ready 

If the device is a diskette drive, the diskette may not be inserted. 
Or, the indicated device may not be powered on or may not be on­
line. Correct the problem and press R to retry. 

Directory in Use 

This error occurs whenever a subdirectory under consideration is 
also contained in a substituted drive path. To delete or rename 
this directory, you must delete the substituted drive(s) that con­
tain it. 

Directory is Full 

Occurs only in the root directory when the maximum capacity of 
directory entries is reached within DOS. Before you can add 
more files or directories, you need to delete some. 

Directory Not Empty 

You may not delete a directory if it contains files or subdirector­
ies. Delete its files and subdirectories first, and then you can de­
lete the directory. Use the Prune command to completely remove 
the contents of a directory. 

Disk Full 

There is no room on the current destination disk for the file being 
copied. Copy the file or files to another disk, or cancel the opera­
tion and delete files from the current destination disk. 

Disk Has Been Changed 

There are two possible problems. One possibility is that since the 
drive was last logged, another disk was inserted without a corre­
sponding log operation being performed. Either replace the origi­
nal diskette or log the drive with the new disk. Another 
possibility is that you performed a DOS operation that changed 
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the disk, either from the Command Shell, the Application Menu, 
or with the Open command. In this case, what XTreeGold has 
logged in memory does not match what is actually on the disk. 
Log the disk again. This error does NOT cause loss of data or 
damage to the disk. 

Disk is Write Protected 

XTreeGold cannot write to the indicated disk. This is probably 
due to a write-protect tab on the diskette. If you are sure you 
want to write to the diskette, remove the tab, reinsert the disk, 
and press R to retry. 

File is Read-Only /System/Hidden 

Read-Only, System or Hidden files may not be deleted or re­
named. Use one of the Attribute commands to turn the attribute 
setting off. 

File Specification Text Maximum 

No more than 238 characters may be entered as a file specifica­
tion list. 

Invalid Attribute 

You have entered an attribute setting that is invalid. See the dis­
cussion of attributes in Chapter 4. 

Invalid Directory Name 

A directory name may contain no more than eleven characters. 

Invalid Disk Drive 

Your drive specifier must be A. .. z and be physically present. Cor­
rect the error by entering a valid drive specifier. 

Invalid File Specification 

Only eight characters are allowed, with a maximum extension of 
three characters. 
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Invalid Path Specification 

Either the path you have specified does not exist or it is mis­
spelled. 

Missing Overlay xxxxxx.sss 

XTreeGold can't find the overlay file it requires for an operation. 
Check that the XTreeGold path has been set correctly. 

Name exists 

MS-DOS restricts the use of identical names for files, directories, 
and volume labels. Only files in separate directories may have 
identical names. Select a unique name. 

Name exists as a directory 

You cannot specify a filename that already exists as a directory 
name. 

No Tagged Files 

The operation you have initiated is only performed on sets of 
tagged files and none have been tagged. 

Operation cancelled 

XTreeGold could not complete the operation. If this is a log disk 
operation, you may not have a enough memory for the operation. 
Release another logged disk and try again. 

Out of Memory 

During an operation, you attempted to create more files or directo­
ries than XTreeGold could process. Remove any unwanted files 
and/or directories; or release an entire disk with the Alt Release 
command. 

Path Not Found 

XTreeGold cannot find the path you specified. Check to see if 
your entry is correct and that you have logged on the disk you 
want. 
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Printer Error. Cancel, Retry? 

Your printer may be turned off or not selected. Or, you may be 
out of paper. Check your printer and the paper and retry by 
pressing R. If you are unsuccessful, your printer may not be 
working. Press C to cancel the print command. 

Read Failure, Close Failure, Write Failure 

One of these errors may be displayed if you are using XTreeGold 
under a network. If this is not the case, call Technical Support. 
Be prepared to give your serial number and system configuration, 
and to explain the specific operation sequences you performed. 

Unable to Create File 

Unable to Delete File 

Unable to Change Attributes 

Unable to Delete Subdirectory 

Unable to Make Directory 

Unable to Open File 

Unable to Read File 

Unable to Rename File 

These errors are rare. They indicate that XTreeGold has encoun­
tered a situation of some severity. If the error is not immediately 
apparent, it could be a Disk Has Been Changed error (see above). 
If you cannot correct the situation, call Technical Support. Be 
prepared to give your serial number and system configuration, 
and to explain the specific operation sequences you performed. 

Unknown Media Format 

This message usually indicates that you have placed an unformat­
ted diskette into the drive or that the hard disk has not been for­
matted. Press C to cancel, then check the disk. You can use the 
Alt F2 format command to format diskettes. 
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Troubleshooting 

This section describes the most common situations reported when 
XTreeGold users call the XTree support line for help. Before call­
ing us, we suggest you look in this section for your problem, and 
its solution. 

The problems are arranged with general problems and questions 
first, followed by printing problems, with specific command ques­
tions last. You will have to skim the pages to find a problem sim-
ilar to yours. ,, 

Problem: Typing XTGOLD at the pos prompt does not run the 
XTreeGold program; instead, just the DOS prompt is displayed. 

Solution: 

Make sure you are using DOS version 3.1 or greater. Also make 
sure COMSPEC is pointing to COMMAND.COM. 

Try this: 

Type SET and press Enter 

You should see the line: 

COMSPEC = C:\COMMAND.COM 

Problem: Mouse does not work 

Solution: 

Make sure you are installing the proper mouse driver for your 
particular mouse. Look in your config.sys file or autoexec.bat file. 

In config.sys you may have a statement: 

DEVICE=C:\MOUSE\MOUSE.SYS 

In your autoexec.bat program, you may see the line: 
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C:\MOUSE\MOUSE.COM 

Problem: Computer "locks up" when running XTreeGold 

Solution 1: 

If the program locks up on startup or when logging a drive, then 
change the logging method to STANDARD. 

Try this: 

1. At the XTGOLD prompt, type XTG_CFG and press Enter 

2. Select Modify configuration items 

3. Select disk logging method and press Enter 

4. Press ESC and then press S for Save configurations and quit 

5. Re-execute XTreeGold 

Solution 2: 

There may be a conflict between XTreeGold software and a device 
driver or a RAM resident program. Check your config.sys or au­
toexec.bat for other programs loaded into computer memory upon 
start up. 

Try this: 

A quick way to test for conflicts in autoexec.bat and config.sys is 
to start up your computer with your original DOS system disk in 
the A: drive and run XTreeGold again. If it works then, one at a 
time, add the contents of the files in config.sys and autoexec.bat 
until you find out which device driver or RAM resident program 
is causing problems. 

Problem: Display screen is flashing 

This is caused by a mis-configuration of the colors. 
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Solution: 

1. Run the configuration program by pressing Alt Fl 0 with the Di­
rectory window active, or typing XTG_CFG at the XTGOLD 
prompt. 

2. Select item 2 on the menu "Display color selection". 

3. Select a color configuration that is not flashing on your screen. 
There are 10 (0 .. 9) default colors set up in this section. To select 
one just type a digit (0 .. 9). 

Problem: Missing overlay 

This problem is caused by a mis-configuration ofXTreeGold's pro­
gram path. To correct this problem, re-configure XTreeGold's 
path to the path where it is installed. 

Solution: 

1. At the XTGOLD prompt type XTG_CFG and press Enter 

2. Select Modify configuration items 

3. Select Program Path and press Enter 

4. Type in the correct path. For example, C:\UTILS\XTGOLD 
and press Enter 

5. Press ESC and then press S for Save configurations and quit 

6. Re-execute XTGOLD 

Problem: Autoview does not display your word processing files in 
their proper format. 

Solution: 

Use the View command to enable you to format the file. 

Then try this: 

1. Press V to view the file 
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2. Then press F to format the file. 

Problem: Cannot delete a file 

Solution 1: 

Check the file attributes for the file you want to delete. You can 
view the file attributes in 2 column or 3 column display format 
using the File display command (Alt + F). XTreeGold will not let 
you delete a file with Read only, System, or Hidden attributes. 

1. Use XTree's File Attributes command to turn off the Read only, 
System, and Hidden status; from the File window, press A 

2. Then type - (the minus sign) and the attribute letter (R, S, or 
H) and press Enter 

3. Now use the Delete command 

~ Note: Do not delete IBMBIO.COM or IBMSYS.COM or 
MSDOS.COM or IOSYS.COM in the root directory. Deleting 
these files will cause your system to hang when booting up. 

Solution2: 

If after pressing D for delete an error message says: 

Error, Disk has been changed, try this: 

1. Relog the disk and try again 

2. If you get the same error, check for spaces in the file name. 
Spaces are not allowed for a file name and you must use DOS's 
REN command to rename the file without spaces before you can 
delete it. (Don't use XTree's Rename command or you will get the 
same error. 

3. For example, if the file name is TE ST.TXT, to rename without 
spaces using DOS's REN command, type: 

REN TE?ST.TXT TEST.TXT and press Enter 

4. Once this is done, re-log the disk and try again. 
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Problem: How do you run lWord without loading XTreeGold? 

1 WORD is built into the program and cannot be run separately. 

Solution: 

Start XTreeGold and run 1 Word by selecting the Edit command 
(Press E when the File window is active). 
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.PFK files, 11-13 

*key, 2-19, 6-13, 6-15, 8-5 
- key, 2-20, 6-14, 6-15, 8-5 

+key, 2-19, 6-13, 6-15, 8-5 

< > Select keys, 2-20, 6-9 
. symbol, 6-13 
+symbol, 6-13, 6-15, 8-4, 8-5 

? symbol, 6-13 
? Statistics command, 6-23 
!Word, 11-1 

-A-

Active window, 1-7 
All by attributes (tag) command, 4-36 

All by attributes (untag) command, 
4-37 

All disk files (tag) command, 3-24 

All disk files (untag) command, 3-25 
All in window (tag) command, 3-19 

All in window (untag) command, 3-21 
Alt commands, 2-31 

Alt + Copy command, 5-21 
Alt + Edit command, 11-3 

Alt+ eXecute command, 8-22 
Alt+ F2 Format diskette, 6-26 
Alt + F3 Relog directory command, 

5-19 

Alt+ F4 compare, 4-26 
Alt + F5 Open archive command, 9-5 

Alt+ F9 Video mode command, 10-21 
Alt + Fl 0 Configuration command, 

10-2 

Alt+ File display command, 3-10 
Alt+ Graft command, 5-29 
Alt + Hide/unhide command, 5-34 

Alt+ Log disk command, 6-16 
Alt + Move command, 5-25 

Alt+ Open command, 8-16 
Alt + Prune command, 5-32 

Alt + Quit command, 2-48 

Index 

Alt+ Release command, 6-10 

Alt+ Sort criteria command, 3-12 
Alt + Tag commands, 4-36 

Alt+ Untag commands, 4-37 

Alt+ Wash deleted space command, 
6-28 

Alt + Z command, 2-48 
Application menu, 8-2 

Creating, 8-6 

Collapsing and expanding, 8-4 
Graphics toggle, 8-5 

Modifying, 8-6 
Preventing modifications, 8-12 

Selecting items from, 8-4 
Applications, starting, 8-2, 8-17, 8-21 

Arc directory commands, 9-9, 9-11 
Arc file commands, 9-9, 9-13 

Archive files command, 9-4 
Archive formats, 9-3 

Archived files, extracting, 9-8 
Archiving features, 9-2 

Attribute, file security, 8-10 

Attributes command, 4-32 
Attributes, tagging by, 4-36 

Attributes, untagging by, 4-37 
Autoview command, 7-18 

Autoview window, 7-19 
Available space command, 6-21 

-8-

Backing up, 3-27, 5-21, 5-24 
Batch command, 8-26 

Batch files, creating, 8-26 
Blank space, 6-13, 8-4 

Branch files command, 2-15, 4-3 
Branch file window, 2-15, 4-2, 4-3 

Branch tagged command, 4-4 
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Matching files, 1-8, 3-3 

Menu bar, 2-12 

Menu command, 8-2 

Merge split tags command, 4-24 
Mouse operations, 1-9, 2-21, 2-23, 

2-30, 2-36, 2-40, 2-42 
Move command, 3-42 

Move files command, 3-42 
Move with paths command, 5-25 

Moving around the windows, 2-18 
Moving directory structures, 5-25 

-N-

Name (volume) command, 6-19 
New date commands, 4-29 

New features, XTreeGold, 1-3 

Next disk command, 6-9 
No files match message, 2-8 

-0-

Oops! (undelete) command, 3-37 

Open (all memory) command, 8-16 

Open archive command, 9-8 
Open (quick) command, 8-15 

Opei;i Zip and Arc command, 9-5 

-P-

Parameters, application menu, 8-11 

Parameters, associate files, 8-17 
Parameters, batch file, 8-27 

Path identification line, 2-7 
Point option, 2-38 

Print (Directory) command, 5-7 
Print (File) command, 3-50 

Programmable function keys (PFK), 
11-13 

Prompt line, 2-11 

Prune command, 5-32 
Pull-down menus, 2-12, 2-24 

Pull-down menus, help, 2-46 

b-4 

-Q-

Quick exiting, 2-48 

Quit commands, 2-4 7 
Quit to directory command, 2-48 

-R-

Release (Release disk) command, 6-10 
Re log directory (Re log) command, 5-19 

Rename (Directory) command, 5-5 
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-s-
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-u-
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-v-
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-w-
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Window pull-down menu, 2-28 

Index 

-x-
XTree Company, contacting, a-1 

XTree pull-down menu, 2-25 
XTreeGold help, 2-43 

XTreeGold terms, 1-7 

-z-
Zip and Arc command, 9-4 

Zip directory commands, 9-9, 9-11 
Zip file commands, 9-9, 9-13 

b-5 




